
Family Tree Maker Help Contents
Basic Family File operations

Select this topic to get help about things that you can do with Family Files, such as 
creating new files, opening existing files, backing up files, finding files, deleting files, 
copying files, and appending files.

Entering family information
Select this topic to get help about entering your family information into Family Tree 
Maker's Family Page, More About dialog boxes, and Scrapbooks.    You will also find 
information about editing the information that you enter and navigating between the 
different parts of Family Tree Maker.

Creating and printing Family Tree Maker documents
Select this topic to get help about creating and printing all Family Tree Maker documents,
which include trees, Family Group Sheets, Kinship reports, Custom reports, labels and 
cards, calendars, Scrapbooks, Family Page information, and the More About dialog box 
information.    You will also find information about Print setup, Batch printing, and creating
family books.

The FamilyFinder Index:    what it is & how to use it
Select this topic to get help about using the FamilyFinder Index; an index right on your 
own computer that can help you locate your relatives.    (The FamilyFinder functions are 
only available if you have a CD-ROM version of Family Tree Maker.)

The toolbar and menu commands
Select this topic to get help about each of the buttons on the Family Tree Maker Toolbar 
and each of the commands in the Family Tree Maker pull-down menus.    

Using the mouse and keyboard
Select this topic to get help about using your mouse effectively in Family Tree Maker.    
You will also find a table of Family Tree Maker's shortcut keys.

Customizing Family Tree Maker
Select this topic to get help about using the commands on the Prefs menu.    These 
commands help you set defaults for date formats, name formats, Fastfields, 
Picture/Object resolution and compression, field label names, and the way in which your 
Family File is backed up.

GEDCOM Import and Export
Select this topic to get help about importing files from other genealogy programs for use 
with Family Tree Maker.    You will also find information about exporting Family Tree Maker 
files for use with other genealogy programs.

Other information
Select this topic to get help about preserving photographs and sources for genealogical 
research.    You will also find information about the README file, using Banner Blue 
Software's technical support, finding the size of your Family File, and getting information 
about your computer that is helpful for technical support.

If you are not familiar with Windows Help systems, you may want to skim through the 
Windows "How to Use Help" Help system. To open the "How to Use Help" Help system, from
the Help menu, select How to Use Help.



Basic Family File operations
Creating new Family Files

Select this topic to get help about starting a new Family File to hold your family 
information.    You only want to create a new Family File if you are just beginning to enter 
family information or if you are starting a Family File for someone who is completely 
unrelated to your family.    Do not create a new Family File each time you have new 
names to enter into Family Tree Maker.

Opening Family Files
Select this topic to get help about opening Family Files that were created with either 
Family Tree Maker for Windows or a CD-ROM version of Family Tree Maker.

Opening Family Tree Maker for DOS files
Select this topic to get help about opening card files that were created with a DOS 
version of Family Tree Maker.

Saving Family Files
Select this topic to get help about saving your work in Family Tree Maker. 

Backing up Family Files
Select this topic to get help about making a backup copy of the Family File that you are 
currently working with. 

Retrieving backup copies
Select this topic to get help about opening a backup copy of a Family File.

Copying/Exporting Family Files
Select this topic to get help about making a copy of the Family File that you are currently 
working with.

Appending Family Files
Select this topic to get help about joining two Family Tree Maker for DOS card files or 
GEDCOM files in order to make one Family Tree Maker for Windows Family File.

Finding files
Select this topic to get help about finding files when you don't remember the exact file 
name or location.

Deleting files
Select this topic to get help about erasing files that you no longer need.

Exiting Family Tree Maker
Select this topic to get help about closing Family Tree Maker when you are finished using 
it.



Creating new Family Files
When you first start Family Tree Maker, you'll create a new Family File where Family Tree 
Maker will store all of your family information.    In order to create trees, calendars, and 
other Family Tree Maker documents, all of your family information must be in one Family 
File, so do not create a new Family File each time you have new names to enter into Family
Tree Maker.    The only time you'll want to create a new Family File is when you're creating a 
Family File for someone who is completely unrelated to you, such as your neighbor.
To create a new Family File:
1. From the File menu, select New Family File (ALT, F, N).

Family Tree Maker displays the New Family File dialog box.
2. Type a name for your file in the File name field.

The name of your file must be eight letters or less and must have the extension .FTW    
For example, you could type    myfamily.ftw    or    smith.ftw

3. The Drives and Directories fields list the drive and directory where Family Tree Maker
will place your new Family File.    If you want to select a different location for your file, 
use these fields to select one. 

4. Click OK.
Family Tree Maker creates your new Family File and then displays an empty Family Page.



Opening Family Files
With Family Tree Maker for Windows, you can open Family Tree Maker for DOS files, too.    If 
you want to open a GEDCOM file, see the topic "GEDCOM import and export."
To open a file in Family Tree Maker for Windows:
1. From the File menu, select Open Family File (ALT, F, O).

Family Tree Maker displays the Open Family File dialog box.    If you know where your file 
is, continue with the instructions below.    If you are unsure where your file is located, see 
the topic "Finding Files."

2. In the Drives and Directories fields, select the drive and directory where the file you 
want to open is located.
Note:    You cannot open a Family Tree Maker file (*.FTW) that is stored on a floppy 
diskette (or other removable media).    The file must be transferred to your hard drive 
before it can be opened.    Family Tree Maker Backup files can be opened from floppy 
diskettes, but will be copied to your hard disk.

3. Click the arrow next to the File format field and select the format of the file that you 
want to open.

4. Click the name of your file in the File name field, and then click OK.
If you are opening a Family Tree Maker for Windows file, you're ready to start working.    
Skip step 5. 

5. If your file is not a Family Tree Maker for Windows file, Family Tree Maker displays the 
New Family File dialog box.    You must give your file a new name so that Family Tree 
Maker can make a copy of your original file and convert the copy to a Family Tree 
Maker for Windows file.    
In the New Family File dialog box, you can either click OK to accept the name that Family
Tree Maker suggests or type a new name and then click OK.    The name for your file 
must be eight letters or less, and must have the extension .FTW 
Family Tree Maker reloads your file as a Family Tree Maker for Windows file and then 
displays a Family Page.    

See Also
Finding files
Appending Family Files
GEDCOM Import and Export



Opening Family Tree Maker for DOS files

To open a Family Tree Maker for DOS file:
1. From the File menu, select Open Family File (ALT, F, O).

Family Tree Maker displays the Open Family File dialog box.    If you know where your file 
is, continue with the instructions below.    If you are unsure where your file is located, see 
the topic "Finding Files."

2. In the Drives and Directories fields, select the drive and directory where the file you 
want to open is located.

3. Click the arrow next to the File format field and select Family Tree Maker for DOS 
(*.FTM).

4. Click the name of your file in the File name field and then click OK.
Family Tree Maker displays the New Family File dialog box.    You must give your file a 
new name so that Family Tree Maker can make a copy of your original file and convert 
the copy to a Family Tree Maker for Windows file.    

5. In the New Family File dialog box, you can either click OK to accept the name that 
Family Tree Maker suggests or type a new name and then click OK.    The name for your
file must be eight letters or less and must have the extension .ftw 

6. Click OK when you've given your file a new name.
Family Tree Maker reloads your file as a Family Tree Maker for Windows file, and then 
displays a Family Page.    

See Also
Finding files
Appending Family Files



Saving Family Files
Family Tree Maker does not have a Save command, but a Backup command.    This is 
because Family Tree Maker is a database program that saves your information regularly 
while you are using the program, as well as when you quit.    Both of these features reduce 
the risk of losing your data.
Note: Since Family Tree Maker automatically saves your information, you cannot 
quit the program without saving.    To get rid of any changes you make, you must fix them
manually.    Or, make separate backup files regularly so you can revert to an old file if you 
need to.    You may especially want to make a separate backup right before you make any 
major changes to the data in your file.
See Also
Backing up Family Files
Startup preferences



Backing up Family Files
Family Tree Maker does not have a Save command, but a Backup command.    This is 
because Family Tree Maker is a database program that saves your information regularly 
while you are using the program, as well as when you quit.    Both of these features reduce 
the risk of losing your data.
Note: Since Family Tree Maker automatically saves your information, you cannot 
quit the program without saving.    To get rid of any changes you make, you must fix them
manually.    Or, make backup files regularly so you can revert to an old file if you need to.   
You may especially want to make a separate backup right before you make any major 
changes to the data in your file.
When Family Tree Maker automatically creates a backup of your Family File (*.FBK), it places
the backup in the same directory as your original Family File (*.FTW).    If you want to make 
a backup copy of your Family File in a different drive or directory, for example, onto a floppy
diskette, you can use the Backup Family File command.
If you would prefer that Family Tree Maker not automatically make a backup copy (*.FBK) of
your Family File when you quit, you can turn off this function.    See the topic "Startup 
Preferences."
To make a backup of your Family File:
1. From the File menu, select Backup Family File (ALT, F, B).

Family Tree Maker displays the Backup Family File dialog box.
2. In the Drives and Directories fields, select the drive and directory where you want 

your backup located.
Family Tree Maker copies the information in your Family File to another file that has the 
same name, except with the extension .FBK    

To save your Family File under a completely different name, not just with a different file 
extension, use the Copy/Export Family File command.
See Also
Retrieving backup copies
Copying/Exporting Family Files
Startup preferences



Opening backup Family Files
If your Family File is accidentally deleted or the data is corrupted in some way, Family Tree 
Maker cannot open it.    When this is the case, you are given the option of opening a backup
copy (*.FBK) of your Family File.    In order to use the backup copy of your Family File, you 
must give it a name with an .FTW extension that is different from the name of the original 
Family File.    For this reason, Family Tree Maker displays the Open Backup Family File dialog 
box.    
When Family Tree Maker displays the Open Backup Family File dialog box:
1. In the File name field, type a new name for your file.

The name of your file must be eight letters or less, and must have the extension .FTW In 
addition, the name must be different from the name of the original file that can no longer
be opened.    For example, if the name of the original file was SMITH.FTW, you could 
rename the backup file SMITH2.FTW

2. The Drives and Directories fields list the drive and directory where Family Tree Maker
will place your new Family File.    If you want to select a different location for your file, 
use these fields to select one. 

3. Click OK.
Family Tree Maker creates your new Family File and then displays an empty Family Page.



Retrieving backup copies
At some time you may need to restore your Family File from a backup copy.    
1. From the File menu, select Open Family File (ALT, F, O).

Family Tree Maker displays the Open Family File dialog box.    If you know where your file 
is, continue with the instructions below.    If you are unsure where your file is located, see 
the topic "Finding Files."

2. In the Drives and Directories fields, select the drive and directory where your backup
is located.

3. Click the arrow next to the File format field and select Family Tree Backup (*.FBK).
4. Click the name of your file in the File name field and then click OK.

Family Tree Maker displays the New Family File dialog box.    Give your file a new name so
that Family Tree Maker can make a copy of the backup file and then convert the copy to a
Family Tree Maker for Windows (*.FTW) file.    

5. Click OK to accept the name that Family Tree Maker suggests or type a new name and 
then click OK.
The name must be eight letters or less, and must have the extension .FTW 

6. Click OK when you've given your file a new name.
You're ready to start working with your restored Family File.

See Also
Finding files



Copying/Exporting Family Files
Occasionally you may want to make a copy of your Family File.      These instructions show 
you how to do it.    If you want to make a copy of your Family File to use with another 
genealogical program, such as PAF or Family Tree Maker for DOS, see the topic "Exporting 
GEDCOM files from Family Tree Maker."
To make a copy of your Family File: 
1. From the File menu, select Copy/Export Family File (ALT, F, C). 

Family Tree Maker displays the Copy/Export Family File dialog box. 
2. In the File name field, type a new file name.
3. In the Drives and Directories fields, select the drive letter and directory name where 

you want your file copied.    
4. When you've made your selections, click OK.    

Family Tree Maker copies or exports your file to the drive, directory, and file name that 
you choose.    

See Also
Exporting GEDCOM files from Family Tree Maker



GEDCOM Import and Export
GEDCOM is a standard file format for exchanging information between genealogy 
programs.    The acronym GEDCOM stands for GEnealogical Data COMmunications.    The 
Family History Department of the Church of Jesus Christ of Latter-day Saints (LDS Church) 
developed the GEDCOM standard.
You can use GEDCOM to transfer information into Family Tree Maker from another 
genealogy program that supports GEDCOM and vice versa.    By using GEDCOM, you can 
avoid retyping all of your family information when you switch from one program to another.
See Also
Importing GEDCOM files into Family Tree Maker
Exporting GEDCOM files from Family Tree Maker



Importing GEDCOM files into Family Tree Maker
If you need to find out what GEDCOM is, see the topic GEDCOM Import and Export.
To open a GEDCOM file in Family Tree Maker for Windows:
1. From the File menu, select Open Family File (ALT, F, O).

Family Tree Maker displays the Open Family File dialog box.
2. In the Drives and Directories fields, select the drive and directory where the file you 

want to open is located.
3. Click the arrow next to the File format field and select GEDCOM (*.GED).
4. Click the name of the GEDCOM file in the File name field and then click OK.

Family Tree Maker displays the New Family File dialog box. 
5. You must give the GEDCOM file a new name so that Family Tree Maker can make a copy

of the original GEDCOM file and convert the copy to a Family Tree Maker for Windows 
file.    
In the New Family File dialog box, you can either click OK to accept the name that Family
Tree Maker suggests or type a new name and then click OK.    The name for your file 
must be eight letters or less and must have the extension .FTW 
Family Tree Maker reloads your file as a Family Tree Maker for Windows file and then 
displays the Import from GEDCOM dialog box.    

6. Make your formatting selections.    Each of the options is described below.
Options    Some programs (like PAF) add an underscore between compound names (for 
example, St._Germaine).    Select the Delete underscore from names check box to 
replace the underscore with a space.    Some programs also don't put spaces between the
city, county, and state in location fields.    Select the Add spacing in location fields 
check box to include the normal space between these words.
Location    Some programs (like PAF) have longer location fields than Family Tree Maker 
does.    For example, PAF could hold the location "Warren, Trumbull County, Ohio, United 
States of America."    Select the Keep first part if location fields are too long option 
button to keep the first part of the location.    For example, "Warren, Trumbull County, 
Ohio."    Select the Keep last part if location fields are too long option button to 
keep the last part of the location.    For example, "Ohio, United States of America."

7. Now you must tell Family Tree Maker which pieces of information to import from your 
GEDCOM file.    Family Tree Maker automatically imports an individual's name, sex, and 
the dates and locations of birth, death, and marriage.    If you have sources for this 
information, they are also imported.    If this is all of the information you want to import,
click OK and skip the rest of these instructions.    If you want to import additional 
information, click Items to Include.
Family Tree Maker displays the Items to Include in Family File dialog box.
There are two lists in this dialog box.    The list on the right, Fields being imported, 
contains two items.    In parentheses are the GEDCOM tags from which the information is
being imported, and to the right of the tags are the names of the Family Tree Maker fields
into which the GEDCOM information will be placed.    The list on the left, Available 
items, contains additional Family Tree Maker fields that you can choose to fill with 
information imported from the GEDCOM file.    

8. To fill an additional Family Tree Maker field with GEDCOM information, click the name of
the field in the Available items list.    

9. Click Include (the arrow pointing to the right).



Family Tree Maker displays the Tag dialog box. 
10.Select a GEDCOM tag that describes the information you selected in step 8, then click 

OK.
11.Repeat steps 8 through 10 until all Family Tree Maker fields that you wish to fill are in 

the Fields being imported list.
12.To remove an item from the Fields being imported list, click that item and then click

Remove (the arrow pointing to the left).
Family Tree Maker places the item in the Available items list.

13.Click OK when you've made your selections.    
Family Tree Maker returns to the Import from GEDCOM dialog box.

14.Click OK again.
Family Tree Maker creates the Family File.



Exporting GEDCOM files from Family Tree Maker
If you need to find out what GEDCOM is, see the topic GEDCOM Import and Export.
To export your Family File to GEDCOM: 
1. From the File menu, select Copy/Export Family File (ALT, F, C). 

Family Tree Maker displays the Copy/Export Family File dialog box. 
2. In the File name field, type a name for the GEDCOM file.    It must have the 

extension .GED
3. In the Drives and Directories fields, select the drive and directory where you want to 

place your file.
4. Click the arrow next to the File format field and select GEDCOM (*.GED).
5. Click OK.    

Family Tree Maker displays the Export to GEDCOM dialog box.
6. Make your selections from the dialog box.    Each of the options is described below.

Location    The Destination field allows Family Tree Maker to check for special 
requirements of the program that will be reading the GEDCOM file.    Click the drop-down 
list and make a selection.    If the program you are exporting to is not listed, choose PAF.

Select this To create this type of file
ANSTFILE Ancestral File of LDS church
NPS Temple submission to LDS church
PAF Personal Ancestral file, 2.1 or 

later
ROOTS Roots II or Roots III
FTM Family Tree Maker

When you make a selection in the Destination field, Family Tree Maker makes 
suggestions for the GEDCOM and Character set fields.    However, if Family Tree 
Maker's suggestions are incorrect for your purposes, click on each of those fields and 
make your own selections.
Options    Select the Indent records check box to make the file more readable in a 
word processor.    Some programs cannot read indented records, in which case this 
setting will be ignored.    Select the Abbreviated tags check box to use abbreviated 
tags.    Most programs use abbreviated tags, even though the long form is more readable.

7. Now you must tell Family Tree Maker which pieces of information to export to your 
GEDCOM file.    Family Tree Maker automatically exports an individual's name, sex, and 
the dates and locations of birth, death, and marriage.    If you have sources for this 
information, they are also exported.    If this is all of the information you want to export,
click OK and skip the rest of these instructions.    If you want to export additional 
information, click Items to Include.
Family Tree Maker displays the Items to Include in GEDCOM File dialog box.
There are two lists in this dialog box.    The list on the right, Fields being exported, 
contains two items.    In parentheses are the GEDCOM tags to which the information is 
being exported and to the right of the tags are the names of the Family Tree Maker fields 
from which the GEDCOM tags will be filled.    The list on the left, Available items, 
contains additional Family Tree Maker fields that you can choose to export to the 



GEDCOM file.    
Note:    The Fields being exported list defaults to contain the most commonly used 
Family Tree Maker for DOS fields.    If you do not want to export all of this information or if
you are exporting the GEDCOM file for use with a different software program, you can 
remove items from this list.    See step 12 for instructions.

8. To export an additional item to the GEDCOM file, in the Available items list, click that 
item.    

9. Click the Include button (the arrow pointing to the right.)
Family Tree Maker displays the Tag dialog box. 

10.Select a tag that describes the information you selected in step 8, then click OK.
11.Repeat steps 8 through 10 until all Family Tree Maker fields that you wish to export are

in the Fields being exported list.
12.To remove an item from the Fields being exported list, click that item and then click

Remove (the arrow pointing to the left.)
Family Tree Maker places the item in the Available items list.

13.Click OK when you've made your selections.    
Family Tree Maker returns to the Export to GEDCOM dialog box.

14.Click OK again.
Family Tree Maker creates the GEDCOM file.



Appending Family Files
If you have several Family Tree Maker for DOS or GEDCOM files, you can join them into one 
big file.
To append one file to another:
1. Open the file to which    you want to append the Family Tree Maker for DOS or GEDCOM 

file.    
2. Now you need to open the file that you want to append to the file you opened in step 1.

From the File menu, select Open Family File (ALT, F, O).
Family Tree Maker displays the Open Family File dialog box.

3. In the Drives and Directories fields, select the drive and directory where the file you 
want to append is located.

4. Click the arrow next to the File format field and select Family Tree Maker for DOS 
(*.FTM) or GEDCOM (*.GED).

5. Select the Append file check box. 
6. Click the name of your file in the File name field and then click OK.    

Family Tree Maker appends the Family Tree Maker for DOS or GEDCOM file to the open 
file.    When Family Tree Maker appends two files, it doesn't connect the information for 
you.    For example if you have a set of parents in one file and their child in another, all of 
the individuals will be in the new file but will not be shown as related.    To fix this, you 
will need to use the Attach and Detach commands.    

See Also
Attach spouse
Detach spouse
Attach child
Detach child



Finding files
There may be times when you need to find an existing file to use with Family Tree Maker.    
You can begin a search from two different locations:
 The Open dialog box, which appears when you select Open from the File menu (ALT, F, O).
 The Insert Picture dialog box, which appears when you choose to Insert Picture from 

File from the Picture/Object menu (only available from the Scrapbook view) (ALT, O, F).

From any of those two dialog boxes, take these steps to find your file:
1. Click Find File, which appears on the right side of the dialog box.

Family Tree Maker displays the Find File dialog box.    Now you can tell Family Tree Maker 
where to look for your file, following steps 2 through 4 below.    Your search will take less 
time if you enter the most exact locations you know.

2. Click the File name field and type in a file name if you already know part or all of it.    
You can type in any valid DOS file name, using the asterisk symbol (*) to indicate "any," 
or a question mark (?) to hold the place of characters if you're unsure of exact spelling 
but know how long a file name is.    For example, you could type sm?th.* if you didn't 
recall whether the Smith Family File used the spelling "Smith" or "Smyth."    If you know 
that the file you're looking for has a name that is six letters long, you can enter ??????.*
to retrieve a list that excludes all shorter and longer titles.

3. Click the File format drop-down list and select a file type.    
The selection of file types will depend on which dialog box you were in when you opened 
the Find File dialog box.    For example, if you were in the Import Picture dialog box, 
Family Tree Maker will graphics file formats.    If you don't know which file format your file 
is saved with, select the last format in the list:  All Files (*.*).

4. Click the Search drop-down list and select a set of drives for Family Tree Maker to 
search.
All of the disk drives on your computer should be listed, as well as any network drives 
connected to your computer.    The list will give you the choice to select a single drive or 
a broad combination of drives.    Remember that your search will take more time if Family
Tree Maker has to search in many different locations, so don't include a drive in your 
search if it's very unlikely that your file is stored there.

5. Once you've made your selections, click Search.
Family Tree Maker searches in the designated areas and lists the matching file paths in 
the Found files box. 

6. If several file names appear in the box, use the scroll bar to scan the list for the file 
name you're trying to find.    To open a file in the list, you can either select the file name
and click Open, or double-click the name in the list.



Deleting files
Family Tree Maker doesn't allow you to delete files, but you can use Windows File Manager 
if you need to delete files.    See your Microsoft Windows User's Guide for more information 
about File Manager.



Exiting Family Tree Maker
You should never shut off your machine before quitting Family Tree Maker and Windows.
To quit Family Tree Maker:
1. From the File menu, select Exit (ALT, F, X).

Family Tree Maker backs up your information and closes the program.
2. If you're done with your computer, close Windows and shut off the computer.



Entering family information
Entering information in the Family Page

Select this topic to get help about recording basic family facts, such as names, birth 
dates, death dates, and marriage dates.

Navigating between Family Pages
Select this topic to get help about moving among the screens of facts that you have 
recorded about each of your family members.

Entering information in the More About dialog boxes
Select this topic to get help about recording the details about each of your family 
members, such as their address, medical history, nicknames, or even quick facts or 
several paragraphs of stories.

Entering information in Scrapbooks
Select this topic to get help about creating collections of pictures, video clips, sound 
clips, and other types of OLE objects for each of your family members.    You will also find 
information about including these types of items in family trees, Family Group Sheets, 
and labels and cards.

Using the Other Spouses dialog box
Select this topic to get help about recording multiple marriages for an individual.

Editing information
Select this topic to get help about editing the text that you enter into Family Tree Maker.   
You will find out about functions such as deleting text, moving text, and undoing your last
editing command.    You will also learn to delete and move people when you have 
accidentally put them in the wrong place.

Adding an unrelated individual
Select this topic to get help about adding an individual to your Family File when you are 
not exactly sure who that individual is related to.



Entering information in the Family Page
Before you can print a tree, report, or other document, you need to enter information about
your family.    To enter basic family information you fill out a Family Page, which is the first 
screen that you see after you open a Family File. Each nuclear family in your Family File has
a Family Page.    
Entering names

Select this topic to get help about how you should record individuals' names in Family 
Tree Maker.

Entering dates
Select this topic to get help about how you should record dates in Family Tree Maker.    
You will also find information about setting a default date format, so that all of the dates 
that you enter into Family Tree Maker are in the same format.

Entering locations
Select this topic to get help about how you should record locations in Family Tree Maker.   
You will also find information about Fastfields, a feature of Family Tree Maker that can 
save time for you by filling in some fields automatically.

Entering information about a marriage
Select this topic to get help about recording marriage dates and locations in Family Tree 
Maker, as well as other information about a couple's relationship.    You will also find 
information about recording intermarriages.

Entering information about children
Select this topic to get help about recording the names, sexes, and birth dates of a 
couple's children.    

Rearranging children
Select this topic to get help about sorting a couple's children so that they appear in the 
order of their birth.

Recording sources
Select this topic to get help about recording your sources of family information. 

Adding an unrelated individual
Select this topic to get help about adding an individual to your Family File when you are 
not exactly sure who that individual is related to.



Entering names
You type individuals' names into the "Husband," "Wife," and "Children" fields on a Family 
Page.    Include an individual's first, middle, and last name.    Enter names first-name-first, 
and don't use initials.    Always use a woman's maiden name and be sure to include 
children's last names. 
Note: You can print names differently from the way you enter them.    For example,
you can choose to print names last-name-first, or only with a first initial.    You can print 
nicknames instead of given names, and in calendars, you can print either married names 
or maiden names.    However, to print names in different ways, you must enter each name
completely (first, middle, last), and then let Family Tree Maker do the hard work.    
Nicknames    Nicknames should be entered in the Lineage dialog box.
Name changes    Name changes should also be entered in the Lineage dialog box.    For 
example, if "Johann Smythe" changed his name to "John Smith," you would enter "John 
Smith" on the Family Page and "Johann Smythe" in the Lineage dialog box.
Unusual last names    If you notice that Family Tree Maker has incorrectly identified 
someone's last name, place the entire last name between backslash characters:    Connie \
Irish Hess\ 
Last names with suffixes    If a suffix is attached to the last name (for example, Jr. or 
Ph.D.) separate it from the last name by a comma (John Smith, Jr.). 
Titles (Mr., Mrs., Dr., etc.)    Family Tree Maker uses titles when you print labels and 
cards.    Do not enter titles such as "Mr.," "Mrs.," or "Dr." on the Family Page.    You can use 
the Title preferences dialog box to select titles such as "Mr." or "Mrs." for use with most of 
the individuals in your Family File.    However, if anyone in your Family File has a special 
title, such as "Dr." or "Reverend," enter it in their Lineage dialog box.    
Missing last names  To show that an individual has no last name, place two backslash 
characters together without a space between them at the end of the name:    Running 
Bear\\ 
See Also
The Lineage dialog box
Title preferences



Entering dates
The "Date" fields in Family Tree Maker can handle any date after 1/1/100 A.D.    You can 
enter a date in almost any way and then when you leave the date field, Family Tree Maker 
puts the date in a standard format.    You can change the standard format using Date 
preferences.    See the topic "Date format preferences."
There may be events for which you don't know an exact date.    The table below shows how 
you can handle estimated dates.

You type this You get this 

1776 1776
Jul 1776 July 1776
4 Jul July 4
est 7/4/1776 Abt July 4, 1776
abt 7/4/1776 Abt July 4, 1776
about 7/4/1776 Abt July 4, 1776
circa 7/4/1776 Abt July 4, 1776
bef 7/4/1776 Bef July 4, 1776
before 7/4/1776 Bef July 4, 1776
aft 7/4/1776 Aft July 4, 1776
after 7/4/1776 Aft July 4, 1776
? Unknown 

Note: You can change the words "abt" and "about" to anything you want using 
Field label preferences. 
If an event hasn't yet happened, leave the date field blank.    If an event has happened, but 
you don't know the date, type a question mark or the word "unknown." 
Double Dates    Family Tree Maker can display double dates to account for the crossover 
between the Julian and Gregorian calendars.    If you enter a date that falls between January
1 and March 25 for any year before 1753, a double date will appear.    
Double dates work as follows:    you can type either Jan 1, 1493/4 or Jan 1, 1493/1494; both 
display as January 1, 1493/94.    If you don't type in both of the years, Family Tree Maker 
interprets the year you typed as the second year.    For example, if you type January 1, 
1494, it's displayed as January 1, 1493/94.      
See Also
Date format preferences
Field label preferences



Entering locations
"Location" fields are for entering an individual's place of birth, death, or marriage.    (These 
fields are preceded by the field label "in.")    Normally you enter the city and state.    You can
also enter the county if it's important.    To conserve space, enter the country name only if 
most members of your family weren't born in that country.
To help you save time when entering locations, Family Tree Maker has a special feature 
called Fastfields.    The Fastfields feature remembers the names of the last 50 locations that 
you've entered into any location field.    This means that when you start typing the name of 
a town that you've previously typed in a location field, Fastfields automatically fills in the 
rest of the letters for you.    For a more complete description of Fastfields, see the topic 
"Fastfields."
Sometimes single page trees have limited space for the location fields.    If Family Tree 
Maker needs to abbreviate a location, it will try to keep the last word in the location field.    
So, if you enter a state and a country, it may print the country, but drop the state.    
Put commas between the city, county, state, and country names so that Family Tree Maker 
can abbreviate correctly when necessary.
Note: Your trees will look better if you enter locations consistently.    Either 
abbreviate states or spell them out.    Don't do both.
See Also
Fastfields
Fastfield preferences



Fastfields
To help you save time when entering family information, Family Tree Maker has a special 
feature called Fastfields.    Most of the Fastfields in Family Tree Maker are location fields, 
such as birth location, death location, and marriage location fields.    For this reason, we'll 
explain Fastfields in terms of location fields.    
The Fastfields feature remembers the names of the last 50 locations that you've entered 
into any location field.    This means that when you start typing the name of a town that 
you've previously typed in a location field, Fastfields automatically fills in the rest of the 
letters for you.    
For example, say that you have typed the following two birth locations into Family Tree 
Maker:    "Abilene, Louisiana" and "Arlington, Virginia."    Then, you go to another birth 
location field and type the letter "A."    Fastfields immediately looks for a location beginning 
with "A" that you've previously typed.    Since "Abilene, Louisiana" is alphabetically the first 
location beginning with an "A," Fastfields automatically places "Abilene, Louisiana" into the 
field.    If you then typed an "r" after the "A," Fastfields would replace "Abilene, Louisiana" 
with "Arlington, Virginia."    If "Arlington, Virginia" wasn't the name that you wanted in that 
birth location field, you would just continue typing the name that you wanted, such as 
"Argyle, New York."    In short, Fastfields refines its suggestions as you type, and quits 
making suggestions when it no longer has any logical choices.
In addition to location fields, "Cause of death," "Picture/Object category," "Sources," and 
the fields in the Address dialog box are Fastfields.    For these fields, Fastfields also 
remembers the last 50 entries that you typed into the field.    
If you are not comfortable using Fastfields, you can turn them off in the Fastfields 
preferences dialog box.    See the topic "Preferences for Fastfields."
See Also
Fastfield preferences



Entering information about a marriage
The "Marriage" and "Beginning status" fields on the Family Page are for recording 
information about a marriage.    Type the date and location of a marriage in the "Marriage" 
fields.    In the "Beginning status" field, you can choose any of the following terms from the 
drop-down list:    Married, Friends, Partners, Other, Single, and Unknown.    If the individual 
never married, leave the fields blank.    
When you enter "Partner" or "Friend" in the "Beginning status" field, Family Tree Maker 
automatically substitutes "Meeting date" for "Marriage date" in the records you're keeping 
about those two individuals.    The Marriage Facts dialog box is where you'll find the "Ending
status" field.    
You can also enter information about a marriage in each marriage's Scrapbook.    For more 
information, see the topic "Entering Information in Scrapbooks."
See Also
The Marriage dialog boxes
Recording intermarriage
Entering information in Scrapbooks



Entering information about children
The "Children" list at the bottom of the Family Page is for recording the names, sexes, and 
birth dates of the children of the parents on that Family Page.    The Family Page appears to 
allow only 4 children, but when you press Enter after the fourth child, the list scrolls up.    
You can enter up to 99 children.
The name and date fields in the "Children" list work just as they do for the husband and 
wife.    The "Sex" field accepts the letters "M" and "F" for "male" and "female," as well as "?"
for cases where the sex is unknown.    The default is Female.    A child's sex determines 
where he or she appears in family trees, so fill in the sex correctly.
Note: You can change a child's sex by typing over the current sex.    If the child is 
married, the spouse's sex will not change automatically.
There are different ways to enter the names of stepchildren, foster children, or adopted 
children.    Some people prefer only to record bloodline relationships in their family trees, 
while others just want to show who makes up the family.    
If you are interested in tracing your family's bloodline, only enter the names of children 
born to the parents on each Family Page.    In this case, you should enter stepchildren only 
as children of their birth parents.    In addition, if you want to trace the family bloodline, you
probably don't want to enter adopted and foster children.
If you want to record everyone who makes up the family, enter all children as you wish.    
You can enter adopted and foster children as children of their foster and adoptive parents 
and leave it at that, or you can use the Lineage dialog box to indicate that they are adopted
or foster children.
See Also
Rearranging children
The Lineage dialog box



Rearranging children
These three commands let you rearrange the individuals in a "Children" list on the Family 
Page.    Always use these commands to rearrange children.    Never attempt to rearrange 
children by typing over names that are already there. 
Using Insert Child

Select this topic to get help about inserting a new child between two children who are 
already in the "Children" list.

Using Move Child
Select this topic to get help about moving a child from one position to another position in
a "Children" list.

Using Sort Children
Select this topic to get help about sorting the children in a "Children" list so that they 
appear in the order of their birth dates.



Using Insert Child
The Insert Child command lets you add a new child between two existing children on a 
Family Page.    
To insert a new child: 
1. Place the cursor on the row where you want the new child's name to appear.
2. From the People menu, select Insert Child (ALT, P, I).

The individual whose name the cursor is on moves down (as do the individuals below), 
leaving the cursor at the beginning of a new empty line.    You may now enter the child's 
name, sex, and birth date on the new line. 



Using Move Child
With the Move Child command you can move a child from one location to another within 
the same Family Page.    To move a child from one Family Page to another, use the Detach 
Child and Attach Child commands.
To move a child within the list of children:
1. In the Children list, place the cursor on the name of the child that you want to move.

Note:    To exchange two adjacent children in the list of children on a Family Page, select 
the lower child as the one to move, then move that child upward.

2. From the People menu, select Move Child From (ALT, P, M).
3. Click OK on the confirmation message.
4. In the Children list on the same Family Page, place the cursor on the row where you 

want the child to end up.
Note:    To move a child to another Family Page, use the Detach and Attach Child 
commands.

5. From the People menu, select Move Child To (ALT, P, M).
The other children on the list move down and the individual you moved ends up in the 
row that you selected in step 3.

See Also
Detach Child
Attach Child



Using Sort Children
With the Sort Children command you can arrange the children in a "Children" list so that 
they appear in the order of their birth.
To sort the children on a Family Page by birth order:
1. Go to the Family Page where you want to sort the children.
2. From the People menu, select Sort (ALT, P, S).    
3. Click OK on the confirmation message.

When the children are sorted, the oldest child appears at the top of the list, and the 
youngest at the bottom.    Twins or triplets stay in the order in which you entered them.    

Note:    If a child's date field is blank, that child will sort at the top of the list.    If a date 
field contains a question mark, that child will sort at the bottom.    If you don't know the 
exact birth date of a child but know that it was born before or after another child, use a 
Before or After date prefix. 
See Also
Entering dates



Recording intermarriage
You may find that somewhere in your family a set of cousins got married or two brothers 
married two sisters.    In these cases, individuals would logically appear twice in your file.    
Family Tree Maker allows you to enter these individuals without duplicating all of their 
information.
To enter an intermarriage:
1. On the Family Page where each individual appears as a child, enter all of their 

information.    
2. Go to the Family Page of one of the individuals.    Enter only the name and birth date of 

their spouse.    Don't enter the spouse's parents a second time!
Make sure that the names and birth dates match the ones you entered in step 1 exactly.   
Family Tree Maker compares the information on the Family Pages to find out if you have 
the same individual entered more than once.

3. Family Tree Maker will ask if the two individuals are the same.    
If it doesn't ask, double check to make sure that the names and birth dates are exactly 
the same and that you didn't enter parents on both Family Pages.

4. Click Yes.
Family Tree Maker "links" the two together.



Recording sources
You should thoroughly document your sources of family information.    That way you can 
return to the source if you have to and you'll know what sources you've already checked.    
You can also print source information in your trees.    Printing source information is 
described in the topic "Formatting items to include in trees."    The following fields can have 
source information: Birth date/location, Death date/location, Medical information, each of 
the 13 Facts fields, Cause of death, Marriage date, Marriage ending date/location, Marriage 
fact date/location.
To record source information for a field: 
1. Place your cursor on the field that you want to record source information for.

Note:    Each set of date and location fields (such as birth date and birth location) has 
one source.

2. From the View menu, select Source (ALT, V, U).
Family Tree Maker displays the Source dialog box.

3. Type your source information in the field.
For example, if your source of information was a church's records, you could enter the 
type of record used and name and location of the church.

4. When you're finished, click OK.
Family Tree Maker returns you to the field for which you recorded sources.

If source information has been entered for a field, Family Tree Maker displays an "s" next to 
that field.    
See Also
Formatting items to include in trees



Navigating between Family Pages
A complete family tree is made up of more than just one nuclear family on one Family Page  .  
Family Tree Maker makes it easy for you to get to other Family Pages so that you can 
quickly see or change them.    
Displaying a parent's Family Page

Select this topic to get help about moving to the Family Page of the parents of the 
individual whose Family Page you are currently viewing.

Displaying a child's Family Page
Select this topic to get help about moving to the Family Page of the children of the 
individual whose Family Page you are currently viewing.

Displaying the Family Pages of additional spouses
Select this topic to get help about moving from a Family Page that contains one of an 
individual's spouses to a Family Page that contains another of an individual's spouses.

Using the Index of Individuals
Select this topic to get help about the Index of Individuals, a list of every individual that 
is currently in your Family File.    You can use the Index of Individuals to move from 
information about one individual to information about another individual.

Using Find Individual
Select this topic to get help about the Find command.    You can use the Find command to
locate an individual with a particular name.    You can also use this command to locate 
individuals that are associated with specific facts, such as birthplaces or birth dates.



Displaying a parent's Family Page
To go to the parents of an individual in your Family File, you need to display the Family Page
of the parent.    For example, to go to the current wife's parents, click the tab on the right 
side of the Family Page that says "Parents of <wife>."    Alternatively, you can press F4.    
Family Tree Maker then displays a Family Page with the wife listed as a child, and 
"Husband" and "Wife" fields where her parents should be entered.
To go to the current husband's parents, click the tab on the right side of the Family Page 
that says "Parents of <husband>."    Alternatively, you can press F5.    Family Tree Maker 
then displays a Family Page with the husband listed as a child, and "Husband" and "Wife" 
fields where his parents should be entered.
See Also
Using the Index of Individuals
Using Find Individual



Displaying a child's Family Page
To go to the Family Page of a child, click the tab on the left side of the Family Page labeled 
with that child's name.    You can also click the child's name and press F6.    Family Tree 
Maker then displays a Family Page with the child listed either as a husband or wife, and a 
"Children" list where his or her children should be entered.
See Also
Using the Index of Individuals
Using Find Individual



Displaying the Family Pages of siblings

To go to the Family Page of a husband's or wife's sibling: 
1. Click the tab for the husband's or wife's parents.

Family Tree Maker displays the Family Page of the parents.
2. On the parents' Family Page, click the tab labeled with the name of the child whose 

Family Page you want to see.
If the child whose Family Page you want to see is not visible in the "Children" list, use the
scroll bar on the right side of the list to scroll through the children.

If you press F8 when the cursor is in either the "Husband" field or the "Wife" field, Family 
Tree Maker goes to the Family Page of the husband's or wife's next sibling.    (The "next" 
sibling is the sibling that is listed directly below the individual in the "Children" list on their 
parents' Family Page.)
If you press ALT + F8 when the cursor is in the "Husband" or "Wife" field, Family Tree Maker 
goes to the Family Page of the husband's or wife's previous sibling.    (The "previous" sibling 
is the sibling that is listed directly above the individual in the "Children" list on their 
parents' Family Page.)    
See Also
Using the Index of Individuals
Using Find Individual



Displaying the Family Pages of additional spouses
When an individual has more than one marriage, you must create a separate Family Page 
for each additional spouse.    The individual with multiple spouses will then be on multiple 
Family Pages.    If you have not yet added the "additional spouse" to your Family File, see 
the topic "Using the Other Spouses dialog box."
To see the Family Page of another spouse: 
1. On the Family Page, click Spouses for the individual whose Spouses dialog box you 

want to see.    Or, click the name of the individual whose Spouses dialog box you want 
to see, then press F3.
Family Tree Maker displays the Spouses dialog box.    

2. In the Select a spouse to go to list, click the name of the spouse whose Family Page 
you want to see and then click OK.
Family Tree Maker takes you to the Family Page containing the spouse that you just 
selected.

See Also
Using the Other Spouses dialog box
Using the Index of Individuals
Using Find Individual



Using the Index of Individuals
The Index of Individuals lists every individual that you've entered in your Family File.    
You can use the Index of Individuals to find individuals quickly.
To view the Index of Individuals, click View on the menu bar and select Index of 
Individuals (ALT, V, I).    Alternatively, you can press F2.    Family Tree Maker displays the 
Index of Individuals.    The individuals are listed alphabetically by last name and each 
individual's birth and death dates are listed next to his or her name.
Note: You'll see that individuals with nicknames (aka's) appear in the index twice, 
one entry for each of their names.        
Using the arrow keys is one way to scroll up and down through the names in the Index of 
Individuals.    Quick Search and Find Name offer other quick ways to locate an individual in 
the Index.    For more detailed information about using the Index of Individuals, select one 
of the topics listed below.
See Also
Doing a Quick Search
Using Find Name
Changing views from the Index of Individuals
Rearranging the Index of Individuals
Selecting an individual to attach



Doing a Quick Search
With this feature you can find an individual in the Index of Individuals just by typing their 
name.    If you need more general information about the Index of Individuals, see the topic 
Using the Index of Individuals.
To use the Quick Search feature:
1. Click in the Name field at the top of the screen.
2. Start typing the last name of the individual that you want to find.

With each character you type, you will get closer to the name you are looking for.    You 
can type part or all of the name, as long as it is in the same format as the Index of 
Individuals:    Last name, First name Middle name.

Note:    You cannot use this search feature when the Index of Individuals is arranged by 
birth dates rather than by last names.    
See Also
Rearranging the Index of Individuals



Using Find Name
Using the Find Name command is a quick way to locate a specific individual in the Index of 
Individuals.    If you need more general information about the Index of Individuals, see the 
topic Using the Index of Individuals.
To use the Find Name command in the Index of Individuals:
1. Click Find.  It's located at the bottom of the Index of Individuals screen.    

Family Tree Maker displays the Find Name dialog box.
2. Type an individual's name.

If you're not sure of the exact name, type any part of it.    Family Tree Maker will find any 
name containing those same letters.    For example, if you type hess, Family Tree Maker 
will find "Kenneth Hess," "Hessel Smith," "George Chess, III," and so on. 

3. Click OK to begin searching.
Family Tree Maker highlights the name of the first individual meeting your request.    If 
there are no matches, Family Tree Maker displays a message telling you this. 

4. To continue searching through the list of names, click Next.    
Once you have moved past the first match in the list, you can also click Previous to go 
back to previous matches.
Note:    If you didn't find the name you were looking for, try typing a smaller portion of 
the name.    For example, you could type sm to look for the last name "Smith."



Changing views from the Index of Individuals
Once you've found a name in the Index of Individuals, you probably want to change views.   
This topic describes how to do that.      If you need more general information about the 
Index of Individuals, see the topic Using the Index of Individuals.
You can do one of two things:
 Click Go to Family Page to go to the Family Page of the individual whose name is 

highlighted.    That individual will be shown as a husband or wife on the Family Page.
If the individual has been married more than once, Family Tree Maker either shows you 
the Family Page of the first marriage, or, if you have selected a preferred spouse for that 
individual, Family Tree Maker shows you the Family Page with the preferred spouse.    

 Click OK to go to the current view of the individual whose name is highlighted.    The 
current view is the view that you were looking at before you opened the Index of Individuals. 
For example, if you were previously looking at an Ancestor tree, clicking OK in the Index of 
Individuals would take you to an Ancestor tree for the individual whose name is highlighted. 



Rearranging the Index of Individuals
You can rearrange the Index of Individuals so that the names are listed either alphabetically
or by birth dates.    If you need more general information about the Index of Individuals, see
the topic Using the Index of Individuals.
To rearrange the list of names in the Index of Individuals:
1. Click Options, located at the bottom of the Index of Individuals screen.    

Family Tree Maker displays a dialog box containing four sorting options.
2. Click the option button for the type of sorting you prefer.

Note:    You can only use the Quick Search feature when the Index of Individuals is sorted
by "Last name (A first)."

3. Click OK when you've made your selection.    
Family Tree Maker sorts the index according the option you chose in step 2.



Selecting an individual to attach
When you select the Attach Spouse or Attach Child commands, Family Tree Maker displays 
the Index of Individuals so you can choose an individual to attach.    Just click the name of 
the individual that you want to attach and then click OK.    Family Tree Maker closes the 
Index of Individuals and displays the Family Page containing the newly attached individual.  
Occasionally, you may mistakenly select an "illegal" individual to attach.    An "illegal" 
individual is someone who, for logical reasons, cannot possibly be attached in the 
relationship that you are creating.    For example, if Robert Brown was listed as a child on a 
particular Family Page, you could not attach him as a father on that same Family Page, 
because it is impossible for someone to be their own ancestor.



Using Find Individual
Using the Find Individual command, you can quickly locate anyone in your Family File  .      You 
can search for individuals using names, dates, comments, or even phrases from the Notes 
dialog box.    
Searching for names
Searching for other items



Searching for names

To search for an individual in your Family File by name, go to any Family Page 
and then:
1. From the Edit menu, select Find Individual (ALT, E, F).

Family Tree Maker displays the Find Individual dialog box.
2. Click the Search field and then select Name from the list that Family Tree Maker 

displays.
3. In the for field, type the name of the individual you wish to find.

If you're not sure of the exact name, type any part of the name.    Family Tree Maker will 
find any name containing those same letters.    For example, if you type hess, Family 
Tree Maker will find "Kenneth Hess," "Hessel Smith," "George Chess, III," and so on.

4. Click Find next to start the search.
Family Tree Maker displays the Family Page of the first individual who matches your 
request.    If no matches are found, Family Tree Maker displays a message saying "No 
individuals found."
If you like, you can edit any Family Pages that are found and then continue your search 
by reopening the Find Individual dialog box and clicking "Find Next."    (To reopen the Find 
Individual dialog box, from the Edit menu, select Find Individual (ALT, E, F).)

5. Click Find next to continue your search.
Continue clicking Find next until you're done searching or until Family Tree Maker runs 
out of matches.    To go back to previous matches, click Find previous.

6. To quit the search, click Cancel.
If you didn't find the name you were looking for, try typing a smaller portion of the name.
For example, type sm to look for the last name "Smith."

7. To go through the same search again, click Restart Search.
Family Tree Maker goes back to the beginning of your Family File and searches through it 
again for the individuals that match your search criteria.

See Also
Searching for other items



Searching for other items
To search for information other than a name, go to any Family Page and then:
1. From the Edit menu, select Find Individual (ALT, E, F).

Family Tree Maker displays the Find Individual dialog box.
2. Click the Search field and then choose the field name that you want to search on from 

the list that Family Tree Maker displays. 
For example, to find an individual with a specific birth date, you would click "Birth date."

3. In the for field, type the information that you want to search for.
For example, if you were searching on the Birth date field and wanted to find individuals 
born in October, you would type October    
Below is a table of searching tips for finding dates.

You type this Family Tree Maker finds this...

= All occurrences where that field is 
empty 

!= All occurrences where that field 
contains information

<10/2/1988
BEFORE 10/2/1988
BEF 10/2/1988

All dates before October 2, 1988, 
including dates entered as "Before 
October 2, 1988"

<=10/2/1988 The date October 2, 1988 and all 
dates before it, including dates 
entered as "Before October 2, 
1988"

>10/2/1988, or
AFTER 10/2/1988, 
or
AFT 10/2/1988

All dates after October 2, 1988, 
including dates entered as "After 
October 2, 1988"

>=10/2/1988 The date October 2, 1988 and all 
dates after it, including dates 
entered as "After October 2, 1988"

ABOUT 10/2/1988, 
or 
CIRCA 10/2/1988, 
or 
EST 10/2/1988

All dates entered as "About 
October 2, 1988," "Circa October 
2, 1988," or "Est October 2, 1988"

10/2/1988..10/2/19
90, or 
>=10/2/1988..<=1
0/2/1990

All dates between October 2, 1988 
and October 2, 1990 including 
those two days



>10/2/1988..<10/2
/1990

All dates between October 2, 1988 
and October 2, 1990 not including 
those two days

UNKNOWN or ? All dates entered as "Unknown" or 
"?"

If you want to search for numbers, you can use the operators >, <, >=, <=, and >X..<Y,
just as they are used with dates in the table above.    For example, if you want to find 
someone who is older than 82, you would enter >82.    If you want to find someone who is
six feet or taller, you would enter >=6.
If the item you are searching for only has certain legal values (such as male, female, and 
unknown), then a drop-down list may be displayed in the "for" field.    If this happens, just
choose one of the items listed.

4. Click Find next to start the search.
Family Tree Maker displays the Family Page of the first individual who matches your 
request.    If no matches are found, Family Tree Maker displays a message saying "No 
individuals found."
If you like, you can edit any Family Pages that are found and then continue your search 
by reopening the Find Individual dialog box and clicking "Find next."    (To reopen the Find 
Individual dialog box, from the Edit menu, select Find Individual (ALT, E, F).)

5. Click Find next to continue your search.
Continue clicking Find next until you're done searching or until Family Tree Maker runs 
out of matches.    To go back to previous matches, click Find previous.

6. To quit the search, click Cancel.
If you didn't find the Family Page you were looking for, try typing a smaller portion of the 
information.    For example, you could type 1988 to find "October, 1988."

7. To go through the same search again, click Restart Search.
Family Tree Maker goes back to the beginning of your Family File and searches through it 
again for individuals that match your search criteria.

See Also
Searching for names



Entering information in the More About dialog boxes
The five More About dialog boxes provide a place for you to record additional information 
about an individual.    The information that you record in the More About dialog boxes can 
be printed in trees, Family Group Sheets, labels and cards, and Custom reports.    (There is 
also a More About dialog box where you can record information about Pictures/Objects.    
See the topic "The More About Picture/Object dialog box.")
To display an individual's More About dialog boxes:
1. Go to the Family Page of the individual whose More About dialog boxes you want to 

see.
2. Click the More button next to that individual's name.    Family Tree Maker displays the 

More About dialog box you were on last, or the Facts dialog box if this is the first time 
you've used the More About dialog boxes.    Each More About dialog box has two parts:

 On the left, there's an area where you can record information about the individual.    
 On the right, there are buttons that you click to move to the other four More About dialog 

boxes.    These buttons appear on each of the More About dialog boxes, so it's easy to move 
between them.
For a description of each of the More About dialog boxes, select one of the topics listed 
below.    To return to the Family Page from any More About dialog box, from the View menu,
select Family Page (ALT, V, F), or click the Fam Pg button on the Toolbar.    
See Also
The Facts dialog box
The Lineage dialog box
The Medical dialog box
The Address dialog box
The Notes dialog box
The Marriage dialog boxes
The More About Picture/Object dialog box



The Facts dialog box
The Facts dialog box contains Fastfields for recording any 13 facts from an individual's life, 
such as special events, personal characteristics, or favorite activities.    The information that
you record in the Facts dialog box can be printed in trees, Family Group Sheets, labels and 
cards, and reports.    If you need more general information about the More About dialog 
boxes, such as displaying them or moving among them, see the topic Entering 
information in the More About dialog boxes.
Enter facts in as many of the "Comment/Location" fields as you like.    If there is a specific 
date related to a fact, you can enter it in the "Date" field.    Otherwise, leave the "Date" field
blank.    You can change the field labels for these fields, but keep in mind that the new field 
labels will appear on every Facts dialog box in Family Tree Maker.    If you imported a Family 
Tree Maker for DOS file into Family Tree Maker for Windows, some of the Comment/Location 
field labels will change automatically.
The "Comment/Location" fields can hold up to 80 characters.    If Family Tree Maker needs to
shorten these fields when you print them, it will simply truncate them.    To enter longer 
stories or biographical sketches to store separately from your trees, it's best to use the 
Notes dialog box.
See Also
Fastfields
The Notes dialog box
Field label preferences



The Lineage dialog box
The Lineage dialog box contains fields for recording nicknames and any special information 
about the relationship between an individual and their parents, such as an adoption.    The 
information that you record in the Lineage dialog box can be printed in trees, Family Group 
Sheets, labels and cards, and Custom reports.    If you need more general information about
the More About dialog boxes, such as displaying them or moving among them, see the 
topic Entering information in the More About dialog boxes.
Title (Dr., Reverend, Colonel, etc.)    Some individuals in your Family File may go by a 
special title, such as "Dr." or "Reverend."    When an individual has a special title, enter it in 
the Title field in the Lineage dialog box.    For all other individuals, leave the Title field 
blank.    Family Tree Maker will use the title that you selected in the Title preferences dialog 
box for all other individuals.
This person is also known as (aka)     You can choose to print nicknames in family trees 
and other documents, so it's important to use this field correctly.    Enter them as follows:
In the Family Page, make sure you enter the individual's full name, for example,    Jonathan
Robert Brown.    Then, in the Lineage dialog box enter the nickname, for example, John 
Brown.    You wouldn't just enter John in the Lineage dialog box because then if you chose to
print nicknames in trees, that individual would only show up as "John" without any last 
name.    
Reference number  This field can contain any numbers or letters that you choose.    You 
can use it as part of your own paper filing system.    Its use is entirely optional.    
Relationship with Mother and Relationship with Father    If a special relationship 
exists with either parent, record it here.    Select the appropriate parent's check box, and 
then select "Adopted," "Foster," or "Unknown."    
Exclude from Trees and Kinship if not in bloodline    If you don't want an individual 
who is not part of the bloodline to print in trees or to show up in Kinship reports, select the 
Exclude from Trees and Kinship if not in bloodline check box.    If you decide not to 
have an individual print in trees, then that individual and their descendants will not print in 
Descendant trees.    Also, that individual's ancestors will not print in Ancestor trees.
Note: This option is only available if you have selected one of the "Relationship 
with" check boxes.
Exclude from Calendars    If you don't want an individual to print in calendars, select the 
Exclude from Calendars check box.    Only the individual that you selected is affected.    
That individual's ancestors and descendants will print in calendars.
See Also
Title preferences



The Medical dialog box
The Medical dialog box contains fields for recording physical and medical information about
an individual.    The information that you record in the Medical dialog box can be printed in 
trees, Family Group Sheets, labels and cards, and Custom reports.    If you need more 
general information about the More About dialog boxes, such as displaying them or moving 
among them, see the topic Entering information in the More About dialog boxes.
Height    If your system is set for metric units, enter the individual's current or adult height 
in meters.    If your system is set for English units, enter the individual's height in feet and 
inches.
Weight    If your system is set for metric units, enter the individual's current or adult weight
in kilograms.    If your system is set for English units, enter the individual's weight in 
pounds.
Cause of death    Use this field to record the cause of an individual's death.    
Medical information  You can enter any type of medical information about the individual 
in this field.    You might want to record diseases, allergies, or serious illnesses that the 
individual had during his or her life.    



The Address dialog box
In the Address dialog box, you can record an individual's address and phone number.    The 
information that you record in the Address dialog box can be printed in trees, Family Group 
Sheets, labels and cards, and Custom reports.    If you need more general information about
the More About dialog boxes, such as displaying them or moving among them, see the 
topic Entering information in the More About dialog boxes.
Recording addresses can be useful if you're planning to send invitations to a family reunion 
or other family gathering, because this is where Family Tree Maker gets the addresses for 
printing mailing labels.    For the purpose of mailing labels, you do not have to type an 
address into each individual's Address dialog box.    This is because individuals can "inherit" 
addresses from their parents and spouses.    If an individual does not have an address in his
or her Address dialog box, Family Tree Maker first checks to see if the individual's spouse 
has an address.    If the individual's spouse does not have an address, Family Tree Maker 
uses the address of the individual's parents.    If the parents do not have an address either, 
the individual has no address.    Family Tree Maker will display a message underneath the 
address fields when it has found a possible address for this individual.
Street 1 and Street 2    Type the building number, street name, and apartment number, if 
applicable, in the Street 1 field.    You only need to use the Street 2 field if the address is 
particularly long.    
Phone(s)    You can enter more than one phone number in this field.    



The Notes dialog box
Each individual and each marriage in your Family File has a Notes dialog box.    You can use 
the Notes dialog box to enter and organize virtually any information, including a family 
member's favorite recipes, jokes, or even a short biography.    Just start typing -- the Notes 
page works like a mini-word processor.    
You cannot print information from the Notes dialog box in your trees but you can print your 
Notes on separate pages for easy filing or as a complete Family Group Sheet printout.    If 
you need more general information about the More About dialog boxes, such as displaying 
them or moving among them, see the topic Entering information in the More About 
dialog boxes.    
Finding text in the Notes dialog box

Select this topic to get help about locating a word or phrase that you have already typed 
into a Notes dialog box.

Formatting text in the Notes dialog box
Select this topic to get help about changing the appearance of the text that you have 
already typed into a Notes dialog box.

Copying text from another Windows program into Notes
Select this topic to get help about making a copy of text in another Windows program 
and placing that copy into a Notes dialog box.

Importing text into Notes from another program
Select this topic to get help about making a copy of text in a DOS or Windows program 
and placing it into a Notes dialog box.

Exporting Notes to another Windows program
Select this topic to get help about making a copy of text in a Notes dialog box and 
placing it into another Windows program.

Basic text editing
Select this topic to get help about editing the text that you enter into a Notes dialog box. 
You will find information about copying text, moving text, deleting text, and undoing your
last editing command.



Finding text in the Notes dialog box
Using the Find command, you can locate any text in a Notes dialog box.    If you need other 
information about the Notes dialog box, see the topic The Notes dialog box.
To find text in a Notes dialog box:
1. Make sure you're in the Notes dialog box that you want to search.
2. From the Edit menu, select Find (ALT, E, F).    
3. In the Find what field, type the text that you want to find.

If you type the letters "the," you'll locate any word with "the" in it.    For example, it would
find "there," "These," and "other," as well as "the."    If you only want to find the whole 
word, and not pieces of other words, select the Match whole word only check box.    If 
you only want to find words that are capitalized the same way as the text you typed in 
the "Find What" field, select the Match case check box.

4. Click Find next.    Family Tree Maker scrolls down through the text to find what you're 
searching for.    
When Family Tree Maker locates the text, the cursor will stop on it.    You can click Find 
next to continue looking or Cancel to quit the search.

5. If you didn't start searching at the top, when Family Tree Maker gets to the bottom of 
your Notes, it will ask if you want to continue the search from the top of the notes.    
Click Yes to continue searching from the top or click No to quit the search.



Formatting text in the Notes dialog box
In the Notes dialog box, when you make formatting choices you are formatting all of the 
Notes for this one individual.    You cannot format individual words or phrases.    In addition, 
the formatting choices that you make will not appear on the screen.    They will only be 
visible when you print the Notes.    If you need other information about the Notes dialog 
box, see the topic The Notes dialog box.
To format text in the Notes dialog box:
1. From the Format menu, select Text Font, Style, & Size (ALT, T, T).

Family Tree Maker displays the Text Font, Style, & Size dialog box.
2. Make your formatting selections from the drop-down lists on the right side of the dialog

box.
Note:    The Notes dialog box can only display a single system font.    This means that 
when you make any font, size, or style changes to your notes, the changes will not 
appear on screen.    However, when you print your notes, the text should be formatted 
according to the selections that you make in the Text Font, Style, & Size dialog box.    To 
see what the text in your notes will look like before you print, look at the "Sample" field 
in the Text Font, Style, & Size dialog box.
In addition, if you type in any special characters using the ALT key and a number 
sequence, for example, symbols or foreign characters, they may appear as different 
characters on the screen.    Again, check them when you print, they should print correctly.

3. When you're finished making your selections, click OK to return to the Notes dialog 
box.



Copying text from another Windows program into Notes
You can copy information from a Windows program to the Clipboard and then paste it into 
Notes.    If you want to transfer information from a DOS program into Family Tree Maker, you
must use the Import command.    See the topic "Importing text into Notes from another 
program."    If you need other information about the Notes dialog box, see the topic The 
Notes dialog box.
To transfer information from another Windows program into Family Tree Maker:
1. In the other Windows program, copy the information to the Clipboard.

If you need assistance with this, consult the documentation that came with the other 
program.

2. In Family Tree Maker, go to the Notes dialog box where you want to place the 
information.

3. Position your cursor where you want to insert the information.    If you want to replace a
section of existing text with the information that you've just copied to the Clipboard, 
highlight that text.

4. From the Edit menu, select Paste (ALT, E, P).    
Since the Clipboard is not erased until you use the Copy or Cut command again, you can 
paste the information multiple times.
See Also
Importing text into Notes from another program



Importing text into Notes from another program
If you've written paragraphs of family information using another software program you may
be able to import that information into the Notes dialog box.    To do this, the other program 
must be able to create an ASCII file.    Check the manual of your other program to see if and
how you can export your information to an ASCII file.    If you need other information about 
the Notes dialog box, see the topic The Notes dialog box.
Once you've created the ASCII file in the other program, you can import its 
contents into an individual's Notes dialog box.    To do this:
1. Go to the Notes dialog box where you want to place the text.
2. Position the cursor where you want to insert the information you're importing.    If you 

want to replace a section of existing text with the information that you're importing, 
highlight that text.

3. From the File menu, select Import Text File (ALT, F, I).
Family Tree Maker displays the Import Text File dialog box.

4. In the Drives and Directories fields, select the drive and directory where the file you 
want to import is located.

5. Select the correct file type from the File format drop-down list box.    
In general, DOS programs create ASCII (PC-8) files, and Windows programs create ASCII 
(ANSI) files.    If you are unsure what type of file your other program created, check the 
manual for that program.

6. From the File name list, select the file that you want to import into the Notes dialog.
7. Click OK.    

Family Tree Maker inserts a copy of the information into the Notes dialog box.



Exporting Notes to another Windows program
You can export the text from a Notes dialog box and bring it into another program.    To do 
this, you create an ASCII text file with Family Tree Maker and open or import it in the other 
program.    Check the manual of your other program to see if your program can read, or 
import, ASCII files.    If you need other information about the Notes dialog box, see the topic 
The Notes dialog box.
To create an ASCII file containing the information in an individual's Notes dialog 
box:
1. Go to the Notes dialog box that has the text you want to export.
2. From the File menu, select Export Notes (ALT, F, E).

Family Tree Maker displays the Export Notes dialog box.
3. In the Drives and Directories fields, select the drive and directory where you want to 

place the file you're creating.
4. Select the correct file type from the File format drop-down list box.    

See the manual of your other program to find out which type of file you need to create, 
either ANSI or PC-8.    In general, Windows programs can import ANSI files and DOS 
programs can import PC-8 files.

5. Type a file name in the File name field.
6.  Click OK.    

Family Tree Maker creates an ASCII file that you can open with your other program. 



The Marriage dialog boxes
Each marriage in Family Tree Maker has its own set of More About dialog boxes:    a Facts 
dialog box and a Notes dialog box.    You can use these to record information, such as a 
special anniversary, about a specific marriage.    If the status of the relationship changed 
over time, you can also record that.    
To display the More About dialog boxes for a marriage:
1. Go to the Family Page of the couple whose More About dialog boxes you want to see.
2. Click the More button next to their marriage.

Family Tree Maker displays whichever of the dialog boxes you used last.    If you haven't 
accessed the More About dialog boxes for that marriage yet, then the Family Tree Maker 
displays the Facts dialog box.    

The Notes dialog box for a marriage works exactly like the Notes dialog box for an 
individual.    However, the Facts dialog box for a marriage is different than the Facts dialog 
box for an individual.
See Also
The Marriage Facts dialog box
The Notes dialog box



The Marriage Facts dialog box
The left side of the Marriage Facts dialog box has fields for recording facts about a 
marriage.    The right side has buttons that let you move between the two Marriage dialog 
boxes.    This topic describes how to use each of the fields on the left.    If you need more 
general information about the More About dialog boxes for a marriage, such as displaying 
them or moving between them, see the topic The Marriage dialog boxes.    
End date/location    If the relationship ended for any reason, type a date and location into 
these two fields.    
Ending status    Click the arrow next to the "Ending status" field and then select one of the
relationship codes from the drop-down list.    Your choices include the following:    
"Annulment," "Death of Spouse," "Divorce," "None," "Ongoing," "Other," "Separation," and 
"Unknown."
Marriage fact date/location    If the marriage has a significant event or date associated 
with it, you can use these fields to record it.
Reference number    This field can contain any letters and numbers.    You can use it as 
part of your own paper filing system.    Its use is entirely optional.    



Using the Other Spouses dialog box
When an individual has more than one marriage, you must create a separate Family Page 
for each additional spouse.    The individual who has had multiple spouses then will appear 
on multiple Family Pages.    
Creating additional spouses

Select this topic to get help about creating another spouse for an individual who already 
has at least one spouse.

Choosing a preferred spouse
Select this topic to get help about deciding which of an individual's spouses Family Tree 
Maker should display when you choose to go to an individual's Family Page.

Displaying the Family Pages of additional spouses
Select this topic to get help about moving from a Family Page that contains one of an 
individual's spouses to a Family Page that contains another of an individual's spouses



Creating additional spouses

To create a Family Page for another spouse: 
1. Bring up the Family Page containing the husband or wife . 
2. Click Spouses next to the individual for whom you want to create another spouse. 

Family Tree Maker displays the Spouses dialog box.    You have the choice of going to an 
existing spouse, creating a new spouse, or choosing a preferred spouse.    

3. Click Create a new spouse to enter information about the new spouse.    
Family Tree Maker takes you to a new Family Page that shows the individual you were 
creating a new spouse for and an empty space in which to enter the new spouse.    

4. Type in the information for the new spouse.
See Also
Choosing a preferred spouse
Displaying the Family Pages of additional spouses



Choosing a preferred spouse
The Family Page of an individual and that individual's preferred spouse is the Family Page
that Family Tree Maker will display when navigating to that individual.    For example, John 
has had two spouses, Susan and Mary.    Mary is his preferred spouse.    When you go to 
John's Family Page, you will see the Family Page that shows Mary as his wife.
Of course, you can still go to the Family Pages that contain an individual's other spouses, as
described in "Displaying the Family Pages of Additional Spouses."    
To select an individual's preferred spouse:
1. On the Family Page, click Spouses for the individual whose Spouses dialog box you 

want to see.    Or, click the individual's name and then press F3.
Family Tree Maker displays the Spouses dialog box.    

2. In the Select a spouse to go to list, click the name of the spouse that you want to be
the preferred spouse.

3. Click the Make the highlighted spouse the preferred spouse button.
4. Click OK when you've made your selection.    

Family Tree Maker displays the Family Page containing the preferred spouse.
You can change your preferred spouse selection at any time by repeating these four steps.
See Also
Displaying the Family Pages of additional spouses



Displaying the Family Pages of additional spouses
If you need other information about additional spouses, see the topic Using the Other 
Spouses dialog box.
To see the Family Page of another spouse: 
1. On the Family Page, click Spouses for the individual whose Spouses dialog box you 

want to see.    Alternatively, you can click the individual's name and then press F3.
Family Tree Maker displays the Spouses dialog box.    

2. In the Select a spouse to go to list, click the name of the spouse whose Family Page 
you want to see and then click OK.
Family Tree Maker takes you to the Family Page containing the spouse that you selected 
in step 2.



Entering information in Scrapbooks
In Scrapbooks, you can store virtually any type of information about your family, including 
Kodak Photo CD Pictures; OLE objects such as sound files, video files, text files, and picture 
files; and non-OLE picture files such as bitmaps, and TIFF files.    Each individual and each 
marriage in your Family File has a Scrapbook, so you'll have wonderfully complete 
collections of family information to pass on from generation to generation.
Scrapbook pages allow you to use your creativity.    For example, you could use scanned 
pictures and school papers, along with video files to create childhood pages in each of your 
children's Scrapbooks.    Scanned photos of a couple's wedding and anniversary parties 
combined with special songs would make a beautiful record of a marriage.    With all of the 
different types of pictures and objects that you can include in Scrapbooks pages, the 
possibilities are endless!    The topics listed below will help you create your own special 
Scrapbooks.
Scrapbook basics

Select this topic to get help about opening Scrapbooks and selecting a default resolution 
and compression for the items that you place in Scrapbooks.    You will also find 
information about what types of items you can place in Scrapbooks.

Inserting items into Scrapbooks
Select this topic to get help about how to place items such as pictures, sound clips, and 
video clips into Scrapbooks.

Working with Scrapbooks
Select this topic to get help about recording important information for each of the 
Pictures/Objects that you place in your Scrapbooks; moving around in Scrapbooks; 
finding Pictures/Objects in Scrapbooks; viewing Pictures/Objects at full size; playing 
Scrapbooks; sorting Scrapbooks; editing Pictures/Objects; and controlling the brightness, 
contrast, resolution, and compression of Pictures/Objects.

Printing Family Tree Maker Documents
Select this topic to get help about printing Scrapbooks.    In addition, you will find 
information about printing other documents that can contain Pictures/Objects:    family 
trees, Family Group Sheets, and labels and cards.



Scrapbook basics
Opening Scrapbooks

Select this topic to get help about displaying an individual's or a marriage's Scrapbook.
What goes into Scrapbooks?

Select this topic to get help about what types of items you can place in Scrapbooks, such
as pictures, sound clips, and video clips.

Scrapbook preferences
Select this topic to get help about selecting a default resolution and compression for the 
items that you place in Scrapbooks.



Opening Scrapbooks
If you are ready to print a Scrapbook and you do not need to enter any new items into the 
Scrapbook before you print, do not use these instructions.    Instead, open the Scrapbook 
using the topic Displaying Scrapbooks for printing.    If you would like to enter new 
items into the Scrapbook, use the instructions below.
You can open Scrapbooks from any view.    However, we'll first explain how to open 
Scrapbooks from the Family Page.        If you need other information about Scrapbooks, see 
the topic Entering information in Scrapbooks.
To display an individual's or a marriage's Scrapbook:
1. Go to the Family Page containing the individual or the marriage whose Scrapbook you 

want to see.
Use the Index of Individuals or Find Individual to find an individual's Family Page.    

2. On the Family Page, place the cursor either on the name of the individual or on the 
marriage whose Scrapbook you want to see.

3. From the View menu, select Scrapbook (ALT, V, S).
Family Tree Maker displays the individual's or marriage's Scrapbook.    If this is the first 
time that you have opened a Scrapbook in Family Tree Maker, you will be on the first 
page of the Scrapbook.    If you have opened a Scrapbook previously, you may be on a 
page other than the first one.
The Scrapbook view is a data entry view:    it is for placing new items into the Scrapbook 
and using the More About Picture/Object dialog box to enter information about each 
Picture/Object.    You cannot use most of the commands on the Contents and Format 
menus while you are in the Scrapbook view, because those commands are related to the 
appearance of a Scrapbook when you print it.    To use the commands on the Contents 
and Format menus, you must be in Scrapbook Print Preview.    If you want to use those 
commands, from the File menu, select Print Preview (ALT, F, V).

If you want to open a Scrapbook from a view other than the Family Page, simply do step 3 
while you are in that view.    Family Tree Maker will display the Individual Scrapbook for the 
primary individual.
Note:    If the Scrapbook that Family Tree Maker displays is not for the correct individual, 
you can navigate to their Scrapbook easily.    Click Index on the toolbar, select the 
individual whose Scrapbook you want to see, and then click OK to see the correct 
Scrapbook.

See Also
Using the Index of Individuals
Using Find Individual



What goes into Scrapbooks?
As we've said before, you can store virtually any type of family information in a Scrapbook, 
including your family photographs and any other paper memorabilia that's been scanned; 
pictures, and other items that can be pasted to and from the Clipboard; sound clips, video 
clips, and other OLE objects; Kodak Photo CD pictures; and text.    Once one of these 
items is stored in a Scrapbook, we refer to it as a Picture/Object. If you're uncertain about
what these different terms refer to, keep reading.    We'll explain each of them below.    If 
you need other information about Scrapbooks, see the topic Entering information in 
Scrapbooks.
Note:    If you are planning to include large images and video clips in your Scrapbooks, 
keep the capabilities of your computer in mind.    If you only have the minimum system 
requirements, your machine will run slowly when you work with large images and video 
clips.    In fact, if your machine does not have enough RAM, you may not be able to load 
particularly large files.    In addition, you will need quite a bit of free space on your hard 
drive to store large images and video clips.    See the topic "Picture Size and Your 
Computer." 

Kodak Photo CD Pictures
A Kodak Photo CD is a CD-ROM disc containing pictures that came directly from your 
undeveloped film, negatives, or old photos.    Placing your pictures on a Kodak Photo CD is 
easy to do and a great way to prepare family photos for use with Family Tree Maker.    For 
more information about creating Kodak Photo CDs, see Appendix C of your manual.
To use Kodak Photo CDs, the only special equipment you need is a CD-ROM player on your 
computer that can read a Kodak Photo CD (many earlier CD-ROM players cannot).    If you 
have one of these CD-ROM players, Family Tree Maker can read and import your Photo CD 
Pictures. 

Pictures
"Pictures," sometimes called graphics, are electronic images.    There are many ways to get 
pictures:
 Take your undeveloped film, old photos, or negatives to a Kodak processor and have the 

images placed on a Kodak Photo CD.
 Scan, create, or purchase pictures that you can store on your hard disk in a graphics file.    

You can create your own pictures using a graphics software program.    Scanning is described
in the next section.

 Cut or copy an image from another software program, another Scrapbook in Family Tree 
Maker, or another view in Family Tree Maker and store it temporarily on the Clipboard as a 
bitmap or metafile.

 Cut or copy an image from any OLE server application and store it temporarily on the 
Windows Clipboard.
Pictures can be stored in many different file formats.    Some common formats are bitmap 
(.BMP) and Tagged Image File Format (.TIF).    When you have pictures in these or one of 
several other file formats, you can place them into your Family Tree Maker Scrapbooks.    
Placing pictures into Family Tree Maker is described in the topic "Inserting Items into 
Scrapbooks."

Scanning
"Scanning" is making an electronic reproduction of a paper item, such as a photograph, 
newspaper clipping, birth certificate, or diploma.    In effect, scanning is a way of making 
your own pictures, just like those described in "Pictures," above.    Scanning is a great way 
to preserve family memorabilia, because scanned images won't fade or become brittle like 



paper and photographs tend to do after many years.    And, once you have a scanned image
of an item, you can store it safely on your computer.
To scan an item, you must have a scanner and scanner software.    Family Tree Maker does 
not scan items for you, nor can it act as scanning software.    There are many different types
of scanners, made by many different companies.    Most scanners come with their own 
software.    If you are interested in scanning your paper memorabilia, the best thing to do is 
to talk with your local computer dealer.    They should be able to help you choose the 
scanner that is right for you.    Of course you'll also want to read the manuals for the 
scanner so that you can correctly create electronic images to place in your Family Tree 
Maker Scrapbooks.

Object Linking and Embedding (OLE)
Object Linking and Embedding (OLE) is a technology that lets you create items in one 
software program and place them in another software program.    For example, you can use 
video capture software to transfer clips of your home videos onto your computer.    Then, 
with the help of Object Linking and Embedding you can transfer video clips from your video
capture software into Family Tree Maker Scrapbooks.    
OLE objects are items, such as the video clips described above, that can be transferred 
from one software program to another.    The types of objects you might want to use in 
Scrapbooks include sound clips; video clips; still images or pictures; and text objects from a
word processor, spreadsheet or database.    
An OLE server is a software program, such as the video capture software described above,
that creates OLE objects.    Any Windows 3.1 (or higher) compatible program can be an OLE
server.    Not all are, so it is important to read the box carefully before making a purchase.    
Most software manufacturers will advertise OLE server capability if they have it or you can 
call the manufacturer to ask before purchasing.    
An OLE client is a software program, such as Family Tree Maker, into which OLE objects 
can be placed.    Think of it in terms of a restaurant:    the server creates the food and serves
it to the client, and the client eats (or stores) it.    For a more thorough description of Object 
Linking and Embedding, see the index of your Microsoft Windows 3.1 (or later) User's 
Guide.

Text
While the Notes dialog box is generally where you store text, there may also be cases when
you want to store text in the Scrapbook.    For example, if your child used a word processor 
to write a paper for school or a letter to grandma, you might want to save the word 
processor file in the Scrapbook.    
To store text (word processor files) in the Scrapbook, you cannot just use the Edit menu to 
copy and paste it into the Scrapbook.    Instead, you need to treat the text as an OLE object. 
For more information about OLE objects, see "Object Linking and Embedding (OLE)" above.
See Also
Inserting items into Scrapbooks
Picture size and your computer



Inserting items into Scrapbooks
There are five different ways to place Pictures/Objects into a Scrapbook.    The method that 
you use will depend on what it is that you want to place in the Scrapbook.    Use the table 
below to help determine which method you should use in each case, then use the list at the
bottom of this topic to jump to the information that you need.    If you need other 
information about Scrapbooks, see the topic Entering information in Scrapbooks.
You can place items in a Scrapbook in any order that you wish, but you cannot leave blank 
spaces; new items must be placed right after the last Picture/Object in the Scrapbook.    In 
addition, you can insert new items in front of existing Pictures/Objects by selecting the 
existing Picture/Object and then inserting the new item.

When you have... Use this method...

A Kodak Photo CD Picture. Picture/Object:    Insert Photo 
CD Picture

A graphics file, such as a scanned image or clip 
art, stored on your computers hard disk.    
Compatible file formats include (*.BMP), (*.GIF), 
(*.PCX), (*.TIF), (*.JPG), and (*.JFF).

Picture/Object:    Insert Picture 
from File

An OLE object in a file.    Also use this method 
when you want to create a new OLE object and 
then insert it into the Scrapbook.

Picture/Object:    Insert Object

Items that you have cut or copied to the 
Clipboard, such as an Ancestor tree, or even a 
Picture/Object that you are copying from one 
Scrapbook to another.

Edit:    Paste

OLE objects on the Clipboard, such as pictures, 
text, video, and sound.    

Edit:    Paste or Edit:    Paste 
Special

See Also
Picture/Object:    Insert Photo CD Picture
Picture/Object:    Insert Picture from File
Picture/Object:    Insert Object
Edit:    Paste
Edit:    Paste Special



Picture/Object:    Insert Photo CD Picture
Using the Insert Photo CD Picture command on the Picture/Object menu, you can insert 
pictures from Kodak CD-ROM discs.    When you insert pictures, keep the capabilities of your
computer in mind.    If you insert large picture files, your machine may run slowly.    In fact, if
your machine does not have enough RAM, you may not be able to load particularly large 
files.    In addition, you will need quite a bit of free space on your hard drive to store large 
images and video clips.    See the topic "Picture Size and Your Computer," for more 
information.    If you need other information about Scrapbooks, see the topic Entering 
information in Scrapbooks.
To insert a Kodak Photo CD picture into a Scrapbook:
1. In the Scrapbook, select the area into which you want to insert the picture.

If you insert a picture when an empty Picture/Object area is selected, the picture goes 
into that Picture/Object area.    If you insert a picture when an occupied Picture/Object 
area is selected, Family Tree Maker moves the Pictures/Objects on that Scrapbook page 
to the right and inserts a new Picture/Object area for the new picture.

2. From the Picture/Object menu, select Insert Photo CD Picture.
Family Tree Maker displays the Insert from Photo CD dialog box.    You have several 
options.
First, you can use your computer keyboard to move around and select pictures in this 
dialog box.    See the topic "Navigating in the Insert Photo CD Picture dialog box" to see 
which keys you can use to navigate in this dialog box.
Find  Use this button to locate a particular picture on the Photo CD.    Simply type the 
number of the picture in the Find Photo Number field and then click OK.    Family Tree 
Maker returns you to the Insert from Photo CD dialog box and selects the picture that you
chose.
View    Use this button to display the currently selected picture at full size in the View 
Picture dialog box.    In the View Picture dialog box you can use the scroll bars and the 
Zoom buttons to get a better look at your picture.    The choices that you make in the 
View Picture dialog box do not change the Picture; they are only for viewing purposes.    
Click OK in the View Picture dialog box to return to the Insert from Photo CD dialog box.
Resolution    Use this button to change the resolution and compression with which this 
picture will be stored in the Scrapbook.    See the topic "Picture Resolution and 
Compression" for a complete description of the Compression/Resolution dialog box.    For 
most cases, you do not need to change the compression and resolution.    However, if you
have a reason for altering the resolution, go ahead and do it now.

3. Click OK in the Insert from Photo CD dialog box when you are ready to insert a picture.
Family Tree Maker displays the Edit Picture dialog box where you can select editing 
options.    The editing options fall into three categories:    rotating, flipping, and cropping.   
Rotating allows you to re-orient pictures that are sideways or upside down, flipping is for 
adjusting pictures that are backwards, and cropping allows you to select the area of the 
picture that you want to place in the Scrapbook.    

Note:    If you want to edit a picture, this is the best time to do it.    This is because Family 
Tree Maker compresses images for storage unless you select 1:1 compression.    Once you
have placed a picture in the Scrapbook, it must be decompressed and recompressed each
time you edit it again.    Decompressing and recompressing a picture multiple times 
reduces the quality of the picture.    (Family Tree Maker uses the industry standard JPEG 
compression method.)    Please note that printing and viewing your picture at different 
sizes does not involve compression and will not reduce the quality of your picture.



The rotation options are:
Rotate L    Use this button to rotate the picture ninety degrees to the left (counter-
clockwise).    
Rotate R    Use this button to rotate the picture ninety degrees to the right (clockwise).    
180    Use this button to rotate the picture 180 degrees.

The flipping options are:
Mirror    Use this button to flip the picture from left-to-right.    
Flip    If the items in your picture are upside-down instead of right side up, use this 
button to flip the picture.

To crop the picture:
1. Move the cursor onto the image.

The cursor becomes a cross-hair (large plus sign).
2. Position the cross-hair over the exact spot where you want the top left corner of the 

cropped picture to be.
3. Press and hold the mouse button while you drag diagonally to the exact spot where 

you want the lower right corner of the cropped picture to be, then release the mouse 
button.
The area of the picture that will remain after the picture is cropped will have a box 
around it.    If you do not like the position of the box, simply repeat steps 2 and 3 to 
create a new box.

4. When you have a box around the area that you want to keep, click Crop.
Family Tree Maker deletes the part of the picture that you chose to crop off, showing you 
what the cropped picture will look like.    If you want to remove even more of the original 
picture, repeat steps 2, 3, and 4.    If you feel that you have cropped too much of the 
picture, click Cancel to start again.    

When you click OK to leave the Edit Picture dialog box, Family Tree Maker compresses and 
saves your picture in the Family File.    The picture is now visible in the Scrapbook at a 
reduced size, called a thumbnail.    The thumbnail's small size allows you to see several 
different images on the screen at once.    The real, full-size images will be used for printing 
and viewing.
Once you have inserted a picture into the Scrapbook, you should use the More About 
Picture/Object dialog box to create a caption and to tell Family Tree Maker in which 
documents you want the picture to print.    See the topic "The More About Picture/Object 
Dialog Box." 
You can also edit and change the compression of the picture once it's in the Scrapbook.    
See the topics "Picture Editing" and "Picture Resolution and Compression."
See Also
Picture size and your computer
Navigating in the Insert Photo CD Picture dialog box
The More About Picture/Object dialog box
Editing Pictures/Objects
Picture resolution and compression



Navigating in the Insert Photo CD Picture dialog box
You can use the following keys to navigate through and select pictures in the Insert Photo 
CD Picture dialog box.

Press this key To do this

Up arrow Move to the picture above the currently selected 
picture

Down arrow Move to the picture below the currently selected 
picture

Left arrow Move to the picture to the left of the currently 
selected picture

Right arrow Move to the picture to the right of the currently 
selected picture

Tab Move forwards between the buttons in the dialog 
box

Shift + Tab Move backwards between the buttons in the dialog 
box

Home Move to the first picture on the current screen

End Move to the last picture on the current screen

Ctrl + Home Move to the first picture on the CD

Ctrl + End Move to the last picture on the CD

Page up Move to the picture one screen up

Page down Move to the picture one screen down



Picture/Object:    Insert Picture from File
Using the Insert Picture from File command on the Picture/Object menu you can insert 
pictures from files into a Scrapbook.    The Scrapbook accepts the following file formats:    
 Windows Bitmap (*.BMP)
 CompuServe Bitmap (*.GIF)
 ZSoft Image (*.PCX)
 Tagged Image Format (*.TIF)
 JPEG Interchange Format (*.JPG, *.JFF)
When you insert pictures, keep the capabilities of your computer in mind.    If you insert 
large picture files, your machine may run slowly.    In fact, if your machine does not have 
enough RAM, you may not be able to load particularly large files.    In addition, you will need
quite a bit of free space on your hard drive to store large images.    See the topic "Picture 
Size and Your Computer" for more information.    If you need other information about 
Scrapbooks, see the topic Entering information in Scrapbooks.
To insert a picture into a Scrapbook with the Insert Picture from File command:
1. In the Scrapbook, select the area into which you want to insert the picture.

If you insert a picture when an empty Picture/Object area is selected, the picture goes 
into that Picture/Object area.    If you insert a picture when an occupied Picture/Object 
area is selected, Family Tree Maker moves the Pictures/Objects on that Scrapbook page 
to the right and inserts a new Picture/Object area for the new picture.

2. From the Picture/Object menu, select Insert Picture from File (ALT, O, F).
Family Tree Maker displays the Insert Picture dialog box.    If you know where your file is, 
continue with the instructions below.    If you are unsure where your file is located, see 
the topic "Finding Files."

3. In the Drives and Directories fields, select the drive and directory where the picture 
file you want to insert is located.

4. Click the arrow next to the List Files of Type field and select the format of the file that
you want to open.

5. Click the name of your file in the File Name field.
When a file name is selected, you have several options:
Preview Picture    Select this check box to view the picture at reduced size in the 
"Preview" field.
View    Use this button to display the picture at full size in the View Picture dialog box.    
In the View Picture dialog box you can use the scroll bars and the Zoom buttons to get a 
better look at your picture.    Click OK in the View Picture dialog box to return to the 
Insert Picture dialog box. 
Compression    Use this button to change the compression with which this picture will 
be stored in the Scrapbook.    See the topic "Picture Resolution and Compression" for a 
complete description of this dialog box.    For most cases you do not need to change the 
compression.    However, if you have a reason for altering the compression, go ahead and
do it now.

6. Click OK in the Insert Picture dialog box.
Family Tree Maker displays the Edit Picture dialog box where you can select editing options. 
The editing options fall into three categories:    rotating, flipping, and cropping.    Rotating 
allows you to re-orient pictures that are sideways or upside down, flipping is for adjusting 
pictures that are backwards, and cropping allows you to select the area of the picture that 
you want to place in the Scrapbook.    



Note:    If you want to edit a picture, this is the best time to do it.    This is because Family 
Tree Maker compresses images for storage unless you select 1:1 compression.    Once you
have placed a picture in the Scrapbook, it must be decompressed and recompressed each
time you edit it again.    Decompressing and recompressing a picture multiple times 
reduces the quality of the picture.    (Family Tree Maker uses the industry standard JPEG 
compression method.)    Please note that printing and viewing your picture at different 
sizes does not involve compression and will not reduce the quality of your picture.

The rotation options are:
Rotate L    Use this button to rotate the picture ninety degrees to the left (counter-
clockwise).    
Rotate R    Use this button to rotate the picture ninety degrees to the right (clockwise).    
180    Use this button to rotate the picture 180 degrees.

The flipping options are:
Mirror    Use this button to flip the picture from left-to-right.    
Flip    If the items in your picture are upside-down instead of right side up, use this 
button to flip the picture.

To crop the picture:
1. Move the cursor onto the image.

The cursor becomes a cross-hair (large plus sign).
2. Position the cross-hair over the exact spot where you want the top left corner of the 

cropped picture to be.
3. Press and hold the mouse button while you drag diagonally to the exact spot where 

you want the lower right corner of the cropped picture to be, then release the mouse 
button.
The area of the picture that will remain after the picture is cropped will have a box 
around it.    If you do not like the position of the box, simply repeat steps 2 and 3 to 
create a new box.

4. When you have a box around the area    that you want to keep, click Crop.
Family Tree Maker deletes the part of the picture that you chose to crop off, showing you 
what the cropped picture will look like.    If you want to remove even more of the original 
picture, repeat steps 2, 3, and 4.    If you feel that you have cropped too much of the 
picture, click Cancel to start again.    

When you click OK to leave the Edit Picture dialog box, Family Tree Maker compresses and 
saves your picture in the Family File.    The picture is now visible in the Scrapbook at a 
reduced size, called a thumbnail.    The thumbnail's small size allows you to see several 
different images on the screen at once.    The real, full-size images will be used for printing 
and viewing.
Once you have inserted a picture into the Scrapbook, you should use the More About 
Picture/Object dialog box to create a caption and to tell Family Tree Maker in which 
documents you want the picture to print.    See the topic "The More About Picture/Object 
Dialog Box."
You can also edit and change the compression of the picture once it's in the Scrapbook.    
See the topics "Editing Pictures/Objects" and "Picture Resolution and Compression."
See Also
Picture size and your computer
Finding files



The More About Picture/Object dialog box
Editing Pictures/Objects
Picture resolution and compression



Picture/Object:    Insert Object
With the Insert Object command, you can insert existing OLE objects into the Scrapbook.    
In addition, you can create new OLE objects and then insert them into the Scrapbook.    OLE
objects include pictures, text, spreadsheets, sound clips, and video clips.    When you insert 
pictures, video, or sound files, keep the capabilities of your computer in mind.    If you insert
large files, your machine may run slowly.    In fact, if your machine does not have enough 
RAM, you may not be able to load particularly large files.    In addition, you will need quite a 
bit of free space on your hard drive to store large images and video clips.    See the topic 
"Picture Size and Your Computer," for more information.    If you need other information 
about Scrapbooks, see the topic Entering information in Scrapbooks.
See Also
Picture size and your computer
Creating new objects to insert
Inserting existing objects



Creating new objects to insert
If you need other information about Scrapbooks, see the topic Entering information in 
Scrapbooks.
To insert an existing OLE object into a Scrapbook with the Insert Object 
command:
1. In the Scrapbook, select the area into which you want to insert the object.

If you insert an OLE object when an empty Picture/Object area is selected, the OLE object
goes into that Picture/Object area.    If you insert an OLE object when an occupied 
Picture/Object area is selected, Family Tree Maker moves the Picture/Object areas on that
Scrapbook page to the right and inserts a new Picture/Object area for the new OLE 
object.

2. From the Picture/Object menu, select Insert Object (ALT, O, O).
Family Tree Maker displays the Insert Object dialog box.

3. Select the Create from file option button.    
4. In the File field, type the path and name of the file containing the OLE object that you 

want to insert into the Scrapbook.
For example, if you had a file called "sound.wav" in the "windows" directory on your C:\ 
drive, you would type C:\windows\sound.wav
If you do not remember the exact name and location of your file, click Browse to display
the Browse dialog box.    In the Browse dialog box, use the Drives and Directories fields
to locate your file.    Click OK to return to the Insert Object dialog box.
If you want to view an icon in the Scrapbook instead of the OLE object itself, select the 
Display as Icon check box.    You may want to do this if you are pasting in a text file or 
some other object that isn't attractive when it's shrunk down to fit into the Picture/Object
area.    
When you select this option, you can change the appearance of the icon by clicking 
Change icon.    In the Change Icon dialog box, you can either type the file name for the 
new icon in the From File field or search for an icon file by clicking Browse.    Click OK 
to return to the Insert Object dialog box.

5. When the correct file name is in the File field, click OK.
Family Tree Maker places the OLE object in the Scrapbook.    

Once you have inserted an OLE object into the Scrapbook, you should use the More About 
Picture/Object dialog box to create a caption and to tell Family Tree Maker in which 
documents you want the item to print.    See the topic "The More About Picture/Object 
Dialog Box."
You can also edit an OLE object once it's in the Scrapbook.    See the topic "Editing OLE 
Objects."
See Also
Picture size and your computer
The More About Picture/Object dialog box
Editing OLE objects



Inserting existing objects
If you need other information about Scrapbooks, see the topic Entering information in 
Scrapbooks.
To create a new OLE object to insert into a Scrapbook:
1. In the Scrapbook, select the area into which you want to insert the object.

If you insert an OLE object when an empty Picture/Object area is selected, the OLE object
goes into that Picture/Object area.    If you insert an OLE object when an occupied 
Picture/Object area is selected, Family Tree Maker moves the Pictures/Objects on that 
Scrapbook page to the right and inserts a new Picture/Object area for the new OLE 
object.

2. From the Picture/Object menu, select Insert Object (ALT, O, O).
Family Tree Maker displays the Insert Object dialog box.

3. Select the Create new option button.    
4. In the Object Type scrolling list, click the name of the OLE object that you want to 

insert into the Scrapbook. 
Microsoft Windows opens the software program in which you can create the OLE object to
insert into the Scrapbook.

5. In the other software program, create the OLE object. 
If you need instructions for using that software program, please refer to its manual.

6. From the File menu of that software program, select Exit and Return to Family Tree
Maker.
Microsoft Windows closes the software program and returns you to Family Tree Maker.    
(Windows may also ask you if you want to update or save your information; answer Yes 
or OK.)    Family Tree Maker places the OLE object in the Scrapbook.    

Once you have inserted an OLE object into the Scrapbook, you should use the More About 
Picture/Object dialog box to create a caption and to tell Family Tree Maker in which 
documents you want the item to print.    See the topic "The More About Picture/Object 
Dialog Box."
You can also edit an OLE object once it's in the Scrapbook.    See the topic "Editing OLE 
Objects."
See Also
Picture size and your computer
The More About Picture/Object dialog box
Editing OLE objects



Edit:    Paste
Using the Paste command on the Edit menu is one of the easiest ways to place items into a 
Scrapbook.    With the Paste command you can insert Pictures/Objects from other 
Scrapbooks; OLE objects such as sound and video clips; pictures; or anything else you have
on the Clipboard, including items from other software programs.    When you insert pictures,
keep the capabilities of your computer in mind.    If you insert large picture files, your 
machine may run slowly.    In fact, if your machine does not have enough RAM, you may not 
be able to load particularly large files.    In addition, you will need quite a bit of free space 
on your hard drive to store large images and video clips.    See the topic "Picture Size and 
Your Computer," for more information.    If you need other information about Scrapbooks, 
see the topic Entering information in Scrapbooks.
To paste an item from the Clipboard into a Scrapbook:
1. Make sure that the item you want to paste into the Scrapbook is on the Clipboard.

In general, to copy an item to the Clipboard, you first select that item.    Then from the 
Edit menu, select Copy (ALT, E, C).    If the item is in a software program other than Family 
Tree Maker, the process may be slightly different.    Please refer to that software 
program's manual for instructions.

2. In the Scrapbook, select the area into which you want to paste the item.
If you paste an item from the Clipboard when an empty Picture/Object area is selected, 
the item will be pasted into that Picture/Object area.    If you paste an item from the 
Clipboard when an occupied Picture/Object area is selected, Family Tree Maker moves the
Pictures/Objects on that Scrapbook page to the right and inserts a new Picture/Object 
area for the new item.

3. From the Edit menu in Family Tree Maker, select Paste (ALT, E, P).    
Family Tree Maker places the item in the Scrapbook.    

As you can see, when an item is placed in the Scrapbook, it shrinks to fit into its 
Picture/Object area.    
Once you have pasted an item into the Scrapbook, you should use the More About 
Picture/Object dialog box to create a caption and to tell Family Tree Maker in which 
documents you want the item to print.    See the topic "The More About Picture/Object 
Dialog Box."
You can also edit and change the compression of an item once it's in the Scrapbook.    See 
the topics "Picture Editing" and "Picture Resolution and Compression."
See Also
Picture size and your computer
The More About Picture/Object dialog box
Editing Pictures/Objects
Picture resolution and compression



Edit:    Paste Special
With the Paste Special command, you can insert OLE objects from the Clipboard into the 
Scrapbook.    OLE objects that can be on the Clipboard include pictures, sound clips, video 
clips, and word processor documents.    When you insert pictures, video, and sound, keep 
the capabilities of your computer in mind.    If you insert large files, your machine may run 
slowly.    See "Picture Size and Your Computer" for more information.    If you need other 
information about Scrapbooks, see the topic Entering information in Scrapbooks.

To paste an OLE object from the Clipboard into a Scrapbook:
1. Make sure that the OLE object you want to paste into the Scrapbook is on the 

Clipboard.
In general, to copy an OLE object to the Clipboard, you first select that item.    Then from 
the Edit menu, select Copy (ALT, E, C).    If the item is in a software program other than 
Family Tree Maker, the process may be slightly different.    Please refer to that software 
programs manual for instructions.

2. In the Scrapbook, select the area into which you want to paste the item.
If you paste an OLE object from the Clipboard when an empty Picture/Object area is 
selected, the OLE object will be pasted into that Picture/Object area.    If you paste an OLE
object from the Clipboard when an occupied Picture/Object area is selected, Family Tree 
Maker moves the Pictures/Objects on that Scrapbook page to the right and inserts a new 
Picture/Object area for the new OLE object.

3. From the Edit menu in Family Tree Maker, select Paste Special (ALT, E, S).
Family Tree Maker displays the Paste Special dialog box.

4. In the As list, click the data type that you want to paste into the Scrapbook.
If you want to view an icon in the Scrapbook instead of the OLE object itself, select the 
Display as Icon check box.    You may want to do this if you are pasting in a text file or 
some other object that isn't attractive when it's shrunk down to fit into the Picture/Object
area.    
When you select this option, you can also change the appearance of the icon by clicking 
Change icon.    In the Change Icon dialog box, you can either type the file name for the 
new icon in the File name field, or search for an icon file by clicking Browse.    Click OK 
to return to the Paste Special dialog box.

5. Click OK.
Family Tree Maker places the OLE object in the Scrapbook.    

Once you have pasted an OLE object into the Scrapbook, you should use the More About 
Picture/Object dialog box to create a caption and to tell Family Tree Maker in which 
documents you want the item to print.    See the topic "The More About Picture/Object 
Dialog Box."
You can also edit an OLE object once it's in the Scrapbook.    See the topic "Editing OLE 
Objects."
See Also
Picture size and your computer
The More About Picture/Object dialog box
Editing OLE objects



Working with Scrapbooks
The More About Picture/Object dialog box

Select this topic to get help about the More About Picture/Object dialog box.    This dialog 
box is where you create a caption for each item that you place in a Scrapbook.    You also 
use this dialog box to help you select which items from the Scrapbooks will appear in 
which printed documents and whether or not an item will appear when you play a 
Scrapbook.

Moving around in a Scrapbook
Select this topic to get help about moving among and selecting the items that you have 
placed in a Scrapbook.

Finding Pictures/Objects in Scrapbooks
Select this topic to get help about locating an item that you have placed in a Scrapbook.

Viewing Pictures/Objects at full size
Select this topic to get help about seeing an item in the Scrapbook at full size, instead of 
at the reduced thumbnail size that appears in the Scrapbook.

Playing OLE objects
Select this topic to get help about calling up the OLE servers for an OLE object in a 
Scrapbook and playing that object.

Playing a Scrapbook
Select this topic to get help about displaying each of the items in a Scrapbook on your 
computer screen one at a time.

Sorting Scrapbooks
Select this topic to get help about rearranging the order in which items are placed in a 
Scrapbook.

Editing Pictures/Objects
Select this topic to get help about cropping, rotating, or flipping a picture that is in a 
Scrapbook.

Picture/Object brightness and contrast
Select this topic to get help about changing the coloring of the pictures that are in a 
Scrapbook.

Picture resolution and compression
Select this topic to get help about changing the clarity with which a picture is displayed 
in a Scrapbook and the amount of space that it takes to store that picture on your 
computer's hard disk.

Moving or copying Pictures/Objects between Scrapbooks
Select this topic to get help about taking a picture that is in one Scrapbook and moving 
that picture, or a copy of it, to another Scrapbook.

Removing Pictures/Objects from Scrapbooks
Select this topic to get help about permanently deleting a picture from a Scrapbook.



The More About Picture/Object dialog box
Each Picture/Object has its own More About Picture/Object dialog box.    This dialog box is 
for recording captions and other important information about your Pictures/Objects, such as
what they are and when they were created.    Another very important function of this dialog 
box is that you use it to select in which documents you want your Picture/Object to print. 
The More About Picture/Object dialog box is also for indicating whether or not you want 
each Picture/Object to be included when the Scrapbook is played.    If you need other 
information about Scrapbooks, see the topic Entering information in Scrapbooks.
To record captions and other information about your Pictures/Objects:
1. Make sure you're in the Scrapbook and the Picture/Object that you want to record 

information about is selected.
2. From the Picture/Object menu, select More About (ALT, O, A).    You can also 

press Ctrl + M or click the downward-pointing arrow next to the Picture/Object.
Family Tree Maker displays the More About Picture/Object dialog box.    A reduced-size 
image of your Picture/Object should be in the upper right-hand corner of the dialog box.   
Make sure that it's the Picture/Object that you want to record information about.    You 
now have several selections to make, each of which is described below.
Caption    Type a caption for your Picture/Object in this field.    
Category    Type a category of your own creation into this field.    Categories are useful 
when it's time to print or search for a Picture/Object.    For example, if you wanted to look 
at all of the Pictures/Objects related to birthdays, and you had given all of the childhood 
birthday Pictures/Objects the category "Childhood Birthday," you'd be able to locate all of
these birthday pictures easily.    
Put some thought into the creation of your categories; you will find that it pays off when 
you print documents in which you want to include Pictures/Objects.    Think about the 
types of documents you will want to print in the future.    Will you want family trees 
containing a portrait of each individual as an adult?    How about creating a special 
anniversary address labels that contains a couple's wedding picture?    Thinking about the
types of documents that you want to print should help you create your categories.    
Depending on the number of Pictures/Objects that you place in Scrapbooks, you may 
want your categories to be fairly specific.    For example, if you have several different 
portraits for each individual, you wouldn't want to put them all in the category "Portrait." 
Instead, it would be a good idea to create categories such as "Portrait - Childhood," 
"Portrait - Teen," and so on.    
Date of origin    Type the date on which the original item was created.    For example, 
the date when the original photograph was taken.
Type    Click the arrow next to this field to display a list of Picture/Object types.    When 
the list of types appears, click the type that applies to the currently selected 
Picture/Object.    If the currently selected Picture/Object is a Kodak Photo CD picture or a 
picture inserted from a file, Family Tree Maker has already selected the type for you.
Description    Type a description of the Picture/Object in this field.    You can include more
detailed information than in the caption.
Include in show    Select this check box if you want Family Tree Maker to include this 
Picture/Object in shows of this Scrapbook.    For more information about shows, see the 
topic "Playing a Scrapbook."
Include in printed Scrapbook    Select this check box if you want Family Tree Maker to 
print this Picture/Object when you print the Scrapbook.    Items that you might not want 
to print include sound clips, because they will only print as icons.



Preferred Picture/Object #1 - #3 for Trees    When you print trees, you can include 
Pictures/Objects for each individual.    Family Tree Maker allows you to select in advance 
the three Pictures/Objects that you are most likely to print for each individual.    You can 
designate your three choices using the "Preferred Picture/Object for trees" check boxes.
For example, if you picked each individual's birthday photo as the "Preferred 
Picture/Object #1 for trees" and told Family Tree Maker to include "Preferred 
Picture/Object #1 for trees" when you printed a tree, the tree would contain each 
individual's birthday photo.
Please note that for each Scrapbook, you can only designate one Picture/Object as the 
"Preferred Picture/Object #1 for trees."    The same holds for "Preferred Picture/Object #2 
for trees" and so on.    This means that if you already have selected one picture as the 
"Preferred Picture/Object #1 for trees" and then select a second picture as the "Preferred 
Picture/Object #1 for trees," the first picture is no longer the "Preferred Picture/Object #1
for trees."
Although Family Tree Maker only allows you to designate three preferred Pictures/Objects
for trees, you can include any other Picture/Object in a tree by using Categories, 
described above, when it is time to print.
Preferred Picture/Object for Labels/Cards    When you print labels or cards, you can   
include Pictures/Objects for each individual.    Family Tree Maker allows you to select in 
advance the one Picture/Object that you are most likely to print for each individual.    You 
can designate your choice using the "Preferred Picture/Object for Labels/Cards" check 
box.
All of the same rules apply to "Preferred Picture/Object for Labels/Cards" as for "Preferred
Picture/Object for trees," described above.    
Preferred Picture/Object for Fam Grp Sheets    When you print Family Group Sheets,
you can include one Picture/Object for each individual.    Family Tree Maker allows you to 
select in advance the one Picture/Object that you are most likely to print for each 
individual.    You can designate your choice using the "Preferred Picture/Object for Fam 
Grp Sheets" check box.
All of the same rules apply to "Preferred Picture/Object for Fam Grp Sheets" as for 
"Preferred Picture/Object for trees," described above.    
CD#, Photo#, Resolution    When the currently selected Picture/Object is a Kodak 
Photo CD picture, Family Tree Maker displays this information.

See Also
Playing a Scrapbook



Moving around in a Scrapbook
You can move around in a Scrapbook to look at and/or edit your Pictures/Objects.    If you 
need other information about Scrapbooks, see the topic Entering information in 
Scrapbooks.
One way to move around the Scrapbook is with your mouse.    Just move the mouse pointer 
to the Picture/Object you want to select and then click the primary mouse button.    Family 
Tree Maker selects the Picture/Object
To turn Scrapbook pages with the mouse, click the page turning buttons in the lower right- 
and left-hand corners of your screen.    When you're on the first page of the Scrapbook, the 
backward page turn button will not work.    When you're on the last page of the Scrapbook, 
the forward page turn button will not work.    
You can also use your computer keyboard to move around in a Scrapbook.    The table below
shows which keys work as navigation keys.

Press this key To do this

Up arrow Move to the Picture/Object above the currently selected 
Picture/Object

Down arrow Move to the Picture/Object below the currently selected 
Picture/Object

Left arrow Move to the Picture/Object to the left of the currently 
selected Picture/Object.    Family Tree Maker turns the 
page if the next Picture/Object is on the next page.

Right arrow Move to the Picture/Object to the right of the currently 
selected Picture/Object.    Family Tree Maker turns the 
page if the next Picture/Object is on the next page.

Tab Move to the next Picture/Object.    Family Tree Maker 
turns the page if the next Picture/Object is on the next 
page.

Shift + Tab Move to the previous Picture/Object.    Family Tree 
Maker turns the page if the next Picture/Object is on the
next page.

Home Move to the first Picture/Object on the current page
End Move to the last Picture/Object on the current page
Ctrl + Home Move to the first Picture/Object on the first page of the 

Scrapbook
Ctrl + End Move to the last Picture/Object on the last page of the 

Scrapbook
Page Up Move one page forward in the Scrapbook
Page Down Move one page backward in the Scrapbook

Ctrl + M Display the More About Picture/Object dialog box for the
currently selected Picture/Object

Finding Pictures/Objects in Scrapbooks
Using the Find Picture/Object command, you can locate a Picture/Object in the Scrapbook 



that is currently open.    If you want to search all of the Scrapbooks in your Family File at the
same time, you must use the Find Individual command.    See the topic "Using Find 
Individual."    If you need other information about Scrapbooks, see the topic Entering 
information in Scrapbooks.
To find a Picture/Object in a Scrapbook:
1. Make sure you're in the Scrapbook that you want to search.
2. From the Edit menu, select Find (ALT, E, F).    

Family Tree Maker displays the Find Picture/Object dialog box.
3. Click in the Search field.    From the drop-down list that Family Tree Maker displays, 

select the field that you want to search.
4. In the for field, type the information that you want to search for.    If the field that you 

are searching only has certain legal values (such as "yes" or "no"), then a drop-down 
list may be displayed in the "for" field.    Just choose the item you want to search for.

5. Click Find next to start the search.    
Family Tree Maker goes to and selects the first Picture/Object that matches your request. 
If no matches are found, Family Tree Maker tells you so.
If you like, you can edit this Picture/Object and then continue your search by clicking 
Find next.    

6. Click Find next to continue your search.
Continue clicking Find next  until youre done searching or until Family Tree Maker runs 
out of matches.    To go back to previous matches, click Find previous.

7. To quit the search, click Cancel.
If you didn't find the Picture/Object you were looking for, try again with a less restrictive 
request.    For example, search for a piece of a caption rather than a complete caption.

See Also
Using Find Individual



Viewing Pictures/Objects at full size
Although pictures appear in Scrapbooks at a reduced size, called a thumbnail, you can view
them at full size.    This only applies to non-OLE pictures.    If you need other information 
about Scrapbooks, see the topic Entering information in Scrapbooks.
To view a picture at full size:
1. In the Scrapbook, select the Picture/Object that you want to view.    
2. From the Picture/Object menu, select View Picture (ALT, O, V).    You can also double-

click the Picture in the Scrapbook.
Family Tree Maker displays the View Picture dialog box.    Use the Zoom buttons to view 
your picture at larger or smaller sizes.    When your whole picture is not visible in the 
dialog box, Family Tree Maker places scroll bars on the bottom and right sides of the 
picture.    You can use these scroll bars to view different sections of your picture.

3. Click OK to close the View Picture dialog box.
Family Tree Maker returns you to the Scrapbook view.



Playing OLE objects
Once you have placed OLE objects in a Scrapbook, you can "play" them.    For example, you
can hear sound files and watch video files.    If you need other information about 
Scrapbooks, see the topic Entering information in Scrapbooks.
To play an OLE object:
1. Double-click the Picture/Object that you want to play.

What happens after you double-click depends on the OLE object's server.    In most cases,
video and sound files will play.    Picture files will most likely appear at full size, while 
spreadsheets will open.

2. If the OLE server opened, you can return to Family Tree Maker by closing the server.    
From the File menu of the server, select Exit and Return to Family Tree Maker.

Note:    If the software program does not have a menu choice such as "Exit and Return" 
or "Update," refer to that software program's manual for instructions.



Playing a Scrapbook
Once you have Pictures/Objects in a Scrapbook, you can easily create a show to display 
each of the Pictures/Objects in sequence.    All you need to do is indicate which 
Pictures/Objects you want to include in the show and how much time you want between 
each Picture/Object.    If you need other information about Scrapbooks, see the topic 
Entering information in Scrapbooks.
To create a show from a Scrapbook:
1. Open the Scrapbook for which you want to create a show.    Do not go into Scrapbook 

Print Preview.
2. Decide which Pictures/Objects you want to include in the show.    Anything that is in the 

Scrapbook can be included, whether it is a picture, sound, video, or other item.    
3. Open the More About Picture/Object dialog box for each of the Pictures/Objects that 

you want to include in the show.    You can do this by clicking the downward-pointing 
arrow next to each Picture/Object.    Make sure that the Include in show check box is 
selected for each of the Pictures/Objects.
You may also want to ensure that the Include in show check box is not selected for 
those Pictures/Objects that you do not want in the show.

4. Make sure that the Pictures/Objects are in the order in which you want them to appear 
in the show.    If not, you can move them.    See the topic "Moving or Copying 
Pictures/Objects Between Scrapbooks" or "Sorting a Scrapbook."

5. From the Picture/Object menu, select Play Scrapbook (ALT, O, P).
Family Tree Maker displays the Play Scrapbook dialog box.

6. Enter a number in the Time between Pictures/Objects field.
You can enter from 1 to 999 seconds.    The number that you enter is the number of 
seconds for which Family Tree Maker will display pictures on the screen during the show.

7. Click OK.
Family Tree Maker begins the show.    Each Picture/Object is centered on the screen for 
the number of seconds that you selected.    Pictures/Objects that can be "played," such as
sounds and videos, are played.    If you click on the screen while a picture is displayed, 
Family Tree Maker will skip the time delay and move on to the next Picture/Object.

See Also
Sorting Scrapbooks
Moving or copying Pictures/Objects between Scrapbooks



Sorting Scrapbooks
You may want the Pictures/Objects in your Scrapbook in a particular order.    You can choose 
the order quickly and easily with Family Tree Maker's sorting feature.    When you choose a 
sorting order, it only affects the Scrapbook that is currently open.    If you need other 
information about Scrapbooks, see the topic Entering information in Scrapbooks.
To sort a Scrapbook:
1. From the Format menu, select Sort Scrapbook (ALT, T, S).

Family Tree Maker displays the Sort Scrapbook dialog box.
2. Click the option button for the type of sorting you prefer.

You can sort on captions, categories, or dates.    For captions or categories, Family Tree 
Maker sorts alphabetically on the first word.      

3. Click OK when you've made your selection.
Family Tree Maker sorts the current Scrapbook according to the option you chose in step 
2 and returns you to the Scrapbook view.



Editing Pictures/Objects
Editing a picture after it has been placed in the Scrapbook involves decompressing and 
recompressing it.    Unless you selected 1:1 compression when you initially imported the 
picture, repeated decompression and recompression reduce the quality of the picture.    
(Family Tree Maker uses the industry standard JPEG compression method.)    For this reason,
Family Tree Maker asks you to retrieve the original picture before you edit it.    Please note 
that printing and viewing your pictures at different sizes does not involve compression and 
will not reduce the quality of your picture.
With Family Tree Maker, you can rotate, flip, and crop your pictures.    Each of these editing 
functions is described in the topics listed below.    If you need other information about 
Scrapbooks, see the topic Entering information in Scrapbooks.
See Also
Preparing to edit a picture
Rotating a picture
Flipping a picture
Cropping a picture
Editing OLE objects



Preparing to edit a picture

To open a picture for editing:
1. In the Scrapbook, select the picture that you want to edit.
2. From the Picture/Object menu, select Edit (ALT, O, E).
3. Family Tree Maker asks if you want to open and edit the original file.    In general, 

editing the original file will give you the best quality picture.    If you click Yes, go to 
step 4.    If you click No, Family Tree Maker displays your picture for editing.    Skip the 
remainder of this section and begin editing now.
Note:    If the picture is black and white, if it is a Kodak Photo CD picture, if you stored 
the picture using 1:1 compression, or if the picture was pasted into Family Tree Maker, 
you will not need to get the original file.    Skip the remainder of this section and begin 
editing now.

4. Family Tree Maker displays the Insert Picture dialog box.    Select the name of your file.
5. Click OK.

Family Tree Maker displays your picture in the Edit Picture dialog box.    To rotate, flip, or 
crop the picture, see one of the topics below.

See Also
Rotating a picture
Flipping a picture
Cropping a picture



Rotating a picture
Sometimes when you scan a picture, newspaper clipping, or other paper memorabilia, the 
image in the file will turn out sideways or upside down.    
To rotate a picture after it has been placed in a Scrapbook:
1. If you are not already in the Edit Picture dialog box, follow the instructions in the topic 

"Preparing to Edit a Picture."
2. Click one of the three following buttons:

Rotate L    Use this button to rotate the picture ninety degrees to the left (counter-
clockwise).    
Rotate R    Use this button to rotate the picture ninety degrees to the right (clockwise).    
180    Use this button to rotate the picture 180 degrees.

3. If you are finished editing the picture, click OK to have Family Tree Maker place the 
newly-rotated picture into the Scrapbook.

See Also
Preparing to edit a picture



Flipping a picture

To flip a picture after it has been placed in a Scrapbook:
1. If you are not already in the Edit Picture dialog box, follow the instructions in the topic 

"Preparing to Edit a Picture."
2. You can flip the picture using two different buttons:

Mirror    Use this button to flip the picture from left-to-right.    
Flip    If the items in your picture are upside-down instead of right side up, use this 
button to flip the picture.

3. If you are finished editing the picture, click OK to have Family Tree Maker place the 
newly-flipped picture into the Scrapbook.

See Also
Preparing to edit a picture



Cropping a picture
Cropping pictures allows you to perfect them for your Scrapbook.    For example, you may 
have a picture with people against a very large background that you want to crop out.    Or, 
you may have a family photograph and want to use it to make individual pictures for each 
family member.    
To crop a picture after it has been placed in a Scrapbook:
1. If you are not already in the Edit Picture dialog box, follow the instructions in the topic 

"Preparing to Edit a Picture."
2. Move the cursor onto the image.

The cursor becomes a cross-hair (large plus sign).
3. Position the cross-hair over the exact spot where you want the top left corner of the 

cropped picture to be.
4. Press and hold the mouse button while you drag diagonally to the exact spot where 

you want the lower right corner of the cropped picture to be, then release the mouse 
button.
The area of the picture that will remain after the picture is cropped will have a box 
around it.    If you do not like the position of the box, simply repeat steps 2 and 3 to 
create a new box.

5. When you have a box around the area of the picture that you want to keep, click Crop.
Family Tree Maker deletes the part of the picture that you chose to crop off, showing you 
what the cropped picture will look like.    If you want to remove even more of the original 
picture, repeat steps 2, 3, and 4.    If you feel that you have cropped too much of the 
picture, click Cancel to start again.    

6. If you are finished editing the picture, click OK to have Family Tree Maker place the 
newly-cropped picture into the Scrapbook.    
Family Tree Maker permanently crops the picture and places the new cropped version in 
the Scrapbook.

See Also
Preparing to edit a picture



Editing OLE objects
Family Tree Maker does not control the editing of OLE objects.    Instead, you edit the 
objects in the software program that originally created the object.    If you need other 
information about Scrapbooks, see the topic Entering information in Scrapbooks.
To edit an OLE object:
1. Select the Picture/Object, and then from the Picture/Object menu, select Edit (ALT, O, 

E). 
Microsoft Windows opens the software program in which the Object was originally 
created.    If Family Tree Maker cannot find the correct software program, check to see 
that you have not deleted the software program or moved it to a new location.

2. Edit the object as you need to.
For instructions, please refer to the manual for that software program.

3. From the File menu of that software program, select Exit and Return to Family Tree
Maker.
Note:    If the software program does not have a menu choice such as "Exit and Return"
or "Update," refer to that software program's manual for instructions.
Microsoft Windows closes the software program and returns you to Family Tree Maker.    
(Windows may also ask you if you want to update or save your information; answer Yes 
or OK, unless you don't want to save your changes.)    Family Tree Maker places the 
edited OLE object in the Scrapbook.    



Picture/Object brightness and contrast
The Brightness and Contrast controls allow you to change the color shading in the non-OLE 
pictures that you have placed in your Scrapbooks.    You can change the contrast for 
individual pictures or brightness for all pictures at once.    You would want to change the 
contrast of an individual picture if the color in that picture wasn't quite right.    You would 
want to change the brightness for all pictures at once if, for example, your printer tended to
print Pictures/Objects too darkly.    See the two topics listed below for more information.    If 
you need other information about Scrapbooks, see the topic Entering information in 
Scrapbooks.
See Also
Changing the contrast for a single Picture/Object
Changing the brightness for all Pictures/Objects



Changing the contrast for a single Picture/Object
If you need more general information about contrast, see the topic Picture/Object 
brightness and contrast.    If you need more general information about Scrapbooks, see 
the topic Entering information in Scrapbooks.
To change the contrast setting for a single Picture/Object:
1. Select the picture whose contrast you want to change.
2. From the Picture/Object menu, select Contrast (ALT, O, N).

Family Tree Maker displays the Contrast dialog box.
3. Place the mouse pointer on the scroll box in the Contrast scroll bar.
4. Click and drag the mouse to move the scroll box and change the contrast.
5. Click OK when you have made your selection.

Family Tree Maker returns you to the Scrapbook.



Changing the brightness for all Pictures/Objects
When you change the brightness setting for all Pictures/Objects at once, you are changing 
it for a specific view, not for all views.    For example, if you are printing an Ancestor tree 
and you change the brightness setting while you're in the Ancestor Tree view, every 
Ancestor tree that you print afterwards will have the same brightness setting.    However, 
Descendant trees would not have this brightness setting.    If you wanted your Descendant 
trees to have the same brightness setting as your Ancestor trees, you would need to switch
to the Descendant Tree view and change the brightness setting there, too.
If you need more general information about contrast, see the topic Picture/Object 
brightness and contrast.    If you need more general information about Scrapbooks, see 
the topic Entering information in Scrapbooks.
To change the brightness setting for all Pictures/Objects:
1. Make sure you are in a view that can print Pictures/Objects, such as the Scrapbook 

view or the Ancestor Tree view.
2. From the File menu select Print Setup (ALT, F, R).

Family Tree Maker displays the Print Setup dialog box.
3. Click Brightness.

Family Tree Maker displays the Brightness dialog box.
4. Click and drag the mouse to move the scroll box and change the brightness.
5. Click OK when you have made your selection.

Family Tree Maker returns you to the Print Setup dialog box.
6. Click OK to close the Print Setup dialog box.



Picture resolution and compression
With Family Tree Maker, you can select the degree of compression for your color and 
grayscale pictures.    This gives you control over the tradeoff between the quality of your 
pictures and the amount of hard disk space they take up.    You can also control the 
resolution of Kodak Photo CD pictures.    You cannot change the compression of black and 
white pictures:    black and white pictures are always compressed because compression 
does not change their quality.    If you need more general information about Scrapbooks, 
see the topic Entering information in Scrapbooks.
You can change the compression of a picture from several places:
 from the Insert Picture dialog box when you are placing a picture into the Scrapbook from 

a file.    
 from the Insert from Photo CD dialog box when you are placing a new Photo CD Picture in 

the Scrapbook.    
 from the Change Compression/Resolution dialog box whenever you are in the Scrapbook.    
In addition, if you want to set a default compression or resolution for all pictures that you 
place in the Scrapbook in the future, see the topic "Preferences for Scrapbooks." 
To change compression or resolution:
1. Select the picture whose compression or resolution you want to change.
2. Open the Compression/Resolution dialog box.    How you open this dialog box depends 

on where you are:
If you are in the Import from Photo CD dialog box, click Resolution.    
If you are in the Import Picture dialog box, click Compression.    
If you are in a Scrapbook, from the Picture/Object menu, select 
Compression/Resolution.    If Family Tree Maker displays a message telling you to get 
the original picture, click OK in that message.    In the Insert Picture dialog box, select the
picture whose compression you want to change and click OK.

3. You can now change the compression and/or resolution.    Each of your options is 
described below.
Degree of Compression    Select the option button corresponding to the degree of 
compression that you want for your picture.    Higher ratios give you a greater loss in 
picture quality, but the pictures will take up less space on your hard disk.    (Family Tree 
Maker uses the industry standard JPEG compression method.)    Lower ratios give you 
pictures with less loss in quality, but will take up the most disk space.    The "1:1" setting 
will not reduce the quality of your picture at all, but will take up the most space on your 
hard disk.
In general, the "Recommended" setting is a good balance between quality loss and disk 
space.    However, if you're importing a file that contains a lot of text, such as a scanned 
article or birth certificate, you may want to use a compression that's lower than the 
recommended level.    It will make the text easier to read.
Resolution    This option is only available for Kodak Photo CD Pictures.    Select the 
option button corresponding to the resolution that you want for your picture.    
"Resolution" refers to the size of your picture.    A higher resolution will create a larger 
picture, and a larger picture will be sharper and have more detail.    If a particular 
resolution is not available for the image that you are currently working with, the option 
button will not be available.    
Choosing resolutions higher (larger) than the recommended "256 x 384" will use up large
amounts of your hard disk space.    In addition, you may not be able to load a picture at a
very high resolution if your computer does not have a sufficient amount of RAM 



(memory).    You only need to use high resolutions when you want to print large, very 
high-quality images on a high-quality printer or when you plan to crop a small part of the
picture.    See the topic "Picture Size and Your Computer," for more information.
Disk Space Needed    Shows the approximate disk space needed to store the picture 
that you are currently working with.    Each time you change one of the options in this 
dialog box, the numbers in the Disk Space Needed field will change.    Note that this is an 
approximation:    the actual size may vary slightly when the picture is actually 
compressed.

4. Click OK when you've made your selections.
Family Tree Maker changes the compression and/or resolution of the picture and places it
in the Scrapbook.    

See Also
Picture size and your computer
Preferences for Scrapbooks



Moving or copying Pictures/Objects between Scrapbooks
You can move or copy Pictures/Objects within a Scrapbook and also from one Scrapbook to 
another Scrapbook, as long as the two Scrapbooks are in the same Family File.    When you 
edit a Picture/Object that is in more than one Scrapbook, you can choose whether or not 
your edits affect all of the copies of the Picture/Object or just the copy in the Scrapbook 
that is currently open.    If you need more general information about Scrapbooks, see the 
topic Entering information in Scrapbooks.
To move or copy a Picture/Object, start with the Scrapbook containing the 
Picture/Object you want to move or copy:
1. Open the Scrapbook.

If you need help opening the Scrapbook, see the topic "Opening Scrapbooks."
2. Select the Picture/Object that you want to move or copy.
3. From the Edit menu, select Cut (ALT, E, C) if you wish to move the Picture/Object 

completely.    Select Copy (ALT, E, P) if you wish to copy the Picture/Object to another 
Scrapbook.
Because the Picture/Object is now on the Clipboard, you can use the Paste command to 
insert the Picture/Object into any location in a Scrapbook.
If you want to place the Picture/Object in a new location in the same Scrapbook, select 
the new location.    Then from the Edit menu, select Paste (ALT, E, P).    You can skip the 
rest of these steps.
If you want to place the Picture/Object in a different Scrapbook, continue with step 4.

4. Go to the Family Page containing the individual or the marriage whose Scrapbook you 
want to paste the Picture/Object into.
You can use the Index of Individuals or Find Individual to find the individual's Family Page.

5. On the Family Page, place the cursor either on the name of the individual or on the 
marriage whose Scrapbook you want to open.

6. From the View menu, select Scrapbook (ALT, V, S).
7. From the Scrapbook submenu, select either Individual or Marriage, depending on 

which type of Scrapbook you want to go to.
Family Tree Maker displays the individual's or marriage's Scrapbook.    

8. Select the area where you want to paste the Picture/Object.
9. From the Edit menu, select Paste (ALT, E, P).

Family Tree Maker pastes the Picture/Object from the Clipboard into the Scrapbook, and 
repositions any existing Pictures/Objects, if necessary.

Since the Clipboard is not erased until you use the Copy or Cut command again, you can 
paste the same Picture/Object or caption as many different times as you like.
See Also
Opening Scrapbooks
Using the Index of Individuals
Using Find Individual



Removing Pictures/Objects from Scrapbooks
You cannot delete a Picture/Object by selecting it and attempting to insert a new 
Picture/Object in its place.    This will only move the Picture/Object that you wanted to 
delete to the right and create a space for the new Picture/Object.    If you need more 
general information about Scrapbooks, see the topic Entering information in 
Scrapbooks.
To remove Pictures/Objects from the Scrapbook:
1. Select the Picture/Object that you want to remove.
2. Press Delete or Backspace to permanently remove the Picture/Object from the 

Scrapbook.    Or, from the Edit menu, select Cut (ALT, E, C) to cut the Picture/Object to 
the Clipboard.
Family Tree Maker asks for confirmation.    If you really want to delete the Picture/Object, 
click OK.    Otherwise, click Cancel.
Family Tree Maker removes the Picture/Object from the Scrapbook, as well as any 
information in its More About Picture/Object dialog box. The Pictures/Objects remaining in
the Scrapbook move to the left to fill up the empty space.

If you accidentally delete the wrong Picture/Object, from the Edit menu, select Undo 
immediately (ALT, E, U).    



Editing information
There are two types of editing in Family Tree Maker:    text editing and family structure 
editing.    When you need to edit textual information with commands such as cut, copy, and 
paste, select the first option, "Basic text editing."    When you need to edit the structure of 
your family, e.g. "fix relationship mistakes," select any of the other five options.
Basic editing

Select this topic to get help about moving, copying, and deleting text and other items.    
You will also find information about undoing your last editing command.

Delete Individual
Select this topic to get help about permanently removing an individual from your Family 
File.

Detach Spouse
Select this topic to get help about "divorcing" two individuals whom you mistakenly 
entered as a couple in Family Tree Maker.

Attach Spouse
Select this topic to get help about "marrying" two individuals who are in your Family File 
and are a couple in real life, but are not shown as a couple in Family Tree Maker. 

Detach Child
Select this topic to get help about removing a child from a "Children" list when the child 
is with the wrong parents.

Attach Child
Select this topic to get help about attaching a child to a set of parents when the child and
parents are already in your Family File, but are not attached to each other correctly.



Basic editing
You can cut, copy, and paste text or most any other item in Family Tree Maker, such as 
trees, Family Group Sheets, and Pictures/Objects.    However, you should not cut and paste 
an individual's name.    Cutting and pasting an individual's name does not move that 
individual to another location.    To move an individual and all of the information associated 
with that individual, use the Detach and Attach commands.    To get information about the 
Detach and Attach commands, see the topic Editing information.
Cutting and pasting text and other items

Select this topic to get help about moving text and other items from one location to 
another.

Copying and pasting text and other items
Select this topic to get help about making a copy of text or another item that is in one 
location and placing that copy in another location.

The Undo command
Select this topic to get help about reversing your last editing command.    For example, 
replacing text that you just cut.



Cutting and pasting text and Pictures/Objects
You can move any amount of text from one place to another.    You can also move 
Pictures/Objects from one Scrapbook to another, as long as both Scrapbooks are in the 
same Family File.    This is called cutting and pasting.    For information about other 
editing commands, see the topic Editing information.
To cut and paste text and Pictures/Objects:
1. Select the text or Picture/Object you want to move.
2. From the Edit menu, select Cut (ALT, E, T).

The text or Picture/Object disappears from the screen, but it's not gone.    It's on the 
Clipboard.    You can use the Paste command to insert the contents of the Clipboard 
wherever you like.

3. Position your cursor where you want to insert the text or Picture/Object.
If you want to replace a section of existing text with text that you've just placed on the 
Clipboard, highlight that text before moving on to the next step.    
If you want to insert a Picture/Object between two existing Pictures/Objects, select the 
Picture/Object on the right before moving on to the next step

4. From the Edit menu, select Paste (ALT, E, P).
Family Tree Maker now pastes the text or Picture/Object from the Clipboard and 
repositions any existing text or Pictures/Objects if necessary. 

Since the Clipboard is not erased until you use the Copy or Cut command again, you can 
paste the same text or Picture/Object multiple times.



Copying and pasting text and other items
You can copy any amount of text and insert it any place you want.    You can also copy and 
insert other items, such as Pictures/Objects, family trees, Custom reports, and Kinship 
reports.    This is called copying and pasting.    For information about other editing 
commands, see the topic Editing information.
To copy and paste text and other items:
1. Highlight the text or item you want to copy.
2. From the Edit menu, select Copy (ALT, E, C).

A copy of the text or other item is placed in a temporary storage place called the 
Clipboard.    You can use the Paste command to insert the contents of the Clipboard 
wherever you like.

3. Position your cursor where you want to insert the text or other item.    If you want to 
replace a section of existing text or an existing item with the information that you've 
just copied to the Clipboard, highlight that text or item before moving on to the next 
step.    

4. From the Edit menu, select Paste (ALT, E, P).
Family Tree Maker now pastes the text or item from the Clipboard and repositions any 
existing text or items if necessary.

Since the Clipboard is not erased until you use the Copy or Cut command again, you can 
paste the same text or item multiple times.



The Undo command
You can use Undo to reverse cutting, copying, pasting, deleting, typing, importing, and 
formatting.    For information about other editing commands, see the topic Editing 
information.
To undo your last command:
1. Don't type any new text or perform any other editing commands.    If you do, you won't 

be able to undo what you want to undo.
2. From the Edit menu, select Undo (ALT, E, U).    

It doesn't matter where your cursor is, Family Tree Maker will remember what your last 
editing command was and undo it.    



Delete Individual
If you've added an individual to your Family File by mistake, you can use the Delete 
Individual command to remove that individual.    
Note: If you've made a mistake entering a single piece of information, such as an 
incorrect date or location, you don't need to use Delete Individual; just type over the 
incorrect information.    Do not type over an individual's name unless you are just 
changing the spelling.    If you need to move an individual to a different Family Page, use 
the Attach and Detach commands.
To delete an individual: 
1. Go to the Family Page of the individual that you want to delete and place the cursor on 

the individual's name.
2. From the People menu, select Delete Individual (ALT, P, D).

Family Tree Maker asks you to confirm the deletion.    
Note: It's important to remember that the Delete Individual command severs all ties 
that the deleted individual created between any other individuals in your tree.    This means
that when you've deleted an individual, you may have to reconnect other individuals in 
your tree.    For example, if you delete a single parent, you've disconnected all of that 
parent's children from the rest of their relatives.    
See Also
Detach Spouse
Attach Spouse
Detach Child
Attach Child



Detach Spouse
If Family Tree Maker shows two individuals as spouses when they were actually never 
married, use the Detach Spouse command to separate them from each other.    
To detach someone from his or her spouse:
1. Go to the Family Page of the individual you want to detach.

Note:    You must be on the Family Page where the individual you want to detach appears
as a husband or wife, not as a child.    

2. Place the cursor on the spouse you want to detach.
3. From the People menu, select Fix Relationship Mistakes (ALT, P, F). 
4. From the Fix Relationship Mistakes submenu, select Detach Spouse.      

Family Tree Maker asks you to confirm the detachment.
If the individual you are detaching has children, the children will remain with the spouse 
who was not detached.
See Also
Attach Spouse



Attach Spouse
If two individuals who are married are in your Family File but aren't shown as married to 
each other, use the Attach Spouse command to join them.    If only one of the individuals is 
already in your Family File, just enter the other spouse's name on the Family Page of the 
individual who already is in the Family File.
Note: Before you can attach a spouse, you must have an opening on the Family 
Page for it.    If you already have two spouses shown on the Family Page, you will need to 
create a spot for the one you're attaching by using the Create additional spouse dialog 
box.    See the topic "Creating additional spouses."
To attach two individuals as spouses:
1. Go to the Family Page where one of the individuals appears in the husband or wife 

field.    
Note:    You must be on the Family Page where the individual to whom you want to attach
a spouse appears as a husband or wife, not as a child.    
In order to ensure that the children from this marriage will appear on the same Family 
Page as their parents, make sure that you are on the Family Page where the children and 
one of the parents appear.    That way, Family Tree Maker knows to keep the children with
the marriage you are creating.

2. From the People menu, select Fix Relationship Mistakes (ALT, P, F).
3. From the Fix Relationship Mistakes submenu, select Attach spouse.    

Family Tree Maker displays a list of everyone in your Family File.    
4. Click the name of the individual that you want to attach as a spouse.
5. Click OK.    

Family Tree Maker asks you to confirm your selection.
See Also
Selecting an individual to attach
Creating additional spouses



Detach Child
If a child in your Family File appears with the wrong parents, you can use the Detach Child 
command to separate the child from those parents.    
To detach a child from his or her parents:
1. Go to the Family Page of the individual you want to detach.

Note:    You must be on the Family Page where the individual you want to detach is 
shown in the "Children" list.    

2. Place the cursor on the child you want to detach.
3. From the People menu, select Fix Relationship Mistakes (ALT, P, F). 
4. From the Fix Relationship Mistakes submenu, select Detach Child.    

Family Tree Maker asks you to confirm the detachment.      
If the child has siblings, Family Tree Maker asks if the siblings should be detached as well.
Select Yes to detach all of them, select No to leave them with the parents.

To reattach this individual to the tree, use the Attach Child command.
See Also
Attach Child



Attach Child
If an individual and his or her parents are in your Family File, but the individual does not 
appear on the parents' Family Page, use the Attach Child command.    If the child is not in 
the Family File, just type his or her name on the appropriate Family Page.
To attach a child to his or her parents:
1. Go to the Family Page where you want the individual to appear as a child (e.g., the 

page that shows the child's parents as spouses).
2. From the People menu, select Fix Relationship Mistakes (ALT, P, F). 
3. From the Fix Relationship Mistakes submenu, select Attach Child.      

Family Tree Maker displays a list of everyone in your Family File.
4. Click the name of the individual that you want to attach as a child.

If you click the name of an individual that, for logical reasons, could not possibly be the 
child of the individual, Family Tree Maker displays an error message and asks you to 
select another individual.    

5. Click OK.
If the child has siblings, Family Tree Maker will ask if you want to attach all of the siblings 
to the new parents as well.    Select Yes to attach all siblings, select No to attach only the
one individual.

See Also
Selecting an individual to attach



Adding an unrelated individual
With the Add Unrelated Individual command you can add an individual to your Family File 
when you know that the individual is somehow related to you, but you're not quite sure of 
the exact relationship.
To add an unrelated individual to your Family File:
1. From the People menu, select Add Unrelated Individual (ALT, P, U).
2. Family Tree Maker takes you to a blank Family Page.    Enter the individual's information.
Note: Because this individual is not currently related to anyone in your file, you will 
need to use the Index of Individuals to navigate to any other Family Page.
The individual that you entered is now in your Index of Individuals.    They will not print in 
trees or appear in Kinship reports until they are attached to the rest of the family.    When 
you find the link between this individual and your family, you can use the Attach Spouse or 
the Attach Child command to connect them to the rest of your family.
See Also
Attach Spouse
Attach Child



Creating and printing Family Tree Maker documents 
Family trees

Select this topic to get help about creating a family tree and printing it.
Family Group Sheets

Select this topic to get help about creating a Family Group Sheet and printing it.
Labels and cards

Select this topic to get help about creating labels or cards, such as mailing labels or 
postcards, and printing them.

Calendars
Select this topic to get help about creating a monthly calendar and printing it.

Kinship reports
Select this topic to get help about creating a list of individuals who are all related to one 
particular individual and printing it.    

Family Pages
Select this topic to get help about printing the facts that are contained on a particular 
Family Page.

Custom reports
Select this topic to get help about creating a report of any type of information that is 
contained in Family Tree Maker and printing it.

Scrapbooks
Select this topic to get help about formatting Scrapbook pages and printing them.

More About dialog boxes
Select this topic to get help about printing the facts that are contained in an individual's 
More About dialog boxes (Lineage, Facts, Medical, Address, and Notes).

Batch printing
Select this topic to get help about printing one type of document for multiple people all 
at once.

Creating family books
Select this topic to get help about putting together your own personalized collections of 
family information.

Print setup
Select this topic to get help about selecting the printer type, paper source, paper 
orientation, and margins for printing.



Family trees
The following topics will help you create and print your trees.
Selecting the primary individual
Selecting and displaying a type of tree
Zooming
Using a mouse with trees
Customizing your tree
Reducing the size of a tree
Printing a tree
Printing large trees on plotters



Selecting the primary individual
If you need other information about family trees, see the topic Family trees.
To select the primary individual for your tree:
1. Display the Family Page of the individual that you want to be the primary individual.
2. Place the cursor on the name of the individual that you want to be the primary 

individual in your tree.
When you change to a tree view, the individual that has the cursor on his or her name 
will be the primary individual in the tree.



Selecting and displaying a type of tree
In Family Tree Maker, there are three tree views, the Ancestor Tree view, the Descendant
Tree view, and the Outline Descendant Tree view.    With the Ancestor Tree view, you can
create two varieties of Ancestor trees:    Fit to Page Ancestor trees and Custom Ancestor 
trees.    With the Descendant Tree view, you can create Descendant trees and with the 
Outline Descendant Tree view, you can create Outline Descendant trees.    This means that 
you can print a total of four different trees.    Each type of tree is described below.    If you 
need other information about family trees, see the topic Family trees.
A Fit to Page Ancestor tree is a one page ancestor tree.    Ancestor trees show an 
individual and that individual's parents, grandparents, great-grandparents, and so on.    It 
does not show that individual's aunts, uncles, nieces, nephews, or cousins.
Print a Fit to Page Ancestor tree when you want a single page Ancestor tree.    However, 
remember that because Fit to Page Ancestor trees are limited to one page, you have less 
control over your tree's appearance.    
A Custom Ancestor tree is an Ancestor tree that you can customize completely.    It can 
be a single page tree or a tree with many pages; you make the selections that determine 
this.    Print a Custom Ancestor tree when you want more control over the appearance of 
your Ancestor tree.    
A Descendant tree shows an individual and that individual's children, grandchildren, 
great-grandchildren, and so on.    It also shows brothers, sisters, aunts, uncles, etc.    
Because Descendant trees include so many individuals, they grow to several pages very 
quickly.    With Descendant trees you can have up to 50 generations, all types of information
in your boxes, and many other formatting options.      
An Outline Descendant Tree shows an individual and that individual's children, 
grandchildren, great-grandchildren, and so on.    It also shows brothers, sisters, aunts, 
uncles, etc.    However, instead of showing each individual in a box, Family Tree Maker 
displays the individuals in outline form, with each individual and their information on a 
separate line, and with each generation indented slightly more than the one before it.    An 
individual's spouse is directly below that individual and has a plus sign (+) in front of their 
name.    With Outline Descendant trees, you can have up to 250 generations, generation 
numbers, and many other formatting options.
To choose a tree:
1. From the View menu, select a tree view, either Ancestor Tree, Descendant Tree, or 

Outline Descendant Tree (ALT, V, A), (ALT, V, D), (ALT, V, O).
Family Tree Maker displays your tree.    
If you've chosen to view an Ancestor tree, Family Tree Maker automatically displays a Fit 
to Page Ancestor tree.    Continue with step two.    
If you've chosen to view a Descendant tree, you can skip the rest of these steps.    You 
might want to read the topic "Choosing the layout and box connections for trees."
If you've chosen to view an Outline Descendant tree, you can skip the rest of these 
steps.    You might want to read the topic "Selecting formatting options for Outline 
Descendant trees."

2. From the Format menu, select Tree Format (ALT, T, F).
Family Tree Maker displays the Tree Format dialog box.    It contains the option buttons for
selecting either Fit to Page or Custom Ancestor tree.    These two types of trees are 
described above.

3. In the Type field, select the option button for the type of tree that you want to create.   



Note:    If you choose Fit to Page Ancestor tree when you already have a Custom 
Ancestor tree on the screen, Family Tree Maker modifies your tree so that it can fit on a 
single page.    Typically, Family Tree Maker will decrease the number of generations and 
the size of the text in the boxes.    There may be other changes, too.

4. Click OK to close the dialog box.    Or, you can choose the tree layout and box 
connections.    These are described in the topic "Choosing the layout and box 
connections for trees."
Family Tree Maker displays your tree.

See Also
Choosing the layout and box connections for trees
Selecting formatting options for Outline Descendant trees



Showing page lines
To control whether or not dotted lines representing page margins appear on the screen, 
from the View menu, select Show Page Lines (ALT, V, S).    If there is a check mark, the 
lines will appear on the screen, otherwise, they won't.    The lines will not appear on your 
printed documents.    To change your page's margins, see the topic "Print setup."    If you 
need other information about family trees, see the topic Family trees.
See Also
Print setup



Zooming
When you select a view, such as Ancestor Tree or Calendar, Family Tree Maker displays the 
document on your screen.    With the Zoom command and Zoom buttons, you can change 
the size in which your document is displayed.    If you need other information about family 
trees, see the topic Family trees.
To use the Zoom command:
When you select most tree views, Family Tree Maker displays the entire tree on the screen.  
With the Zoom command, you can make your tree appear larger on screen so it's easier to 
read the text.
To use the Zoom command:
1. From the View menu, select Zoom (ALT, V, Z).    

Family Tree Maker displays the Zoom dialog box.
2. From the Zoom submenu, select a size.

Size to Window is the default setting; it fits your entire tree on the screen.    Actual Size 
makes boxes the size they are when they print.    200% is the largest size.    When your 
whole tree is not visible on the screen, Family Tree Maker places scroll bars on the 
bottom and right sides of the tree.    You can use these scroll bars to view different 
sections of your tree.

Instead of choosing a size from the View menu, you can also just click the Zoom buttons on
the toolbar.    The Zoom In button will make your document larger, and the Zoom Out 
button will make it smaller.



Using a mouse with trees
In Tree views, clicking in a tree's boxes allows you to do two different things.    First, you can
navigate through Family Tree Maker, moving to different views and making different 
individuals the primary individual.    Second, you can activate your Pictures/Objects, either 
viewing pictures at full size or "playing" OLE objects.    What you do depends on what you 
click on in the box, and whether you double-click or single-click.    The tables below describe
each of the functions.    If you need other information about family trees, see the topic 
Family trees.

Do this... To do this...
Click once anywhere in a box or click 
an individual's name in an Outline 
Descendant tree

Select the individual.    You can now 
use the menus or the Toolbar to 
change to any view.    The selected 
individual becomes the primary 
individual

Double-click any text in a box or an 
individual's name in an Outline 
Descendant tree

Go to the individual's Family Page 

Double-click a Picture/Object in a box
(not available for Outline Descendant
trees)

If the Picture/Object is an OLE object, 
Family Tree Maker opens the OLE 
server and "plays" the object.    For 
example, it plays sound and video 
files, and opens pictures and displays
them at full size.

If the Picture/Object is a not an OLE 
object, Family Tree Maker displays 
the Picture/Object in the View Picture 
dialog box.

See Also
Selecting information to include in trees



Customizing your tree
Selecting the layout and box connections for trees
Formatting options for Outline Descendant trees
Selecting the number of generations
Selecting information to include in trees
Formatting items to include in trees
Formatting text in trees
Selecting styles for boxes, lines, and tree borders
Adding a title and footnote to a tree
Limiting the width of boxes
Other printing options for trees



Selecting the layout and box connections for trees
The tree layout is the placement of the boxes on a page.    Box     connections   are the way that
your tree's boxes are connected to each other.    If you need other information about family 
trees, see the topic Family trees.
Note: These options do not apply to Outline Descendant trees because they do not
use boxes to display each individual's information.
To choose your tree layout or box connections:
1. Make sure you're in a tree view; there should be a tree on your screen.
2. From the Format menu, select Tree Format (ALT, T, F).    

Family Tree Maker displays the Tree Format dialog box.    If you were in a Descendant tree 
in step 1, the Tree Format dialog box will only contain buttons for selecting a tree layout.  
Connections options are not available for Descendant trees.
If you were in an Ancestor tree in step 1, the Tree Format dialog box will contain option 
buttons for choosing a tree type, as well as buttons for selecting a tree layout and box 
connections.    If the Layout buttons are grayed out, you are in Fit to Page mode and 
cannot choose a layout.    This is because Family Tree Maker chooses a layout for you 
when you are in Fit to Page mode.    If you want to select a layout for your Ancestor tree, 
you must select the Custom option button at the top of the dialog box.    However, if you 
select Custom, your tree may grow larger than one page.

3. Click the buttons that show the layout and/or connections that you want in your tree.    
Remember, not all of these options are available for all trees. 
When you're choosing Connections, the "Detached" button will give you the largest tree 
and the "Fishtail" button the smallest tree, while trees with "Overlap" connections are in 
the middle.    
When you're choosing a Layout, the "Perfect" button creates the largest tree, the 
"Squished" button creates the smallest tree, and the "Collapsed" button will give you a 
tree somewhere in the middle.    
In general, a larger tree has more space between the boxes, and tends to look more 
elegant.    When you choose to create a tree that takes less space, you can fit more on a 
page, but the tree will look slightly more crowded.    Experiment!    Find the layout and 
connections that suit your tree best.

4. Click OK when you've made your selections.    
Family Tree Maker returns you to the tree view.

See Also
Selecting and displaying a type of tree



Formatting options for Outline Descendant trees
Outline Descendant trees have special formatting options because they don't use boxes to 
display each individual's information.    These formatting options only apply to Outline 
Descendant trees.    If you need other information about family trees, see the topic Family 
trees.
To format an Outline Descendant tree:
1. From the Format menu, select Tree Format (ALT, T, F).

Family Tree Maker displays the Tree Format dialog box.
2. Select the formatting options that you want for your tree.    Each of the options is 

described below.
Indentation    In Outline Descendant trees, each generation is indented slightly more 
than the generation above it.    Some people find it easier to distinguish between 
generations when there are leader dots (........) extending from the left margin of the 
page to each individual's name.    If you want leader dots in your tree, enter a period (.) 
into the Indent with which character field.    If you don't want leader dots, leave this 
field blank.    If you want to indent with a character besides leader dots, enter that 
character into the field.
To increase or decrease the size of each generation's indentation, click the up arrow or 
down arrow in the Indent each generation by field.    When you change the size of the 
indentation, you are changing it for all generations.    You cannot change the indentation 
for only some of the generations.
Generation Numbers    Generation numbers can help you see who belongs to which 
generation.    They are especially helpful when your tree includes many generations.    To 
include generation numbers, select the Place a generation number before each 
descendant's name check box.    
Normally, "1" would be the first generation number in a tree.    However, you can enter 
any number in the Starting generation number field, up to 9999.    You may want to 
enter a number other than 1 if you are creating a series of trees.
Size & Spacing    If you choose to include several items of information for each 
individual in your tree, each individual's information may not fit on a single line.    To allow
an individual's information to wrap to more than one line, enter a number greater than 1 
in the Maximum height (in rows) for each individual field.    If you want each 
individual's information on one line only, enter "1" in the Maximum height (in rows) 
for each individual field.
Blank lines between each individual's information can make Outline Descendant Trees 
easier to read, but they will also decrease the amount of information you can fit on a 
single page.    To include blank lines between individuals in your tree, enter a number 
greater than 0 in the Number of blank lines between individuals field. 
Selecting the Always one page wide check box means that Family Tree Maker will 
always fit each individual's information on one page only.    If the individual's information 
is too wide to fit on one page, Family Tree Maker will try reducing the point size to make 
the information fit.    You can avoid having the point size reduced by increasing the 
number in the Maximum height (in rows) for each individual field.

3. Click OK when you've made your selections.
Family Tree Maker returns you to the tree view.



Selecting the number of generations
If you need other information about family trees, see the topic Family trees.
To choose the number of generations to include in your tree: 
1. From the Contents menu, select # of Generations to Show (ALT, C, G).

Family Tree Maker displays the # of Generations to Show dialog box.
2. Click the up or down arrows to increase or decrease the number of generations that will

be included in your tree. 
Descendant trees can have up to 50 generations, Custom Ancestor trees can have up to 
12 generations, Fit to Page Ancestor trees can have up to 6 generations, and Outline 
Descendant trees can have up to 250 generations.

3. Click OK when you've made your selections.    
Family Tree Maker returns you to the tree view.

When you look at a Fit to Page Ancestor tree, you may notice that Family Tree Maker 
needed to abbreviate some of the names, locations, and biographical information to get the
tree to fit on a single page.    This happens most often with trees of 5 or more generations.   



Selecting information to include in trees
With Family Tree Maker, you can choose which information to include in your trees.    You 
can also format the text and the items that appear in your trees.    If you need other 
information about family trees, see the topic Family trees.
From the Contents menu, select Items to Include (ALT, C, I).    Family Tree Maker displays 
the Items to Include dialog box.    It contains two lists.    The list on the right shows which 
items will be included in your tree.    The scrolling list on the left shows which items you can
add to the tree.    There is a default group of items that are already included.    However, you
can add and delete items to and from the list on the right as often as you like.    When 
you're done selecting information, click OK.    Family Tree Maker will return you to the Tree 
view.
To add items to or remove items from a tree: 
1. Click the name of the item in the list on the left if you want to add the item.    Click the 

name of the item in the list on the right if you want to remove the item.
2. Click either the Include button (the arrow pointing to the right) or the Remove button 

(the arrow pointing to the left). 

 
If you chose to add the item, it is added to the list on the right.    If you chose to remove the 
item, it is removed from the list on the right.
Instead of selecting an item and then clicking "Include" or "Remove," you can just double-
click the item's name.    Double-clicking items in the list on the left automatically adds them. 
Double-clicking items in the list on the right automatically removes them.    In addition, if you
want to delete all items from the list on the right, just click the Remove all button (the 
double arrow pointing to the left). 
Some items, such as names and dates, require you to make formatting choices.    Family Tree
Maker automatically displays a dialog box that asks you to make a formatting choice when it
is necessary.    For example, if you have placed Pictures/Objects in each individual's 
Scrapbook, you can include them in your trees.    Simply select Picture/Object from the list 
on the left.    Family Tree Maker will display the Options:    Picture/Object dialog box.    In this 
dialog box you can select which Picture/Object will be included in each individual's box.    If 
an individual does not have a Picture/Object, Family Tree Maker will insert a small graphic in 
the box instead.    For more information about substitute graphics and other items that need 
to be formatted, see the topic "Formatting items to include in trees."    You can also format 
the text that appears in your trees.    See the topic "Formatting text in a tree."
Using the Custom Field item, you can add up to 80 characters of text to each box.    What 
you type in this field will appear in every box that you print.    If you want extra space in your
boxes, select the item Blank row as many times as you like.    You can also add lines to your
boxes by selecting the item Line in box.
See Also
Formatting items to include
Formatting text in a tree



Formatting items to include in trees
When you're selecting items to include in your tree's boxes, sometimes a Format dialog box
appears.    You can use the dialog box to control the appearance of the information in your 
tree.    If you need other information about family trees, see the topic Family trees.
When you choose to include names in your tree, Family Tree Maker displays the Options: 
Name dialog box.    Select a name formatting option, and if you want to print individuals' 
nicknames, select the Use aka if available check box.    
Some fields, such as Phone number and Facts, have an option called Include source 
information.    Select this check box to include the source information for that field in your 
tree.
If you choose to print Standard numbers, Family Tree Maker displays the    Options: 
Standard number (Ahnentafel) dialog box.    The number that you type in the Starting 
number field will be the starting Ahnentafel number for the primary individual in your tree. 
Normally you would just type "1" in this field.    However, if you have a set of trees and you 
want the Ahnentafel numbers to be sequential from tree to tree, choose an appropriate 
starting number to type in the field.    Ahnentafel numbers are only available in Ancestor 
trees.
When you choose to include Pictures/Objects in your tree, Family Tree Maker displays the 
Options:    Picture/Object dialog box.    For more information about this dialog box, see the 
topic "Formatting Pictures/Objects."
To change the formatting of an item that's already in the list on the right side 
of the Items to Include dialog box: 
1. From the Contents menu, select Items to Include (ALT, C, I).    

Family Tree Maker displays the Items to Include dialog box.    It contains two lists.      
2. Select the item in the list on the right by clicking it.

Family Tree Maker highlights the item.
3. Click Options.

Family Tree Maker displays an Options dialog box.    
Note:    If you select an item in the scrolling list on the right, and Options remains 
grayed out, that item does not have any formatting options.

4. Make your formatting selections, then click OK.
Some formatting options are not available for certain types of trees.    For example, "Word
Wrap" is not available for Outline Descendant trees.    When an option is not available, it 
is grayed out.
When you have finished formatting and selecting fields to include in your tree's boxes, 
click OK in the Items to Include dialog box.    Family Tree Maker returns you to the view of
your tree.

See Also
Recording Sources
Formatting Pictures/Objects in trees



Formatting Pictures/Objects in trees
You can include Pictures/Objects in your Ancestor trees and Descendant trees, but not in 
Outline Descendant trees.    If you need other information about family trees, see the topic 
Family trees.    
If you choose to include Pictures/Objects, Family Tree Maker displays the Options: 
Picture/Object dialog box.    This is where you choose which of each individual's Scrapbook 
Pictures/Objects will appear in the tree.    Select one of the Preferred Picture/Object 
option buttons to include a Picture/Object that you chose as a "Preferred Picture/Object for 
trees" in the More About Picture/Object dialog box.    For more information, see the topic 
"The More About Picture/Object dialog box."
Instead of using the "Preferred Pictures/Objects," you can choose to include a Picture/Object
of a particular category and type.    You use the More About Picture/Object dialog box to 
assign categories and types to Pictures/Objects.    Categories are classifications that you 
create.    For example, you could create a "Birthday" category in which to place birthday 
pictures.    Or, you could create a "Child Portrait" category in which to place portraits that 
were taken when the individuals were young.    Types are chosen from a drop-down list in 
the More About Picture/Object dialog box.    They describe what Pictures/Objects are, such 
as "Pictures" or "Sound Clips."    
The By Category and and Type fields work together to find the Pictures/Objects that you 
want to place in your tree.    For example, if you choose the category "Birthdays" and the 
type "Picture," Family Tree Maker searches for Pictures/Objects that fulfill both 
requirements.    However, both of the fields have an "Any" option, which, in effect, allows 
you to search only one of the two fields.    If the category that you assigned to a 
Picture/Object does not appear in the "By Category" drop-down list, just type it into the 
field.    When there is more than one Picture/Object in the category that you select, Family 
Tree Maker uses the first one.
If you wish to add the Picture/Object's caption or date, select the Include caption or 
Include date check box.    You can also limit the size of the Pictures/Objects that you 
include in your trees.    See the topic "Limiting the Width of Boxes and Pictures/Objects." 

Missing Pictures/Objects
You may not have a Picture/Object for all of the individuals that you are including in the 
tree.    When this is the case, Family Tree Maker substitutes a graphic where the 
Picture/Object normally would be.    To choose the substitute graphic, click Missing 
Pictures/Objects.    Family Tree Maker displays the Missing Pictures/Objects dialog box.    
You can do one of the following:
 Select the button for the graphic that you prefer and then click OK to return to the 

Options: Picture/Object dialog box.
 Choose to use your own picture file as a substitute graphic.    The graphic can be in any of 

the following file formats:    Windows Bitmap (*.BMP), CompuServe Bitmap (*.GIF), ZSoft 
Image (*.PCX), Tagged Image Format (*.TIF), JPEG Interchange Format (*.JPG, *.JFF).    To 
choose your own picture, click Choose Picture.    Family Tree Maker displays the Import 
Picture from File dialog box.    If you need instructions, see the topic "Pictures/Objects:    Insert
Picture from File."    When you are finished selecting a picture to insert, click OK to return to 
the Options: Picture/Object dialog box.
See Also
Limiting the width of boxes
Pictures/Objects:    Insert Picture from File
The More About Picture/Object dialog box





Formatting text in trees 
Each text item that appears in your tree can be formatted differently.    For example, you 
might want to bold individuals' names or even print them in a larger point size than the 
other text in your tree.    If you need other information about family trees, see the topic 
Family trees.
To format items that appear in your tree's boxes:
1. From the Format menu, select Text Font, Style, & Size (ALT, T, T).

Family Tree Maker displays the Text Font, Style, & Size dialog box.
2. In the Items to format list, select an item that you want to format, such as Name.    

Each of the formatting options is described below.    The "Sample" field shows what your 
choices will look like.
Font    Use this field to select a font for that item.    
Size    Use this field to select a point size for that item.    

Note:    The Size option is not available for Fit to Page Ancestor trees.    Family Tree 
Maker automatically sizes text in these trees for you.

Style    Use this field to select a text style, such as bold or italics, for that item.        
Color    Use this field to select a color for that item.
Alignment    Use this field to select an alignment option, such as "Centered," for that 
item.    

Note:    The Alignment option is not available for Outline Descendant trees.    
Underline    Select this check box to underline the item.    

3. Click OK when you've made your selections.    
Family Tree Maker returns you to the tree view.



Selecting styles for boxes, lines, and tree borders
Each family tree that you print can have a different style and color of boxes, lines, and 
borders.    You can also choose a background color for the entire tree.    If you need other 
information about family trees, see the topic Family trees.
To select formatting options for boxes, lines, and borders:
1. From the Format menu, select Box, Line, & Border Styles (ALT, T, B). 

Family Tree Maker displays the Box, Line, & Border Styles dialog box.    If you are 
formatting an Outline Descendant tree, this dialog box is labeled "Line & Border Styles."

2. Make your selections by clicking the buttons with the pictures of the borders, boxes, 
and lines that you like.    Each tree can only have one border style, one box style, and 
one line style.    Of course, Outline Descendant trees don't have box style options.

3. You can also choose colors for each of these elements.    Click the arrow next to the 
color field for the element whose color you wish to change and then select a color from
the list that is Family Tree Maker displays.    
The colors will only print if you have a color printer.    Otherwise, the colors will print in 
shades of gray.    
A "fill" color is the color that your boxes are "filled in" with.    A "background" color is the 
color behind your tree.    A "shadow" color is the area of color that appears on the outside
edge of the bottom two box styles.

4. Click OK when you've made your selections.    
Family Tree Maker returns you to the tree view.



Adding a title and footnote to a tree
Each family tree that you print can have a personalized title and footnote.    If you need 
other information about family trees, see the topic Family trees.
To add a title or footnote to your tree:
1. From the Contents menu, select Title & Footnote (ALT, C, T).

Family Tree Maker displays the Title & Footnote dialog box.    
Title    Select the Automatic title option button to get a title such as "Ancestors of Jane 
Smith."    To create your own title, select the Custom title option button and type your 
title in the field provided.    Titles print at the top center of your tree.    With Outline 
Descendant trees, you can select the Print title on every page check box to include 
the title on each page of your tree.
Page Number    Select the Include page number check box to place page numbers at 
the bottom of each page of your tree.    Click the up and down arrows on the Starting 
number field to change the starting page number.

Note:    This option is only available for Outline Descendant trees.
Footnote    Type your footnote in the field provided.    It can be up to four lines long and 
will print in the lower left corner of your tree.    Select the Draw box around footnote 
check box if you want Family Tree Maker to draw a box around your footnote.    

2. Click OK when you've made your selections.    
Family Tree Maker returns you to the tree view.



Limiting the Width of Boxes and Pictures/Objects
Setting a maximum box width and a maximum Picture/Object width can often help you fit 
more information on a single page.    This option is not available for Fit to Page Ancestor 
trees because Family Tree Maker automatically controls this setting for you.    If you need 
other information about family trees, see the topic Family trees.
To set a maximum width for your tree's boxes and Pictures/Objects:
1. From the Format menu, select Maximum Width for Each Box & Picture/Object 

(ALT, T, W).
Family Tree Maker displays the Maximum Width for Each Box & Picture/Object dialog box.

2. Enter a number in the Maximum box width field.    To get a smaller tree, 
enter a smaller number.    You can enter any width between .1 and 99.99 
inches. 

3. Enter a number in the Maximum Picture/Object width field.    To allow the 
Pictures/Objects to fit inside their boxes, this number must be slightly smaller than the 
number in the "Maximum box width" field.    If it is too large, Family Tree Maker will 
display an error message. 

4. Click OK when you've made your selections.    
Family Tree Maker returns you to the tree view.

Note: If necessary, Family Tree Maker will abbreviate your information to make it 
fit in the box size you specify.    For example, if you select a very long name format, but a 
small maximum box width, Family Tree Maker may have to change the name format to a 
smaller one.



Other printing options for trees
Select the topic for the type of tree that you are currently printing.
Ancestor tree printing options
Descendant tree printing options
Outline Descendant tree printing options



Ancestor tree printing options
To display the special printing options for Ancestor trees, go to the Ancestor tree view.    
Then, from the Contents menu, select Options (ALT, C, O).    If you need other information 
about family trees, see the topic Family trees.
Label columns as "Parents," "Grandparents," etc.    Column labels identify each 
generation of your tree as the parents, grandparents, great-grandparents, etc., of the 
primary individual.    These labels appear at the top of each column.    
Include duplicate ancestors each time they appear    If you have an instance of 
intermarriage (for example, a cousin marrying back into the family), you will have duplicate
individuals in your tree.    Select this check box if you want these individuals to print more 
than once.
Include Siblings of Primary Individual    Usually an Ancestor tree doesn't contain the 
siblings of the primary individual.    However, you can select this option to include them.    
With Fit to Page Ancestor trees, the siblings will be left out if there is not enough space.    
Include empty branches  Select this option to print trees with empty branches.    This can
be useful if you are going to do some research.    You can just print a tree with "typical" 
branches and fill in any information you find.    Then, when you return home, you can 
transfer your hand-written information to Family Tree Maker.



Descendant tree printing options
To display the special printing options for Descendant trees, go to the Descendant tree 
view.    Then, from the Format menu, select Options (ALT, C, O).    If you need other 
information about family trees, see the topic Family trees.
Label rows as "Children," "Grandchildren," etc.    Row labels identify each generation 
of your tree as the children, grandchildren, great-grandchildren, etc., of the primary 
individual.    These labels appear at the left margin of the page. 
Include duplicate descendants each time they appear    If you have an instance of 
intermarriage (for example, a cousin marrying back into the family), you will have 
duplicated individuals in your tree.    Select this check box if you want these individuals to 
print more than once.



Outline Descendant tree printing options
To display the special printing options for Outline Descendant trees, go to the Outline 
Descendant tree view.    Then, from the Format menu, select Options (ALT, C, O).    If you 
need other information about family trees, see the topic Family trees.
Print spouses    Select this check box to include each individual's spouse in your Outline 
Descendant tree.    An individual's spouse appears directly below that individual with a plus 
sign (+) in front of his or her name.    
Include duplicate descendants each time they appear    If you have an instance of 
intermarriage (for example, a cousin marrying back into the family), you will have 
duplicated individuals in your tree.    Select this check box if you want these individuals to 
print more than once.



Reducing the size of a tree
Making a tree shorter
Making a tree narrower



Making a tree shorter
Experiment with the following options to help control the size of your tree.    If you need 
other information about family trees, see the topic Family trees.
 Choose a format that puts the date and location on the same line or prints the date only.    
 Choose to include fewer generations in a single tree.    Print multiple trees instead.    
 Print fewer items for each individual.      
 Omit borders, titles, and footnotes.    
 Don't label columns as parents, grandparents, etc.    
 Omit empty branches and siblings of the primary individual.    
 Select a smaller font size, a smaller font, and the font style "Regular."    
 For Outline Descendant trees, reduce the number of rows per individual.
 Try switching Print Setup to Portrait.    
See Also
Formatting items to include in trees
Selecting information to include in trees
Selecting the number of generations
Selecting the layout and box connections for trees
Adding a title and footnote to a tree
Other printing options for trees
Formatting text in trees
Selecting styles for boxes, lines, and tree borders
Formatting options for Outline Descendant trees
Print setup



Making a tree narrower
Experiment with the following options to help control the size of your tree.    If you need 
other information about family trees, see the topic Family trees.
 Choose a format that puts the date and location on separate lines or prints the date only.    
 Choose a name format that omits middle names.    
 Choose to include fewer generations in a single tree.    Print multiple trees instead.    
 If you print "Fact" fields, shorten the information entered in them.
 Omit borders, titles, and footnotes.    
 Don't label rows as children, grandchildren, etc.    
 Omit empty branches and siblings of the primary individual.    
 Select a smaller font size, a smaller font, and the style "Regular."    
 Reduce the width of the boxes with the Maximum Box Width option.    
 For Outline Descendant trees, select the "Always One Page" option.
 Try switching Print Setup to Landscape    
See Also
Formatting items to include in trees
Selecting information to include in trees
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The Facts dialog box
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Selecting styles for boxes, lines, and tree borders
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Printing a tree
Once you have created your tree, you're ready to print it.    If you need other information 
about family trees, see the topic Family trees.
To print a tree that you've created:
1. Make sure you're in a tree view; there should be a tree on your screen.
2. Turn your printer on.
3. From the File menu, select Print Tree (ALT, F, P).

Family Tree Maker displays the Print dialog box where you can select printing options.    
Note:    You can control items such as paper orientation, paper size, margins, and which
printer prints your tree.    If you want to change any of these items, see the topic "Print 
setup." 

Print range    If you want to print all of the pages, select the All option button.    If you 
want to print a range of pages, type the page number of the first page in the From field 
and the page number of the last page in the To field.    If you want to print only one page,
type the number in both the From and To fields.
Print quality    The higher the print quality you choose, the darker and sharper your 
printed materials will be.    If your printer does not support different print qualities, this 
option will not be available to you.
Copies    In this field, type the number of copies that you want to print.
Print to file    If you want to print your tree to a file and send it to your printer at a later 
time, select this check box.    This option is useful if you want to print on a printer owned 
by someone who doesn't have Family Tree Maker.    When you print, you will need to 
provide an output file name.    

Note:    Make sure you change the settings in the Print Setup dialog box to match the 
printer you will be using.    

Collate copies    Select this check box if you are printing multiple copies of a multiple 
page tree and want to print complete trees instead of several copies of the first page, 
then several copies of the second page, and so on.
Print empty    Select this check box to print an empty tree.    

Note:    This option is not available for Outline Descendant Trees.
Print color    Select this check box to print in color if you have a color printer or in 
grayscale if you don't have a color printer.    

4. Click OK when you've made your selections.    
Family Tree Maker prints your tree.

See Also
Print setup



Printing large trees on plotters
If you can get access to a large plotter, you can print your tree on a poster-size piece of 
paper.    To find a plotter, check with engineering and architectural service bureaus in your 
area.    When you find a service bureau that can plot your tree, follow the instructions 
below.    If you need other information about family trees, see the topic Family trees.
1. Find out what type of plotter they use and then install that plotter's printer driver in 

Windows on your computer.    For information about installing printer drivers, see your 
Windows manual.

2. Change the settings in Family Tree Maker's Print Setup dialog box so that they match 
the plotter on which you will print your tree.

3. Create your tree.
4. Put a floppy disk in your disk drive.
5. From the File menu, select Print (ALT, F, P).

Family Tree Maker displays the Print dialog box.
6. Select the Print to file check box.    Also make sure to select Print color if you want 

the tree printed in color and have selected appropriate colors in the process of creating
your tree.

7. Click OK.
Family Tree Maker displays the Print to File dialog box.

8. In the Output file name field, type the letter of the drive where your floppy disk is 
located and a name for the tree. 
For example, if your floppy disk was in drive a:\ and you were creating a tree for the Ball 
family, you might type something like a:\balltree.prn  Remember, the file name 
must be no longer than eight characters with a three letter extension.

9. Click OK.
Family Tree Maker prints your tree to your disk.

You can now take the floppy disk to the service bureau and they can print your tree.    The 
service bureau does not need a copy of Family Tree Maker to print your tree.    They will 
simply copy the file directly to the plotter.    For example, if the plotter was connected to 
LPT 1 and your floppy disk was in drive a:\ of their computer, they would type copy /b A:\
balltree.prn LPT1



Family Group Sheets
The following topics will help you create and print Family Group Sheets.
Displaying a Family Group Sheet
Selecting information to include in Family Group Sheets
Formatting items to include in Family Group Sheets
Formatting the text in Family Group Sheets
Adding a title and footnote to a Family Group Sheet
Family Group Sheet format
Printing Family Group Sheets



Displaying a Family Group Sheet
If you need other information about Family Group Sheets, see the topic Family Group 
Sheets.
To create a Family Group Sheet:
1. Go to the Family Page of the individual whose Family Group Sheet you want to see. 

Make sure you go to the Family Page of the husband and wife for whom you want to print
a Family Group Sheet.    If the Family Page shows a spouse other than the one that you 
want, you can navigate to the correct spouse by clicking the Spouses button next to the
individual that you do want in your Family Group Sheet.    

2. From the View menu, select Family Group Sheet (ALT, V, G).    
Family Tree Maker displays the Family Group Sheet.
You can move around in your Family Group Sheet with the scroll bars and arrow keys.    
You can also use the Zoom command to enlarge it on the screen.    From the Edit menu, 
select Zoom (ALT, E, Z), and then choose a size from the dialog box.    The larger the 
percentage, the bigger your Family Group Sheet will be on screen.    You can also use the 
Zoom In and Zoom Out buttons on the Toolbar to view your Family Group Sheet at 
different sizes.
Note:    The Zoom command does not control how large your Family Group Sheet will be 
when you print.
To control whether or not dotted lines representing page margins appear on the screen, 
from the View menu, select Show Page Lines (ALT, V, S).    If there is a check mark, the 
lines will appear on the screen, otherwise, they won't.    The lines will not appear on your 
printed documents.

3. You can either print your Family Group Sheet right away or customize it and then print.
See Also
Selecting information to include in Family Group Sheets
Formatting text in Family Group Sheets
Printing Family Group Sheets



Selecting information to include in Family Group Sheets
With Family Tree Maker, you can choose which information to include in your Family Group 
Sheets.    You can also format the text and the items that appear in your Family Group 
Sheets.    If you need other information about Family Group Sheets, see the topic Family 
Group Sheets.
From the Contents menu, select Items to Include (ALT, C, I).    Family Tree Maker displays 
the Items to Include dialog box.    It contains two lists.    The list on the right shows which 
items will be included in your Family Group Sheet.    The scrolling list on the left shows 
which items you can add to the list of items to include.    You can add and delete items to 
and from the list on the right as often as you like.
One page of your Family Group Sheet can contain the basic information; this page is called 
the Standard Page.    You can also choose to include information from the More About dialog
boxes.    This information will appear on additional pages.    If you have placed 
Pictures/Objects in Scrapbooks, you can include them on the Standard Page -- one for each 
individual and one for the marriage.    Simply select Standard Page with 
Pictures/Objects from the list on the left.    If a marriage or an individual does not have a 
Picture/Object, Family Tree Maker will insert a graphic instead.    For more information about 
substitute graphics, see the topic "Standard Page with Pictures/Objects."    Please note that 
this option is not available if you selected the LDS option in the Labels dialog box (see the 
topic "Field label preferences").
To remove an item from the list on the right:
1. Select the item in the list on the right by clicking it.

Family Tree Maker highlights the item.
2. Click the Remove button (the arrow pointing to the left).    
 

The item disappears from the scrolling list on the right. 
To delete all items from the list on the right, click the Remove all button (the double arrow 
that points to the left).    To change the order in which items print, you need to remove all 
items, then add them back in the order in which you want them to print.
3. Click OK when you've made your selections.    

Family Tree Maker returns you to the Family Group Sheet view.
To add an item to include in your Family Group Sheet: 
1. Select an item in the list on the left by clicking it.    

Be sure to select the items that you want to include in your Family Group Sheet in the 
order in which you want them to print.

2. Click the Include button (the arrow pointing to the right). 
The item appears in the list on the right.    Sometimes when you select an item to 
include, you need to make a formatting choice.    If this is the case, Family Tree Maker 
automatically displays a dialog box asking for your formatting choice.    Just make your 
selections and click OK.    Your formatting options are described more completely in the 
topic "Formatting items to include in Family Group Sheet."

3. Click OK when you've made your selections. 
Family Tree Maker returns you to the Family Group Sheet view.

See Also
Formatting items to include in Family Group Sheets
Standard Page with Pictures/Objects



Field label preferences
Formatting text in Family Group Sheets



Formatting items to include in Family Group Sheets
If you need other information about Family Group Sheets, see the topic Family Group 
Sheets.
To change the formatting of an item that's already in the list on the right of the
Items to Include dialog box: 
1. From the Contents menu, select Items to Include (ALT, C, I).
2. Select the item in the list on the right by clicking it.
3. Click Options.

Family Tree Maker displays an Options dialog box.    
If you selected the Standard Page, you will have the following options:

Include labels of empty fields    Select this check box to print labels for fields which 
contain no information.    
Include blank rows for additional children    Select this check box to print empty 
rows so you can fill in information about more children.
Spouses    Select the Include all spouses option button to list all spouses on the 
Family Group Sheet.    If you want only the preferred spouse to print, select Include 
preferred spouse only.

If you selected the Standard Page with Pictures/Objects, you have several options.    For 
more information, see the topic "Standard Page with Pictures/Objects."
If you selected information from any of the More About dialog boxes, you will have the 
following options:

Include labels of empty fields    Select this check box to print labels for fields which 
contain no information.    
Include source information    Select this check box to print source information along 
with the More About information.

4. Click OK when you've made your selections.
When you have finished formatting and selecting items to include in your Family Group 
Sheet, click OK in the Items to Include dialog box.    Family Tree Maker returns you to the 
Family Group Sheet view.
See Also
Standard Page with Pictures/Objects



Standard Page with Pictures/Objects
If you need other information about Family Groups Sheets, see the topic Family Group 
Sheets.
If you choose to include the Standard Page with Pictures/Objects in your Family Group 
Sheet, Family Tree Maker displays the Options: Standard Page with Pictures/Objects dialog 
box.    Select the Preferred Picture/Object option button to include the Picture/Object 
that you chose as the "Preferred Picture/Object for Fam Grp Sheets" in the More About 
Picture/Object dialog box.    The Picture/Object that you chose in the Marriage Scrapbook 
will appear at the top of the Family Group Sheet and the Picture/Object that you chose in 
the Individual Scrapbooks will appear next to each individual.    For more information about 
the More About Picture/Object dialog box, see the topic "The More About Picture/Object 
dialog box."
Instead of using the "Preferred Pictures/Objects," you can choose to include a Picture/Object
of a particular category and type.    Categories are classifications that you create.    For 
example, you could create a "Birthday" category in which to place birthday pictures.    Or, 
you could create a "Child Portrait" category in which to place portraits that were taken 
when the individuals were young.    
Types are chosen from a drop-down list in the More About Picture/Object dialog box.    They 
describe what Pictures/Objects are, such as "Pictures" or "Sound Clips."    Categories and 
types are assigned to each Picture/Object in the More About Picture/Object dialog box.    
The By Category and and Type fields work together to find the Pictures/Objects that you 
want to place on your Family Group Sheet.    For example, if you choose the category 
"Birthdays" and the type "Picture," Family Tree Maker searches for Pictures/Objects that 
fulfill both requirements.    However, both of the fields have an "Any" option, which, in 
effect, allows you to search only one of the two fields.    If the category that you assigned to
a Picture/Object does not appear in the "By Category" drop-down list, just type it into the 
field.    When there is more than one Picture/Object of the category and type that you 
select, Family Tree Maker uses the first one.

Missing Pictures/Objects
You may not have a Picture/Object for all of the individuals that you are including in the 
Family Group Sheet.    When this is the case, Family Tree Maker substitutes a graphic where 
the Picture/Object normally would be.    To choose the substitute graphic, click Missing 
Pictures/Objects.    Family Tree Maker displays the Missing Pictures/Objects dialog box.    
You can do one of the following:
 Select the button for the graphic that you prefer and then click OK to return to the 

Options: Picture/Object dialog box.
 Choose to use your own picture file as a substitute graphic.    The graphic can be in any of 

the following file formats:    Windows Bitmap (*.BMP), CompuServe Bitmap (*.GIF), ZSoft 
Image (*.PCX), Tagged Image Format (*.TIF), or JPEG Interchange Format (*.JPG, *.JFF).    To 
choose your own picture, click Choose Picture.    Family Tree Maker displays the Import 
Picture from File dialog box.    If you need instructions, see the topic "Picture/Object:    Insert 
Picture from File."    When you are finished selecting a picture to insert, click OK to return to 
the Options: Picture/Object dialog box.
See Also
The More About Picture/Object dialog box



Formatting text in Family Group Sheets
You can change the text font, style, and size in Family Group Sheets.    If you need other 
information about Family Groups Sheets, see the topic Family Group Sheets.
To format text on the Family Group Sheet:
1. From the Format menu, select Text Font, Style, & Size (ALT, T, T).

Family Tree Maker displays the Text Font, Style, & Size dialog box.
2. In the Items to format list, click an item that you want to format, such as Standard 

Page.
Each of the formatting options is described below.    The "Sample" field shows what your 
choices will look like.
Font    Use this field to select a font for that item.    
Size    Use this field to select a point size for that item.    
Style    Use this field to select a text style, such as bold or italics, for that item.        
Color    Use this field to select a color for that item.
Underline    Select this check box to underline the item.    

3. Click OK when you've made your selections.    
Family Tree Maker returns you to the Family Group Sheet view.



Adding a title and footnote to a Family Group Sheet
Each Family Group Sheet that you print can have a personalized title and footnote.    If you 
need other information about Family Groups Sheets, see the topic Family Group Sheets.
To add a title or footnote to your tree:
1. From the Contents menu, select Title & Footnote (ALT, C, T).

Family Tree Maker displays the Title & Footnote dialog box. 
Title    Select the Automatic title option button if you want Family Tree Maker to create 
a title for you.    To create your own title, select the Custom title option button and type 
your title in the field provided.    Titles print at the top center of the page.
Name, Address, Phone, and Date    Enter your personal information and the date in 
these fields so that people who look at the Family Group Sheet will know who prepared it.
This information prints as a footnote.
Include page number    Select this check box to print page numbers at the bottom of 
each page.    You can choose the starting page number.

2. Click OK when you've made your selections.    
Family Tree Maker returns you to the Family Group Sheet view.



Family Group Sheet Format
When you print your Family Group Sheets, you can choose whether or not each individual's 
information begins on a new page.    If you need other information about Family Groups 
Sheets, see the topic Family Group Sheets.
To select a Family Group Sheet printing format:
1. From the Format menu, select Format (ALT, T, F).

Family Tree Maker displays the Format dialog box.
2. If you want each individual's information to begin on a new page, select the Begin 

each person on a new page check box.    Otherwise, do not select the check box.
3. Click OK when you've made your selection.

Family Tree Maker returns you to the Family Group Sheet view.



Printing Family Group Sheets
When you have finished creating your Family Group Sheet, you're ready to print.    You can 
also use these instructions to print an empty Family Group Sheet.    If you need other 
information about Family Groups Sheets, see the topic Family Group Sheets.
To print your Family Group Sheet:
1. Make sure you're in the Family Group Sheet view.
2. Turn your printer on.
3. From the File menu, select Print Family Group Sheet (ALT, F, P).

Family Tree Maker displays the Print dialog box where you can select printing options. 
Print range    If you want to print the entire Family Group Sheet, select the All option 
button.    If you only want to print part, type the number of the first page that you want to
print in the From field and the number of the last page in the To field.    To print only one 
page, type the number of that page in both the From and To fields.
Print quality    The higher the print quality you choose, the darker and sharper your 
printed materials will be.    If your printer does not support different print qualities, this 
option will not be available to you.
Print color    Select this check box to print text in color if you have a color printer, or in 
black, white, and gray if you don't have a color printer.    
Copies    In this field, type the number of copies that you want to print.
Collate copies    Select this check box if you are printing multiple copies of a Family 
Group Sheet and want to print complete sets.    De-select this check box if you want 
multiple copies of the first page, multiple copies of the second page, and so on.
Print to file    If you want to print your Family Group Sheet to a file and send it to your 
printer at a later time, select this check box.    This option is useful if you want to print on 
a printer owned by someone who doesn't have Family Tree Maker.    When you print, you 
will need to provide an output file name.    

Note:    Make sure you change the settings in the Print Setup dialog box to match the 
printer you will be using.    

Print empty    To print an empty Family Group Sheet, click this check box.    
4. Click OK when you've made your selections.    

Family Tree Maker prints your Family Group Sheet.



Labels and cards
Labels and cards have all kinds of valuable uses.    For example, you can print address 
labels when it's time to send out invitations or holiday greetings.    Making "Hello, my name 
is..." stickers for large family reunions can help everyone get acquainted, and printing 
rolling index cards allows you to keep family phone numbers close at hand.    You can even 
print addresses directly onto postcards when it is time to do a family mailing or onto 
address book pages for your personal use.    By printing on regular 8 1/2" x 11" paper, you 
can also use this printing feature to print block-style lists of family members.    
Family Tree Maker allows you to select a group of individuals for whom to print labels or 
cards so that you don't have to print everyone in your Family File.    In addition, each time 
you print, Family Tree Maker lets you choose whether to print one label or card for each 
household or for each individual.    For example, if you are printing address labels for 
holiday cards, you probably only want to print one label per household.    If you are printing 
name tags, you would want to print one for each individual.
Because Family Tree Maker recognizes the relationships between the individuals in your 
family tree, the labels and cards printing function is that much more powerful.    For 
example, if you choose to print one address label per household, Family Tree Maker realizes
that not everyone fits into the precise mold of a nuclear family.    This means that it would 
print address labels that said "The John and Jane Doe Family" for any nuclear families, "John
and Jane Doe" for any couples without children, and "Jane Doe" or "John Doe" for any single
adults.    No one is excluded just because they aren't part of a household that has two 
parents and children.    The topics below will help you create your labels and cards.
See Also
Displaying labels and cards
Using your mouse with labels and cards
Print setup and label size
Selecting individuals to print
Selecting items to include on labels and cards
Formatting items to include on labels and cards
Formatting text on labels and cards
Selecting box, border, and line styles for labels and cards
Selecting a width for Pictures/Objects
Other printing options for labels and cards
Sorting labels and cards
Printing labels and cards



Displaying labels and cards
If you need other information about labels and cards, see the topic Labels and cards.
To create labels or cards:
1. From the View menu, select Labels/Cards (ALT, V, L).    

Family Tree Maker displays a sheet of labels or cards.    Their size and shape will depend 
on the type of labels or cards that are currently selected in the Print Setup dialog box.    
The default is an 8 1/2" x 11" sheet of address labels.    We will show you how to change 
the label or card size in the topic "Print Setup and label size."
You can move around in your labels and cards with the scroll bars and arrow keys.    You 
can also use the Zoom command to enlarge it on the screen.    From the Edit menu, 
select Zoom (ALT, E, Z) and then choose a size from the dialog box.    The larger the 
percentage, the bigger your labels or cards will be on screen.    You can also use the 
Zoom In and Zoom Out buttons on the Toolbar to view your labels or cards at different 
sizes.
Note:    The Zoom command does not control how large your labels and cards will be 
when you print.
To control whether or not dotted lines representing page margins appear on the screen, 
from the View menu, select Show Page Lines (ALT, V, S).    If there is a check mark, the 
lines will appear on the screen, otherwise, they won't.    The lines will not appear on your 
printed documents.

3. You can either print your labels and cards right away, or customize them and then 
print.

See Also
Using your mouse with labels and cards
Print setup and label size for labels and cards
Selecting individuals to print
Selecting items to include on labels and cards
Formatting items to include on labels and cards
Formatting text on labels and cards
Selecting box and line styles for labels and cards
Selecting a width for Pictures/Objects
Other printing options for labels and cards
Sorting labels and cards
Printing labels and cards



Using a mouse with labels and cards
In the Labels/Cards view, clicking in an individual's name allows you to navigate through 
Family Tree Maker, moving to different views and making different individuals the primary 
individual.    What you do depends on whether you double-click or single-click the 
individual's name.    The table below describes each of the functions.    If you need other 
information about labels and cards, see the topic Labels and cards.

Do this... To do this...
Click an individual's name once Select the individual in the box.    

You can now use the menus or the
Toolbar to change to any view.    
The selected individual becomes 
the primary individual

Double-click an individual's 
name

Go to the individuals Family Page 

Print setup and label size for labels and cards
Labels and cards have their own special Print Setup dialog box where you can choose the 
label size, paper source, and which printer to use.    Print setup for all other documents is 
described in the topic "Print Setup."    If you need other information about labels and cards, 
see the topic Labels and cards.
To change the print setup for labels or cards:
1. From the File menu, select Print Setup (ALT, F, R).

Family Tree Maker displays the Print Setup dialog box where you can select your Print 
Setup options.    Each of these options is described below.
Default/Specific Printer    Use this field to select a printer.    The default printer is the 
printer that is normally used by all of your Windows programs.    Under the "Specific 
printer" field there is a list of other printers connected to your computer.    Select the 
Specific Printer option button if you want to select a printer other than the default 
printer.

Note:    If the printer you wish to use is not shown, then you will need to install that 
printer's driver.    Consult your Microsoft Windows User's Guide for information on 
installing printer drivers.

Portrait/Landscape    If you want your document to print with the short edge of the 
paper at the bottom (as a letter normally prints) click the Portrait option button.    If you 
want your document to print with the long edge of the paper at the bottom (sideways), 
click the Landscape option button.    
Source    Click the arrow next to the Source field to choose a paper source.
Avery products    Use this field to select the type and size of the label or card on which 
you will print.    Family Tree Maker supports dozens of different label and card sizes, 
including address labels, name badges, rotary cards, video cassette labels, index cards, 
address book pages, and many more.    The card and label types are based on the Avery 
line of office products, although you can use any brand.    You can even print on plain 8 
1/2" x 11" paper if you just want to print block-style reports.    
Family Tree Maker indicates the product number, style, and size of each label or card so 
that you can get a general idea of the label's or card's appearance.    If you want a better 



idea of a label's or card's appearance, select the label type in the Avery products field 
and click OK.    Family Tree Maker will draw the label or card on your screen.    If you do 
not like the style of the label or card, simply re-open the Print Setup dialog box to select 
a new label or card style.     
Brightness    Use this button to display the Brightness dialog box.    In the Brightness 
dialog box you can control the color level for all of the Pictures/Objects in your 
Scrapbooks.    The Brightness level that you select through the Print Setup for 
Labels/Cards dialog box will only apply to Pictures/Objects that are printed on labels or 
cards.    When you have selected a brightness setting, click OK in the Brightness dialog 
box to return to the Print Setup dialog box.    
Options    Use this button to display the Options dialog box.    The options available to 
you depend on your printer.    Make your selections from this dialog box, and then click 
OK to return to the Print Setup dialog box.

2. Click OK when you've made your selections.
Family Tree Maker returns you to the Labels/Cards view.

See Also
Print setup



Selecting individuals to include on labels and cards
When you print labels or cards, you can choose to print one label or card for each 
household or for each individual.    For example, if you are printing address labels for 
holiday cards, you probably only want to print one label per household.    If you are printing 
name tags, however, you would want to print one for each individual.    If you need other 
information about labels and cards, see the topic Labels and cards.
As you create your list of individuals to print, make sure to include all of the individuals 
whose names you want to appear on a label or card.    If you are printing labels or cards for 
individuals, make sure that you don't leave any individuals off of the list, otherwise a label 
or card won't print for that individual.    If you are printing labels or cards for households, 
make sure to include all of the individuals in the household (unless you purposely want to 
leave a member of the household out).    If you accidentally leave out a member of a 
household, the information on the label or card may not print as you want it to.
Once you have created your list of individuals to print, you will be able to tell Family Tree 
Maker whether you want to print your labels or cards separately for each individual or 
whether you want to print one label or card for each household.    To make this choice, you 
will use the Options dialog box on the Contents menu.    This dialog box is described 
completely in the topic "Other Printing Options for Labels and Cards."
You will also be able to select name formats for your labels and cards.    The name 
formatting choices let you control how formal or informal your labels or cards are.    For 
example, you can choose to use titles such as "Mr." and "Mrs." or you can just choose to 
use first names.    You also can control how the names in a household print.    For example, 
you may choose a name format such as "Mr. & Mrs. Doe and Family."    On the other hand 
you may prefer to list out all of the names of the individuals in the household.      There are 
many other selections to choose from; the choice that you make will probably depend on 
the reason why you are printing your labels or cards.    To make this choice, you will use the 
Options:    Name dialog box, described in the topic "Formatting information that prints."

To create a list of individuals to include:
From the Contents menu, select Individuals to Include (ALT, C, N).    In the Include dialog 
box, choose Selected individuals and then click Individuals to Include to create a new 
group of individuals.    Family Tree Maker displays the Individuals to Include dialog box.    In 
this dialog box you can create a group of individuals to print.    If you later decide that you 
want to print all individuals in your Family File, go back to the Include dialog box and 
choose All individuals instead of Selected individuals.    
The Individuals to Include dialog box contains two lists.    The list on the right shows the 
group of individuals who will be printed.    The scrolling list on the left shows which 
individuals you can add to the group.    The individuals in the list on the left are in 
alphabetical order by last name.    Nicknames (aka's) are not included on the same line as 
given names.    To locate an individual in the list on the left quickly, click in the Name field 
at the top of the list and type the individual's name in the following format:    Last name, 
First name Middle name.    With each character you type, you will get closer to the name 
you are looking for.
You create a group of individuals to print by selecting individuals and adding them to or 
removing them from the list on the right.    You can add and remove individuals in three 
ways:    using the "Include" and "Remove" buttons, using the "Include All" and "Remove All" 
buttons, and using the "Find and Include" and "Find and Remove" buttons.    The table 
below summarizes how each of these buttons work.    Each of these methods is described 
below in more detail.



Use this button... To do this...
"Include" or "Remove" Include or remove individuals one-

by-one.
"Include All" or "Remove All" Include all of the individuals 

currently in your Family File or 
remove all of the individuals 
currently in the group.

"Find and Include" or "Find and 
Remove" 

Choose categories of individuals 
to include or remove all at once.

You can use any combination of these methods to create your group.    When you're done 
creating the group, click OK.    Family Tree Maker will return you to the Labels/Cards view.
Note: There is one Individuals to Include dialog box for all views in Family Tree 
Maker.    The group of individuals that you create in one view, such as Labels/Cards, is 
available to you in the other views that allow you to choose groups:    Custom reports and 
Batch print.    Even if you quit Family Tree Maker, the group that you create in the 
Individuals to Include dialog box will remain the same until you change it again.    Of 
course, if you make changes to the group in one view, such as the Report view, the group
will change in all other views as well.
In general, you do not need to worry about the order in which you add individuals because 
Family Tree Maker can sort them for you later.    The sorting orders include "Last name (A 
first)," "Last name (Z first)," "Birth date (oldest first)," and "Birth date (youngest first)."    If 
you want individuals in an order other than those offered in the Sort dialog box, you need 
to add them to the list on the right in that order.    Then, in the Sort dialog box, select the 
Don't sort individuals option button.

Using the "Include" and "Remove" Buttons
With the "Include" and "Remove" buttons you can add and remove individuals to and from 
the group one at a time.    
To create a group using the "Include" and "Remove" buttons:
1. If you want to add an individual to the group, click his or her name in the list on the 

left.    If you want to remove an individual from the group, click his or her name in the 
list on the right.

2. Click either the Include button (the arrow pointing to the right) or the Remove button 
(the arrow pointing to the left).    

 
If you chose to add the individual, his or her name is added to the list on the right and the 
"Number included" increases by one.    If you chose to remove the individual, his or her name
is removed from the list on the right, and the "Number included" decreases by one.
Instead of selecting an individual and then clicking "Include" or "Remove," you can just 
double-click the individual's name.    Double-clicking names in the list of the left 
automatically adds them to the group.    Double-clicking names in the list on the right 
automatically removes them from the group.

Using the "Include All" and "Remove All" Buttons
With the "Include All" button, one click adds all of the individuals currently in your Family 
File to the group.    With the "Remove All" button, one click removes all of the individuals 
from the group.    
The best time to use the "Include All" button is when you want to create a group that 



includes almost all of the individuals that are currently in your Family File.    For example, if 
there are only a few people that you don't want to include in the group, click the Include 
All button (the double arrows pointing to the right) to move all of the individuals to the list 
on the right.    Then use the Remove button (the arrow pointing to the left) to remove the 
few individuals that you don't want in the group.    This is much faster than including all of 
the individuals one by one.    
If you want to include all of the individuals in your Family File, don't use the "Include All" 
button.    Instead, from the Contents menu, select Individuals to Include.    Then, in the 
Include dialog box, select All Individuals.    This way, individuals that you add to your 
Family File later will be included automatically.    If you use the "Include All" button to 
include everyone, individuals that are added to your Family File later will not be added to 
the group automatically.
The best time to use the "Remove All" button is when you already have several individuals 
in the group and you want to start over.    Click the Remove All button (the double arrows 
pointing to the left) to remove all of the individuals from the group.    Then use the Include 
button (the arrow pointing to the right) to begin adding individuals to the group again.    

Using the "Find and Include" and "Find and Remove" Buttons
With the "Find and Include" and "Find and Remove" buttons, Family Tree Maker will search 
your Family File for individuals, such as those who were born before a certain date or those 
who are ancestors of a particular individual, and add them to the group or remove them 
from the group.
To create a group using the "Find and Include" and "Find and Remove" buttons:
1. Decide which individuals you want to add to or remove from the group.    For example, 

do you want to add all of your ancestors?    Do you want to add all of the individuals 
who were born in a particular town?    Do you want to remove all of the individuals who 
were born before a particular date?    
If you want to add or remove a group of individuals that are ancestors or descendants of 
a particular individual, make sure to highlight the name of that individual in the list on 
the left before moving on to step 2.    For example, if you wanted to add all of your 
ancestors, you would highlight your name.    

2. Click either the Find and Include ("Find" with the arrow pointing to the right) or Find 
and Remove button ("Find" with the arrow pointing to the left).    
Family Tree Maker displays either the Add Individuals or Remove Individuals dialog box.    
In this dialog box you specify which individuals you want Family Tree Maker to find and 
add to the group or remove from the group.

3. Click in the Search field.    
If you want to find individuals who are all ancestors or descendants of a particular 
individual, choose either "Ancestors," or "Descendants," from the drop-down list (you 
may have to scroll upwards to do this).    Family Tree Maker automatically fills the "of" 
field with the name of the individual that was highlighted in step 1.    Skip to step 5.    
If you want to find individuals who have information in common, such as a birth location, 
use the drop-down list to choose the name of the field that contains that information.    
For example, if you want to find all individuals who were born in a particular place, you 
would select "Birth location."    When you've selected a field, go to step 4.

4. In the for field, type the information that you want to search for.    If the field that you 
are searching only has certain legal values (such as "male," "female," and "unknown"), 
then a drop-down list may be displayed in the "for" field.    Just choose the item you 
want to search for.
For example, if you chose "Birth location" in step 3, and you wanted Family Tree Maker to



find everyone that was born in Cleveland, Ohio, then you would type    Cleveland, Ohio  
in the "for" field.    

5. Click OK.    
Family Tree Maker searches through your Family File for individuals who match your 
request.    If no matches are found, Family Tree Maker tells you so.    If you chose to add 
the individuals, their names are added to the list on the right and the "Number included" 
increases.    If you chose to remove the individuals, their names are removed from the list
on the right, and the "Number included" decreases.

See Also
Formatting items to include on labels and cards
Other printing options for labels and cards



Selecting items to include on labels and cards
You can include any type of information that you want on labels and cards, including 
Pictures/Objects.    If you need other information about labels and cards, see the topic 
Labels and cards.
When you're printing labels or cards that include addresses, you should know that Family 
Tree Maker takes addresses from the Address dialog box, described in the topic "The 
Address dialog box."    You do not have to type an address into each individual's Address 
dialog box, because individuals can "inherit" addresses from their spouses or parents.    If 
an individual does not have an address in his or her Address dialog box, Family Tree Maker 
first checks to see if the individual's spouse has an address.    If the individual's spouse does
not have an address, Family Tree Maker uses the address of the individual's parents.    If the 
parents do not have an address either, then the individual has no address.    You can tell 
when an address has been inherited because the label has a dotted line around it.    (The 
dotted line will not print on the label or card.)

Adding and Removing Items to and from labels and cards
From the Contents menu, select Items to Include (ALT, P, I).    Family Tree Maker displays 
the Items to Include dialog box.    It contains two lists.    The list on the right shows which 
items will be included on each label or card.    The scrolling list on the left shows which 
items you can add to the labels or cards.    There is a default group of items that are already
included.    However, you can add and delete items to and from the list on the right as often
as you like.    Remember, though, you don't want to include more items than will fit 
attractively on the labels or cards.    When you're done selecting information, click OK.    
Family Tree Maker will return you to the Labels/Cards view.
To add items to or remove items from labels or cards: 
1. Click the name of the item in the list on the left if you want to add the item.    Click the 

name of the item in the list on the right if you want to remove the item.
2. Click either the Include button (the arrow pointing to the right) or the Remove button 

(the arrow pointing to the left). 
 

If you chose to add the item, it is added to the list on the right.    If you chose to remove the 
item, it is removed from the list on the right.
Instead of selecting an item and then clicking "Include" or "Remove," you can just double-
click the item's name.    Double-clicking items in the list on the left automatically adds them. 
Double-clicking items in the list on the right automatically removes them.    In addition, if you
want to delete all items from the list on the right, just click the Remove all button (the 
double arrow pointing to the left). 
Some items, such as names and dates, require you to make formatting choices.    Family Tree
Maker automatically displays a dialog box that asks you to make a formatting choice when it
is necessary.    For example, if you have placed Pictures/Objects in each individual's 
Scrapbook, you can include them on your labels or cards.    Simply select Picture/Object 
from the list on the left.    Family Tree Maker will display the Options:    Picture/Object dialog 
box.    In this dialog box you can select which Picture/Object will be included on each 
individual's label or card.    If an individual does not have a Picture/Object, Family Tree Maker 
will insert a small graphic in the box instead.    For more information about substitute 
graphics, and other items that need to be formatted, see the topic "Formatting items to include 
on labels and cards."    You can also format the text that appears in your labels and cards.    See
the topic "Formatting text on labels and cards."
Using the Custom Field item, you can add up to 80 characters of text to your labels or 
cards.    What you type in this field will appear on every label or card that you print.    The 
Custom Field item is most useful for adding phrases such as "Hello, my name is..." or 



"Holiday Greetings for" the top of name tags or address labels.    Also useful for labels and 
cards is the item City State    Zip.    This item allows you to print addresses in the correct 
format.    If you tried to create a label using the three separate items City, State, and Zip, 
they would print on three separate lines instead of on one line.
See Also
Formatting items to include on labels and cards
Formatting text on labels and cards



Formatting items to include on labels and cards
When you're selecting items to include on your labels or cards, sometimes Family Tree 
Maker displays an Options dialog box where you can select a format for the information 
that you are including.    If you need other information about labels and cards, see the topic 
Labels and cards.
When you choose to include names on your labels or cards, Family Tree Maker displays the 
Options: Name dialog box.    For more information about this dialog box, see the topic 
"Formatting names in labels and cards."    
Some fields, such as Phone number and Facts, have an option called Include source 
information.    Click this check box to include the source information for that field in your 
tree.
When you choose to include Pictures/Objects in your tree, Family Tree Maker displays the 
Options:    Picture/Object dialog box.    For more information about this dialog box, see the 
topic "Formatting Pictures/Objects in labels and cards."
To change the formatting of an item that's already in the list on the right side 
of the Items to Include dialog box: 
1. From the Contents menu, select Items to Include (ALT, C, I).    

Family Tree Maker displays the Items to Include dialog box.    It contains two lists.      
2. Select the item in the list on the right by clicking it.

Family Tree Maker highlights the item.
3. Click Options.

Family Tree Maker displays an Options dialog box.    
Note:    If you select an item in the scrolling list on the right and Options remains grayed
out, that item does not have any formatting options.

4. Click OK when you've made your selections.
When you have finished formatting and items to include on your labels or cards, click OK
in the Items to Include dialog box.    Family Tree Maker returns you to the Labels/Cards 
view.

See Also
Formatting names in labels and cards
Formatting Pictures/Objects in labels and cards



Formatting names in labels and cards
When you choose to include names in your labels or cards, Family Tree Maker displays the 
Options: Name dialog box.    In this dialog box, you can choose the format in which all 
names print on labels or cards.    If you need other information about formatting items on 
labels and cards, see the topic Formatting items to include on labels and cards.
Note: There may be a few individuals in your Family File who use different titles.    
For example, some individuals may use the title "Dr." or "Reverend" instead of "Mr." or 
"Mrs."    You can create a special name format for an individual in that individual's Lineage
dialog box.    See the topic "The Lineage Dialog Box" for more information.    However, the 
majority of the individuals in your Family File will get their name formats from the 
Options: Name dialog box.
There are two different name formats that you can set in this dialog box:    one when the 
individuals are printed on a label or card as part of a household, and one when the 
individuals are printed as individuals.    Each of these name formats has multiple parts that 
work together to create the whole printed name.    
Before you begin making your selections, here are a few examples:

To get Begin with name end with
The John B. Doe 
Family

The John B. Doe Family

John & Jane Doe 
and Children

(Blank) John & Jane Doe and 
Son/Daughter/ 
Children

Mr. and Mrs. Doe Mr. and 
Mrs.

Doe N/A

Ms. Jane S. Doe Mr./Mrs./Ms. First M. Last 
name

N/A

To set the name format:    
1. Click in the Households/Begin with field.    You can either type in your own word(s), 

leave the field blank, or select an item from the drop-down list.    
The drop-down list generally uses the titles "Mr." and "Mrs."    However, if you prefer 
different titles, you can change them in the Titles dialog box.    For more information, see 
the topic "Title preferences."

2. Click in the Households/name field.    Select an appropriate name format from the 
drop-down list.

3. Click in the Households/end with field.    You can either select an item from the drop-
down list or type in your own word(s).
This field is only available for Households.

4. Repeat steps 1 and 2 for the Individuals field.
5. If you would like Family Tree Maker to print nicknames when they are available, select 

the Use aka if available check box.    If you would like all last names printed in 
capitals, select the Last name all caps check box.    To allow long name formats to 
wrap onto two lines, select the Word wrap check box.

6. Click OK when you've made your selections.
See Also



The Lineage dialog box
Title preferences



Formatting Pictures/Objects in labels and cards
If you choose to include Pictures/Objects on your labels or cards, Family Tree Maker displays
the Options: Picture/Object dialog box.    This is where you choose which of the individual's 
Scrapbook Pictures/Objects will appear on the label or card.    If you need other information 
about formatting information on labels and cards, see the topic Formatting items to 
include on labels and cards.
Select the Preferred Picture/Object #1 option button to include the Picture/Object that 
you chose as the "Preferred Picture/Object for Labels/Cards" in the More About 
Picture/Object dialog box.    For more information about the More About Picture/Object 
dialog box, see the topic "The More About Picture/Object dialog box."
Instead of using the "Preferred Pictures/Objects," you can choose to include a Picture/Object
of a particular category and type.    Categories are classifications that you create.    For 
example, you could create a "Birthday" category in which to place birthday pictures.    Or, 
you could create a "Child Portrait" category in which to place portraits that were taken 
when the individuals were young.    
Types are chosen from a drop-down list in the More About Picture/Object dialog box.    They 
describe what Pictures/Objects are, such as "Pictures" or "Sound Clips."    Categories and 
types are assigned to each Picture/Object in the More About Picture/Object dialog box.    
The By Category and and Type fields work together to find the Pictures/Objects that you 
want to place on your labels or cards.    For example, if you choose the category "Birthdays"
and the type "Picture," Family Tree Maker searches for Pictures/Objects that fulfill both 
requirements.    However, both of the fields have an "Any" option, which, in effect, allows 
you to search only one of the two fields.    If the category that you assigned to a 
Picture/Object does not appear in the "By Category" drop-down list, just type it into the 
field.    When there is more than one Picture/Object of the category and type that you 
select, Family Tree Maker uses the first one.
If you wish to add the Picture/Object's caption or date, select the Include caption or 
Include date check box.    You can also limit the size of the Pictures/Objects that you 
include in your trees.    See the topic "Limiting the width of Pictures/Objects." 

Missing Pictures/Objects
You may not have a Picture/Object for all of the individuals that are being printed.    When 
this is the case, Family Tree Maker substitutes a graphic where the Picture/Object normally 
would be.    To choose the substitute graphic, click Missing Pictures/Objects.    Family Tree
Maker displays the Missing Pictures/Objects dialog box.    You can do one of the following:
 Select the button for the graphic that you prefer and then click OK to return to the 

Options: Picture/Object dialog box.
 Choose to use your own picture file as a substitute graphic.    The graphic can be in any of 

the following file formats:    Windows Bitmap (*.BMP), CompuServe Bitmap (*.GIF), ZSoft 
Image (*.PCX), Tagged Image Format (*.TIF), or JPEG Interchange Format (*.JPG, *.JFF).    To 
choose your own picture, click Choose Picture.    Family Tree Maker displays the Insert 
Picture dialog box.    If you need instructions, see the topic "Picture/Object:    Insert Picture 
from File."    When you are finished selecting a picture to insert, click OK to return to the 
Options: Picture/Object dialog box.
See Also
The More About Picture/Object dialog box
Selecting the width of Pictures/Objects
Picture/Object:    Insert Picture from File



Formatting text on labels and cards
Each text item that appears in your labels and cards can be formatted differently.    For 
example, you might want to bold individuals' names, or even print them in a larger point 
size than the other text on your labels or cards.    If you need other information about labels
and cards, see the topic Labels and cards.
To format items that appear on your labels or cards:
1. From the Format menu, select Text Font, Style, & Size (ALT, T, T).

Family Tree Maker displays the Text Font, Style, & Size dialog box.
2. In the Items to format list, select an item that you want to format, such as Name.    

Each of the formatting options is described below.    The "Sample" field shows what your 
choices will look like.
Font    Use this field to select a font for that item.    
Size    Use this field to select a point size for that item.    
Style    Use this field to select a text style, such as bold or italics, for that item.        
Color    Use this field to select a color for that item.
Alignment    Use this field to select an alignment option, such as "Centered," for that 
item.    
Underline    Select this check box to underline the item.    

3. Click OK when you've made your selections.    
Family Tree Maker returns you to the Labels/Cards view.



Selecting box, border, and line styles for labels and cards
Family Tree Maker has several different box and line styles for labels and cards.    In 
addition, you can select colors for different elements in your labels and cards, such as the 
background and borders.    The box is drawn around the outside edge of the label or card.    
Choosing not to have a box will give you the most space for text on your label or card.    The
line color that you select will be the color with which the box is drawn.    The fill color will be
inside the box.    If you need other information about labels and cards, see the topic Labels 
and cards.
To select these formatting options:
1. From the Format menu, select Box & Line Styles (ALT, T, B).    

Family Tree Maker displays the Box & Line Styles dialog box.    
2. Make your selections by clicking the buttons with the styles that you like.    

You may only choose one style for each element.    For example you can only choose one 
border style per document.

3. You can also select colors for various parts of your document, depending on which 
document it is.    Click the arrow next to the color field for the element you wish to 
change and then select a color from the list Family Tree Maker displays.    The colors will
only print if you have a color printer, otherwise they will print in grayscale.

4. Click OK when you've made your selections.    
Family Tree Maker returns you to the Labels/Cards view.



Selecting a width for Pictures/Objects
When you choose to include Pictures/Objects on your labels or cards, setting a maximum 
width can help you fit more information on each label or card.    If you need other 
information about labels and cards, see the topic Labels and cards.
To set a maximum width for Pictures/Objects on labels and cards:
1. From the Format menu, select Maximum Width for Each Picture/Object (ALT, T, W).
2. Enter a number in the Maximum Picture/Object width field.    To get a smaller 

Picture/Object, enter a smaller number.    You can enter any width between 0.1 inch and
99.99 inches.    Your Pictures/Objects will fit into a square with sides of that length.

3. Click OK when you've made your selection.    
Family Tree Maker returns you to the Labels/Cards view.

Note: If necessary, Family Tree Maker will abbreviate your information to make it 
fit in the label or card size you specify.    For example, if you select a very long name 
format, but a small label or card, Family Tree Maker may have to change the name format
to a smaller one.



Other printing options for labels and cards
Labels and cards have other important printing options.    To display the dialog box where 
you choose special printing options, from the Contents menu, select Options (ALT, P, O).    
Each of these options is described below.    If you need other information about labels and 
cards, see the topic Labels and cards.
Use Name Format for    When you print labels or cards, you must decide if you want to 
print one label or card for each household or for each individual.    For example, if you are 
printing address labels for holiday cards, you probably only want to print one label per 
household.    If you are printing name tags, however, you would want to print one for each 
individual.    
If you select Individual, Family Tree Maker will use the "Individuals" name format you 
selected in the Options:    Name dialog box to print a label or card for each individual in your
list of Individuals to Include.    If you select Household, Family Tree Maker will use the 
"Household" name format you selected in the Options: Name dialog box to print a label or 
card for each group of individuals who share the same address.    Family Tree Maker is smart
enough to adjust the name format for all different types of households:
 A family group, such as parents and children, that shares the same address will print on 

one label with the "Household" name format you have selected.    For example "Mr. and Mrs. 
Doe and Family." 

 A couple that shares the same address will print on one label with a variation of the 
"Household" name format.    For example "Mr. and Mrs. Doe"

 A single individual with a unique address will print alone on a label with another variation 
of the "Household" name format.    For example, "Ms. Doe." 
That way, all of your labels and cards have the same basic style and formality, but are 
suitable to the type of household.    The exact name format that is printed on your labels or 
cards will depend on your selections in the Options: Name dialog box, described in the topic
"Formatting names in labels and cards."
Print blank rows when fields are empty    When the Print blank rows when fields 
are empty check box is selected, Family Tree Maker will insert a blank row in the label or 
card when it comes across an empty field.
See Also
Formatting names in labels and cards



Sorting labels and cards
When you print labels and cards, you can select the order in which the names print.    If you 
need other information about labels and cards, see the topic Labels and cards.
To select a sorting order:
1. From the Format menu, select Sort (ALT, T, S).

Family Tree Maker displays the Sort dialog box.
2. Click the option button for the type of sorting you prefer.

If you want the individuals to print in the order in which you added them to the group in 
the Individuals to Include dialog box, select the Don't Sort Individuals option button.    
This is especially useful for printing individuals in Ancestor or Descendant order. 

3. Click OK when you've made your selection.
Family Tree Maker returns you to the Labels/Cards view.



Printing labels and cards
Once you have created your labels and cards, you are ready to print.    If you need other 
information about labels and cards, see the topic Labels and cards.
To print a labels and cards:
1. Make sure you're in the Labels/Cards view.
2. Turn your printer on.
3. From the File menu, select Print (ALT, F, P).

Family Tree Maker displays the Print dialog box where you can select printing options.    
Each of these options is described below.

Note: You can also control items such as paper orientation, label/card size, and 
which printer prints your labels or cards.    If you want to change any of these items, 
see the topic "Print Setup and label size."

Print range    Use this option to select the pages to print.    If you want to print all of the 
pages, select the All option button.    If you want to print a range of pages, type the page
number of the first page that you want to print in the From field and type the page 
number of the last page you want to print in the To field.    If you want to print only one 
page, type the number of that page in both the From and To fields.
Print quality    Use this option to select the quality of your printed materials.    The 
higher the print quality you choose, the darker and sharper your printed materials will 
be.    However, items printed in high print quality also take longer to print.    If your printer
does not support different print qualities, this option will not be available to you.
Copies    In this field, type the number of copies that you want to print.
Print to file    If you want to print to a file and send it to your printer at a later time, 
select this check box.    This option is especially useful if you want to print on a printer or 
plotter owned by someone who doesn't have Family Tree Maker.    When you print, Family 
Tree Maker will ask for an "Output File Name." 

Note: If you intend to print the file on a printer other than your own, you will need 
to change the settings in the Print Setup dialog box to match the printer you will be 
using.    See the topic "Print Setup and label size."    

Collate copies    Select this check box if you are printing multiple copies of your 
document and want to print complete sets instead of several copies of the first page, 
then several copies of the second page, and so on.
Print color    If you have a color printer, select this check box to print in color.      If you 
have a black and white printer, select this check box to print in grayscale.    De-select this
check box if you just want to print in black and white.    If you have a black and white 
printer, color Pictures/Objects will always print in grayscale. 

4. Click OK when you've made your selections.    
Family Tree Maker prints your labels and cards.

See Also
Print setup and label size



Calendars
When you choose the Calendar view, Family Tree Maker creates a basic calendar for you. 
You can modify the chart to your liking and then print it.
Displaying a calendar
Selecting information to include in calendars
Formatting text in calendars
Selecting border and line styles for calendars
Adding a subtitle and footnote to calendars
Printing calendars
Printing calendars with pictures



Displaying a calendar
To create a calendar, from the View menu, select Calendar (ALT, V, C).    Family Tree Maker 
displays a calendar with your family's birthdays and anniversaries.    If there are too many 
birthdays or anniversaries to fit on a particular day, a second page of that month will print 
with the overflow.    If you need other information about calendars, see the topic 
Calendars.
You can move around in your calendar with the scroll bars and arrow keys.    You can also 
use the Zoom command to enlarge it on the screen.    From the Edit menu, select Zoom 
(ALT, E, Z), and then choose a size from the dialog box.    The larger the percentage, the 
bigger your calendar will be on screen.    You can also use the Zoom In and Zoom Out 
buttons on the Toolbar to view your calendar at different sizes.
Note:    The Zoom command does not control how large your calendar will be when you 
print.
To control whether or not dotted lines representing page margins appear on the screen, 
from the View menu, select Show Page Lines (ALT, V, S).    If there is a check mark, the 
lines will appear on the screen, otherwise, they won't.    The lines will not appear on your 
printed documents.
If you notice that anyone is missing from your calendar, go to the Lineage dialog box for 
that individual and check to see that they are selected to appear in calendars.    
See Also
The Lineage dialog box



Selecting information to include in calendars
You can include different types of information in your calendars, such as birthdays and 
anniversaries.    If you need other information about calendars, see the topic Calendars.
To choose information to include in your calendar:
1. From the Contents menu, select Items to Include (ALT, C, I).

Family Tree Maker displays the Items to Include dialog box.
2. Select the items that you want to print in your calendar.

Year    Use this option to control which year prints.
Month    Choose a particular month if you only want to print that month.    To print a full 
year, choose All.
Name format    Use this option to choose the format in which each individual's name 
appears.    For example, you could choose to include only first and last names, but not 
middle names.
Use aka if available    Select this check box to use individuals' nicknames instead of 
given names.
Use married names for female family members  Select this check box to use 
women's married names instead of maiden names.    
Print only if still alive    Select this check box to exclude information about those 
individuals for whom you have entered death dates.
Event Items to Include    Use these options to indicate whether you want birthdays, 
anniversaries, or both included in your calendar.    
To have Family Tree Maker calculate individuals' ages and the number of years that they 
have been married, select the "Include age for birthdays & years for anniversaries" check
box.    This number will appear next to their names.    If a "?" prints, it means that there is 
no information in the associated date field.    If "est" prints, it means that you entered an 
uncertain date.    (A date that is uncertain contains a modifier such as "about," "before," 
or "after.")
Events that fall on February 29th will appear on February 28th if the calendar is not for a 
leap year.    Anniversaries of divorced couples or couples whose marriages were annulled 
will not appear.

3. Click OK when you've made your selections.    
Family Tree Maker returns you to the Calendar view.



Formatting text in calendars
You can format the text for each item that prints in your calendar.    If you need other 
information about calendars, see the topic Calendars.
To format text in a calendar:
1. From the Format menu, select Text Font, Style, & Size (ALT, T, T).

Family Tree Maker displays the Text Font, Style, & Size dialog box.
2. In the Items to format list, click an item that you want to format, such as Month 

names.
Each of the formatting options is described below.    The "Sample" field shows what your 
choices will look like.
Font    Use this field to select a font for that item.    
Size    Use this field to select a point size for that item.    
Style    Use this field to select a text style, such as bold or italics, for that item.    
Color    Use this field to select a color for that item.

3. Click OK when you've made your selections.    
Family Tree Maker returns you to the Calendar view.



Selecting border and line styles for calendars
A border is a design that Family Tree Maker draws around your entire calendar.    The fill 
color appears inside the box for each day and the background color surrounds the entire 
month.    If you need other information about calendars, see the topic Calendars.
To change border, background, or fill colors on your calendar:
1. From the Format menu, select Box, Line, & Border Styles (ALT, T, B).

Family Tree Maker displays the Box, Line, & Border Styles dialog box. 
Box & Line Style    Click one of the buttons to choose a line style for the boxes in your 
calendar.    
Border Style    Click one of the buttons to choose a border style for your calendar.
Line color    Click the arrow next to this field to see a list of colors.    Click one of the 
colors to change the color of the lines in your calendar.
Fill color    Click the arrow next to this field to see a list of colors.    Click one of the colors
to fill your calendars boxes with a color.
Border color    Click the arrow next to this field to see a list of colors.    Click one of the 
colors to change your calendars border color.
Background color    Click the arrow next to this field to see a list of colors.    Click one of 
the colors to change your calendars background color.

2. Click OK when you've made your selections.
Family Tree Maker returns you to the Calendar view.



Adding a subtitle and footnote to a calendar
In calendars, the month automatically prints as a title, but you can add a subtitle and 
footnote.    The footnote will appear in the lower right corner of the page.    If you need other
information about calendars, see the topic Calendars.
To add a subtitle or footnote:
1. From the Contents menu, select Title & Footnote (ALT, C, T).

Family Tree Maker displays the Title & Footnote dialog box.    
Subtitle  If you wish to have a subtitle in your calendar, type one in this field.
Footnote    Use this field to include a footnote in your calendar.        
Draw box around footnote    Select this check box to draw a box around your footnote.

2. Click OK when you're done creating your title and footnote. 
Family Tree Maker returns you to the Calendar view.



Printing calendars
When you have finished creating your calendar, you're ready to print.    If you need other 
information about calendars, see the topic Calendars.
To print your calendar:
1. Make sure you're in the Calendar view.
2. Turn your printer on.
3. From the File menu, select Print Calendar (ALT, F, P).

Family Tree Maker displays the Print dialog box where you can select printing options. 
Note:    You can also control items such as paper orientation, paper size, margins, and 
which printer prints your calendar.    To change any of these items, see the topic "Print 
setup."

Print range    To print all of the pages, select the All option button.    To print a range of 
pages, type the number of the first page in the From field and the number of the last 
page in the To field.    To print only one page, type the number in both the From and To 
fields.
Print quality    The higher the print quality you choose, the darker and sharper your 
printed materials will be.    If your printer does not support different print qualities, this 
option will not be available to you.
Print color    If you have a color printer, select this check box to print text in color or in 
black, white, and gray if you don't have a color printer.
Copies In this field, type the number of copies that you want to print.
Collate copies    Select this check box if you are printing multiple copies of a calendar 
and want to print complete sets.    De-select this check box if you want multiple copies of 
the first page, multiple copies of the second page, and so on.
Print to file    If you want to print your calendar to a file and send it to your printer at a 
later time, select this check box.    This option is useful if you want to print on a printer 
owned by someone who doesn't have Family Tree Maker.    When you print, you will need 
to provide an output file name.    

Note:    If you intend to print the file on a printer other than your own, make sure you 
change the settings in the Print Setup dialog box to match the printer you will be using. 

Print empty    Select this check box to print an empty calendar.
4. Click OK when you've made your selections.    

Family Tree Maker prints your calendar.
See Also
Print setup



Printing calendars with pictures
Using your Scrapbook images, you can print a year-long calendar with pictures 
accompanying each month.    You'll start by printing a complete calendar for the year and 
then make printouts of the twelve different Scrapbook images you'd like to feature.    
To start making the calendar, search through your Family Tree Maker Scrapbook files and 
select one image to show alongside each month.    Choose images which reflect the 
seasonal and holiday themes of that month or which feature an individual or family who is 
celebrating a special occasion that month.    If you'd like to have two or more pictures 
featured in a particular month, make a note of which images to include in that combination.
Then, when you reach step 6 below, follow the special instructions in the note.
1. First, customize and print a calendar with your choice of fonts, borders, and colors.    

For more information about printing calendars, see the topic "Calendars." 
Next, you'll print each one of your images using the same color and font scheme that 
you used for the calendar.    Start here with your picture for January.

2. Go to the Scrapbook page containing a picture you would like to feature.
3. From the File menu, select Print Preview (ALT, F, V).    

Family Tree Maker will take a few seconds to display your picture the way it will appear 
on a printed page. 

4. From the Format menu, select Scrapbook Format (ALT, T, F).
Family Tree Maker displays the Scrapbook Format dialog box.    It contains options for 
arranging several pictures on one page.    

5. Since you will probably only want one picture per page, select Custom Layout and 
click Edit.
Family Tree Maker displays the Edit dialog box. 

6. In the Edit dialog box, enter 1 in the Across field and 1 in the Down field.    
Note:    If you have selected multiple images for a particular month, enter the 
dimensions of your desired layout: for example, for a printout with two pictures side by 
side, enter 2 in the Across field and 1 in the Down field.    If you need more 
information about combining pictures from two different individuals' Scrapbooks, see 
the topic "Moving or Copying Pictures/Objects Between Scrapbooks." 

7. Click OK once you've selected the dimensions you want.
Family Tree Maker returns to the Scrapbook Format dialog box.    Custom Layout should 
still be selected.    

8. Click OK to exit the Scrapbook Format dialog box and return to Scrapbook Print 
Preview.

9. If you like, you can include a title at the top of the Scrapbook page.    The Automatic 
title "Scrapbook of," followed by the individual's name, will appear at the top of the 
page unless you change it.    To change the title, from the Contents menu select Title 
& Footnote (ALT, C, T).    Click the Custom Title option button and enter the title you 
prefer or leave it blank if you don't want a title. 

10. Click OK when you've finished creating the title.
Family Tree Maker returns you to Scrapbook Print Preview.

11. To choose captions or dates to include underneath each picture, from the Contents 
menu select Items to Include with each Picture/Object (ALT, C, I).    For each item 
you would like to include, click the item name in the list on the left and then click the 
Include button (the arrow pointing to the right) to move the item to the list on the 



right.    The items will appear on your printout in the same sequence that you add 
them to this list.

12. Click OK when you've made your selections.    
Family Tree Maker returns you to Scrapbook Print Preview.

13. Your Scrapbook page is ready to print.    Click Print at the top of the Print Preview 
screen, or from the File menu select Print Scrapbook (ALT, F, P).    
Family Tree maker displays the Print dialog box where you can select printing options.    
For a complete description of the Print dialog box, see the topic "Printing Your 
Document."

14. Click OK to print your Scrapbook page.
15. Repeat steps 2 through 14 for each of the other eleven months.
Once you have printed all twelve of your Scrapbook pages, combine them with the 
calendar pages.    You can use a wall calendar you already own as a model:    glue the 
calendar from January to the back of the picture from February, the calendar from February 
to the back of the picture from March, and so on.    Punch holes in the pages along the 
center seam, and bind all the pages together with ribbon.    If you need a sturdier calendar, 
paste each of the pages to a piece of cardboard, and bind the cardboard together at the 
seam.
See Also
Calendars
Moving or copying Pictures/Objects between Scrapbooks
Printing a Scrapbook



Kinship reports
When you look at a Kinship report, you will see four columns.    The first one lists the names 
of each of the primary individual's relatives.    The second column shows the exact 
relationship of that individual to the primary individual.    The third column shows the 
individual's Civil relationship to the primary individual, and the fourth column lists that 
person's Canon relationship to the primary individual.
Adopted children, foster children, and children of unknown status will appear in Kinship 
reports unless they are selected to be excluded.    
Displaying a Kinship report
Using a mouse with Kinship reports
Finding an individual in a Kinship report
Formatting text in Kinship reports
Adding a title and footnote to a Kinship report
Selecting borders for Kinship reports
Printing Kinship reports



Displaying a Kinship report
If you need other information about Kinship reports, see the topic Kinship reports.
To create a Kinship report: 
1. Select the primary individual for the Kinship report.    

A quick way to do this is to highlight the individual's name in the Index of Individuals and
then click OK.    

2. From the View menu, select Kinship (ALT, V, K).
Family Tree Maker displays the Kinship report.    To get a better look at the report, you can
move around using the scroll bars and arrow keys.    With the Zoom command, you can 
make the Kinship report bigger and easier to read on screen.    From the Edit menu, 
select Zoom (ALT, V, Z) and then choose a size from the dialog box.    The larger the 
percentage, the bigger your Kinship report will be on screen.    You can also use the 
Zoom In and Zoom Out buttons on the Toolbar to view your calendar at different sizes.
Note:    The Zoom command does not control how large your Kinship report will be when 
you print.
You can also control whether or not dotted lines representing page margins appear on 
the screen, from the View menu, select Show Page Lines (ALT, V, S).    If there is a check 
mark, the lines will appear on the screen, otherwise, they won't.    The lines will not 
appear on your printed documents.



Using a mouse with Kinship reports
In the Kinship view, clicking in an individual's name allows you to navigate through Family 
Tree Maker, moving to different views and making different individuals the primary 
individual.    What you do depends on whether you double-click or single-click the 
individual's name.    The table below describes each of the functions.    If you need other 
information about Kinship reports, see the topic Kinship reports.

Do this... To do this...
Click an individual's name once Select the individual in the box.    

You can now use the menus or the
Toolbar to change to any view.    
The selected individual becomes 
the primary individual

Double-click an individual's 
name

Go to the individuals Family Page 

Finding an individual in a Kinship report
You can find an individual in your Kinship report with the Kinship Quick Search feature.    
This helps you quickly find the relationship between two people.    If you need other 
information about Kinship reports, see the topic Kinship reports.
To find an individual in a Kinship report:
1. Make sure a Kinship report is on the screen.
2. In the Type name field, Start typing the last name of the individual that you want to 

find.
With each character you type, the highlight bar will get closer to the name you are 
looking for.    You can type part or all of the name, as long as it is in the same format as in
the Kinship report (Last name, First name Middle name).

When there are letters in the Type name field, pressing Esc once clears the field.    Pressing
it a second time clears the highlight bar from the Kinship report.
See Also
Displaying a Kinship report



Formatting text in Kinship reports
You can format the text in your Kinship report.    If you need other information about Kinship
reports, see the topic Kinship reports.
To format the text and title in a Kinship report:
1. From the Format menu, select Text Font, Style, & Size (ALT, T, T).

Family Tree Maker displays the Text Font, Style, & Size dialog box.
2. In the Items to format list, click an item that you want to format, such as Title.

Each of the formatting options is described below.    The "Sample" field shows what your 
choices will look like.
Font    Use this field to select a font for that item.    
Size    Use this field to select a point size for that item.    
Style    Use this field to select a text style, such as bold or italics, for that item.        
Color    Use this field to select a color for that item.

3. Click OK when you've made your selections.    
Family Tree Maker returns you to the Kinship view.



Adding a title and footnote to a Kinship report
You can add a title and footnote to Kinship reports.    The footnote will appear in the lower 
right corner of the page.    If you need other information about Kinship reports, see the topic
Kinship reports.
To add a title or footnote:
1. From the Contents menu, select Title & Footnote (ALT, C, T).

Family Tree Maker displays the Title & Footnote dialog box.    
Title  If you wish to have a title on your Kinship report, type one in this field.      With 
Kinship reports, you can select the Print title on every page check box to include the 
title on each page of your tree.
Page Number    Select the Include page number check box to place page numbers at 
the bottom of each page of your Kinship report.    Click the up and down arrows on the 
Starting number field to change the starting page number.
Footnote    Use this field to include a footnote on your Kinship report.        
Draw box around footnote    Select this check box to draw a box around your footnote.

2. Click OK when you're done creating your title and footnote. 
Family Tree Maker returns you to the Kinship view.



Selecting borders for Kinship reports
A border is a design that Family Tree Maker draws along the top and/or bottom edge of your
Kinship report.    The background fills the background of your report.    If you need other 
information about Kinship reports, see the topic Kinship reports.
To select formatting options for borders:
1. From the Format menu, select Box, Line, & Border Styles (ALT, T, B). 

Family Tree Maker displays the Line & Border Styles dialog box.    
2. Make your selections by clicking the buttons with the pictures of the borders and lines 

that you like.    Each Kinship report can only have one border style and one line style.    
3. You can also choose colors for each of these elements.    Click the arrow next to the 

color field for the element you wish to change, and then select a color from the list that
is displayed.    The colors will only print if you have a color printer.    Otherwise, the 
colors will print in shades of gray.    A "background" color is the color behind your 
kinship report.

4. Click OK when you've made your selections.    
Family Tree Maker returns you to the Kinship report view.



Printing Kinship reports
When you have finished creating your Kinship report, you're ready to print.    If you need 
other information about Kinship reports, see the topic Kinship reports.
To print your Kinship report:
1. Make sure you're in the Kinship view.
2. Turn your printer on.
3. From the File menu, select Print Kinship report (ALT, F, P).

Family Tree Maker displays the Print dialog box where you can select printing options.    
Print range    To print all of the pages, select the All option button.    To print a range of 
pages, type the number of the first page in the From field and the number of the last 
page in the To field.    To print only one page, type the number in both the From and To 
fields.
Print quality    The higher the print quality you choose, the darker and sharper your 
printed materials will be.    If your printer does not support different print qualities, this 
option will not be available to you.
Print color    If you have a color printer, select this check box to print in color.    If you 
don't have a color printer, select this check box to print in grayscale.
Copies In this field, type the number of copies that you want to print.
Collate copies    Select this check box if you are printing multiple copies of a Kinship 
report and want to print complete sets.    De-select this check box if you want multiple 
copies of the first page, multiple copies of the second page, and so on.
Print to file    If you want to print your Kinship report to a file and send it to your printer 
at a later time, select this check box.    This option is useful if you want to print on a 
printer owned by someone who doesn't have Family Tree Maker.    When you print, you 
will need to provide a name for the output file. 

Note:    If you intend to print the file on a printer other than your own, make sure the 
settings in the Print Setup dialog box match the printer you will be using.    

4. Click OK when you've made your selections.    
Family Tree Maker prints your Kinship report.



Printing information contained in the Family Page

To print the information contained in a Family Page:
1. Go to the Family Page containing the information you want to print.
2. Turn your printer on.    
3. From the File menu, select Print Family Page (ALT, F, P).

Family Tree Maker displays the Print dialog box where you can select printing options.
Print range    To print all of the pages, select the All option button.    To print a range of 
pages, type the number of the first page in the From field and the number of the last 
page in the To field.    To print only one page, type the number in both the From and To 
fields.
Print quality    The higher the print quality you choose, the darker and sharper your 
printed materials will be.    However, items printed in high print quality take longer to 
print.    If your printer does not support different print qualities, this option will not be 
available to you.
Copies In this field, type the number of copies that you want to print.
Collate copies    Select this check box if you are printing multiple copies of a Family 
Page and want to print complete sets.    De-select this check box if you want multiple 
copies of the first page, multiple copies of the second page, and so on.
Print empty    Select this check box to print an empty Family Page.

4. Click OK when you've made your selections.    
Family Tree Maker prints your Family Page information.



Custom reports
A report contains the names, birth dates, and death dates of each individual in your Family 
File.    Printing a report is a quick way to see who is included in your Family File.
Displaying a report
Using a mouse with reports
Selecting individuals to include in reports
Selecting items to include in reports
Formatting items to include in reports
Formatting text in reports
Selecting borders for reports
Adding a title and footnote to a report
Sorting reports
Printing reports



Displaying a report
If you need other information about Custom reports, see the topic Custom reports.
To create a report: 
1. From the View menu, select Report (ALT, V, R).

Family Tree Maker displays the report.    To get a better look at it, you can move around 
using the scroll bars and arrow keys.    With the Zoom command, you can make the 
report bigger and easier to read on screen.    From the Edit menu, select Zoom (ALT, V, Z) 
and then choose a size from the dialog box.    The larger the percentage, the bigger your 
report will be on screen.    You can also use the Zoom In and Zoom Out buttons on the 
Toolbar to view your calendar at different sizes.
Note:    The Zoom command does not control how large your report will be when you 
print.
You can also control whether or not dotted lines representing page margins appear on 
the screen, from the View menu, select Show Page Lines (ALT, V, S).    If there is a check 
mark, the lines will appear on the screen, otherwise, they won't.    The lines will not 
appear on your printed documents.



Using a mouse with reports
In the Report view, clicking in an individual's name allows you to navigate through Family 
Tree Maker, moving to different views and making different individuals the primary 
individual.    What you do depends on whether you double-click or single-click the 
individual's name.    The table below describes each of the functions.    If you need other 
information about Custom reports, see the topic Custom reports.

Do this... To do this...
Click an individual's name once Select the individual in the box.    

You can now use the menus or the
Toolbar to change to any view.    
The selected individual becomes 
the primary individual

Double-click an individual's 
name

Go to the individuals Family Page 

Selecting individuals to include in reports
From the Contents menu, select Individuals to Include (ALT, C, N).    In the Include dialog 
box, choose Selected individuals and then click Individuals to Include to create a new 
group of individuals.    Family Tree Maker displays the Individuals to Include dialog box.    In 
this dialog box you can create a group of individuals to print.    If you later decide that you 
want to print all individuals in your Family File, go back to the Include dialog box and 
choose All individuals instead of Selected individuals.    
The Individuals to Include dialog box contains two lists.    The list on the right shows the 
group of individuals who will be printed.    The scrolling list on the left shows which 
individuals you can add to the group.    The individuals in the list on the left are in 
alphabetical order by last name.    Nicknames (aka's) are not included on the same line as 
given names.    To locate an individual in the list on the left quickly, click in the Name field 
at the top of the list and type the individual's name in the following format:    Last name, 
First name Middle name.    With each character you type, you will get closer to the name 
you are looking for.
You create a group of individuals to print by selecting individuals and adding them to or 
removing them from the list on the right.    You can add and remove individuals in three 
ways:    using the "Include" and "Remove" buttons, using the "Include All" and "Remove All" 
buttons, and using the "Find and Include" and "Find and Remove" buttons.    The table 
below summarizes how each of these buttons work.    Each of these methods is described 
below in more detail.

Use this button... To do this...
"Include" or "Remove" Include or remove individuals one-

by-one.
"Include All" or "Remove All" Include all of the individuals 

currently in your Family File or 
remove all of the individuals 
currently in the group.

"Find and Include" or "Find and Choose categories of individuals 



Remove" to include or remove all at once.

You can use any combination of these methods to create your group.    When you're done 
creating the group, click OK.    Family Tree Maker will return you to the Report view.
Note: There is one Individuals to Include dialog box for all views in Family Tree 
Maker.    The group of individuals that you create in one view, such as Custom reports, is 
available to you in the other views that allow you to choose groups:    Labels/Cards and 
Batch print.    Even if you quit Family Tree Maker, the group that you create in the 
Individuals to Include dialog box will remain the same until you change it again.    Of 
course, if you make changes to the group in one view, such as the Report view, the group
will change in all other views as well.
In general, you do not need to worry about the order in which you add individuals because 
Family Tree Maker can sort them for you later.    The sorting orders include "Last name (A 
first)," "Last name (Z first)," "Birth date (oldest first)," and "Birth date (youngest first)."    If 
you want individuals in an order other than those offered in the Sort dialog box, you need 
to add them to the list on the right in that order.    Then, in the Sort dialog box, select the 
Don't sort individuals option button.

Using the "Include" and "Remove" Buttons
With the "Include" and "Remove" buttons you can add and remove individuals to and from 
the group one at a time.    
To create a group using the "Include" and "Remove" buttons:
1. If you want to add an individual to the group, click his or her name in the list on the 

left.    If you want to remove an individual from the group, click his or her name in the 
list on the right.

2. Click either the Include button (the arrow pointing to the right) or the Remove button 
(the arrow pointing to the left).    

 
If you chose to add the individual, his or her name is added to the list on the right and the 
"Number included" increases by one.    If you chose to remove the individual, his or her name
is removed from the list on the right, and the "Number included" decreases by one.
Instead of selecting an individual and then clicking "Include" or "Remove," you can just 
double-click the individual's name.    Double-clicking names in the list of the left 
automatically adds them to the group.    Double-clicking names in the list on the right 
automatically removes them from the group.

Using the "Include All" and "Remove All" Buttons
With the "Include All" button, one click adds all of the individuals currently in your Family 
File to the group.    With the "Remove All" button, one click removes all of the individuals 
from the group.    
The best time to use the "Include All" button is when you want to create a group that 
includes almost all of the individuals that are currently in your Family File.    For example, if 
there are only a few people that you don't want to include in the group, click the Include 
All button (the double arrows pointing to the right) to move all of the individuals to the list 
on the right.    Then use the Remove button (the arrow pointing to the left) to remove the 
few individuals that you don't want in the group.    This is much faster than including all of 
the individuals one by one.    
If you want to include all of the individuals in your Family File, don't use the "Include All" 
button.    Instead, from the Contents menu, select Individuals to Include.    Then, in the 
Include dialog box, select All Individuals.    This way, individuals that you add to your 



Family File later will be included automatically.    If you use the "Include All" button to 
include everyone, individuals that are added to your Family File later will not be added to 
the group automatically.
The best time to use the "Remove All" button is when you already have several individuals 
in the group and you want to start over.    Click the Remove All button (the double arrows 
pointing to the left) to remove all of the individuals from the group.    Then use the Include 
button (the arrow pointing to the right) to begin adding individuals to the group again.    

Using the "Find and Include" and "Find and Remove" Buttons
With the "Find and Include" and "Find and Remove" buttons, Family Tree Maker will search 
your Family File for individuals, such as those who were born before a certain date or those 
who are ancestors of a particular individual, and add them to the group or remove them 
from the group.
To create a group using the "Find and Include" and "Find and Remove" buttons:
1. Decide which individuals you want to add to or remove from the group.    For example, 

do you want to add all of your ancestors?    Do you want to add all of the individuals 
who were born in a particular town?    Do you want to remove all of the individuals who 
were born before a particular date?    
If you want to add or remove a group of individuals that are ancestors or descendants of 
a particular individual, make sure to highlight the name of that individual in the list on 
the left before moving on to step 2.    For example, if you wanted to add all of your 
ancestors, you would highlight your name.    

2. Click either the Find and Include ("Find" with the arrow pointing to the right) or Find 
and Remove button ("Find" with the arrow pointing to the left).    
Family Tree Maker displays either the Add Individuals or Remove Individuals dialog box.    
In this dialog box you specify which individuals you want Family Tree Maker to find and 
add to the group or remove from the group.

3. Click in the Search field.    
If you want to find individuals who are all ancestors or descendants of a particular 
individual, choose either "Ancestors," or "Descendants," from the drop-down list (you 
may have to scroll upwards to do this).    Family Tree Maker automatically fills the "of" 
field with the name of the individual that was highlighted in step 1.    Skip to step 5.    
If you want to find individuals who have information in common, such as a birth location, 
use the drop-down list to choose the name of the field that contains that information.    
For example, if you want to find all individuals who were born in a particular place, you 
would select "Birth location."    When you've selected a field, go to step 4.

4. In the for field, type the information that you want to search for.    If the field that you 
are searching only has certain legal values (such as "male," "female," and "unknown"), 
then a drop-down list may be displayed in the "for" field.    Just choose the item you 
want to search for.
For example, if you chose "Birth location" in step 3, and you wanted Family Tree Maker to
find everyone that was born in Cleveland, Ohio, then you would type    Cleveland, Ohio  
in the "for" field.    

5. Click OK.    
Family Tree Maker searches through your Family File for individuals who match your 
request.    If no matches are found, Family Tree Maker tells you so.    If you chose to add 
the individuals, their names are added to the list on the right and the "Number included" 
increases.    If you chose to remove the individuals, their names are removed from the list
on the right, and the "Number included" decreases.





Selecting information to include in reports
You can select which information you want to include in your Custom reports.    If you need 
other information about Custom reports, see the topic Custom reports.
In Custom Reports, the items that you choose appear in columns, from right to left.    Select 
the item that you want in the leftmost column first.    For example, you would choose Name
first if you wanted each individuals name to be the leftmost column.    You would choose 
Death date last if you wanted this information to appear in the rightmost column.    You 
can include up to one hundred items per report, limited by paper size, however.
From the Contents menu, select Items to Include (ALT, C, I).    Family Tree Maker displays 
the Items to Include dialog box.    It contains two lists.    The list on the right shows which 
items will be included in your report.    The scrolling list on the left shows which items you 
can add to the report.    There is a default group of items that are already included.    
However, you can add and delete items to and from the list on the right as often as you 
like.    When you're done selecting information, click OK.    Family Tree Maker will return you 
to the Report view.
To add items to or remove items from a report: 
1. Click the name of the item in the list on the left if you want to add the item.    Click the 

name of the item in the list on the right if you want to remove the item.
2. Click either the Include button (the arrow pointing to the right) or the Remove button 

(the arrow pointing to the left). 
 

If you chose to add the item, it is added to the list on the right.    If you chose to remove the 
item, it is removed from the list on the right.
Instead of selecting an item and then clicking "Include" or "Remove," you can just double-
click the item's name.    Double-clicking items in the list on the left automatically adds them. 
Double-clicking items in the list on the right automatically removes them.    In addition, if you
want to delete all items from the list on the right, just click the Remove all button (the 
double arrow pointing to the left). 
With Custom reports, you need to make formatting choices for names.    Family Tree Maker 
automatically displays a dialog box that asks you to make a formatting choice when it is 
necessary.    For more information, see the topic "Formatting items to include."    You can also 
format the text that appears in your report.    See the topic "Formatting text in a report."
See Also
Formatting items to include in reports
Formatting text in reports



Formatting items to include in reports
In Custom reports, you can only format names.    For all other items, Family Tree Maker 
automatically chooses the format that is best for the report.    If you need other information 
about Custom reports, see the topic Custom reports.
When you choose to include names, aka's, or spouses in your Custom report, Family Tree 
Maker displays the Options: Name dialog box.    In this dialog box, you can choose the 
format in which the names print in your report.    When you've made your formatting 
selections, click OK.    
To change the formatting of an item that's already in the list on the right side 
of the Items to Include dialog box: 
1. From the Contents menu, select Items to Include (ALT, C, I).    

Family Tree Maker displays the Items to Include dialog box.    It contains two lists.      
2. Select the item in the list on the right by clicking it.

Family Tree Maker highlights the item.
3. Click Options.

Family Tree Maker displays an Options dialog box.    
Note:    If you select an item in the scrolling list on the right, and Options remains 
grayed out, that item does not have any formatting options.

4. Make your formatting selections, then click OK.
When you have finished formatting and items to include on your labels or cards, click OK
in the Items to Include dialog box.    Family Tree Maker returns you to the Report view.



Formatting text in reports
You can format the text in your Custom report.    If you need other information about 
Custom reports, see the topic Custom reports.
To format the text and title in a report:
1. From the Format menu, select Text Font, Style, & Size.(ALT, T, T)

Family Tree Maker displays the Text Font, Style, & Size dialog box.
2. In the Items to format list, click an item that you want to format, such as "Title."

Each of the formatting options is described below.    The "Sample" field shows what your 
choices will look like.
Font    Use this field to select a font for that item.    
Size    Use this field to select a point size for that item.    
Style    Use this field to select a text style, such as bold or italics, for that item.        
Color    Use this field to select a color for that item.

3. Click OK when you've made your selections.    
Family Tree Maker returns you to the Report view.



Adding a title and footnote to a report
With reports you can add a title and footnote.    The footnote will appear in the lower right 
corner of the page.    If you need other information about Custom reports, see the topic 
Custom reports.
To add a title or footnote:
1. From the Contents menu, select Title & Footnote (ALT, C, T).

Family Tree Maker displays the Title & Footnote dialog box.    
Title  If you wish to have a title on your Report, type one in this field.      Select the Print 
title on every page check box to include the title on each page of your tree.
Page Number    Select the Include page number check box to place page numbers at 
the bottom of each page of your Report.    Click the up and down arrows on the Starting 
number field to change the starting page number.
Footnote    Use this field to include a footnote on your Custom report.        
Draw box around footnote    Select this check box to draw a box around your footnote.

2. Click OK when you're done creating your title and footnote. 
Family Tree Maker returns you to the Report view.



Selecting borders for reports
A border is a design that Family Tree Maker draws along the top and/or bottom edge of your
report.    The background fills the background of your report.    If you need other information 
about Custom reports, see the topic Custom reports.
To select formatting options for lines and borders:
1. From the Format menu, select Box, Line, & Border Styles (ALT, T, B). 

Family Tree Maker displays the Line & Border Styles dialog box.    
2. Make your selections by clicking the buttons with the pictures of the borders and lines 

that you like.    Each report can only have one border style and one line style.    
3. You can also choose colors for each of these elements.    Click the arrow next to the 

color field for the element you wish to change, and then select a color from the list that
is displayed.    The colors will only print if you have a color printer.    Otherwise, the 
colors will print in shades of gray. 

4. Click OK when you've made your selections.    
Family Tree Maker returns you to the Report view.



Sorting reports
When you print Custom reports, you can select the order in which the names print.    If you 
need other information about Custom reports, see the topic Custom reports.
To select a sorting order:
1. From the Format menu, select Sort (ALT, T, S).

Family Tree Maker displays the Sort dialog box.
2. Click the option button for the type of sorting you prefer.

If you want the individuals to print in the order in which you added them to the group in 
the Individuals to Include dialog box, select Don't Sort Individuals.    This is especially 
useful for printing individuals in an Ancestor or Descendant order. 

3. Click OK when you've made your selection.
Family Tree Maker returns you to the Report view.



Printing reports
When you have finished creating your report, you're ready to print.    If you need other 
information about Custom reports, see the topic Custom reports.
To print your report:
1. Make sure you're in the Report view.
2. Turn your printer on.
3. From the File menu, select Print Report (ALT, F, P).

Family Tree Maker displays the Print dialog box where you can select printing options.    
Print range    To print all of the pages, select the All option button.    To print a range of 
pages, type the number of the first page in the From field and the number of the last 
page in the To field.    To print only one page, type the number in both the From and To 
fields.
Print quality    The higher the print quality you choose, the darker and sharper your 
printed materials will be.    If your printer does not support different print qualities, this 
option will not be available to you.
Print color    If you have a color printer, select this check box to print in color.    If you do 
not have color printer, select this check box to print in grayscale.
Copies    In this field, type the number of copies that you want to print.
Collate copies    Select this check box if you are printing multiple copies of a report and 
want to print complete sets.    De-select this check box if you want multiple copies of the 
first page, multiple copies of the second page, and so on.
Print to file    If you want to print your report to a file and send it to your printer at a 
later time, select this check box.    This option is useful if you want to print on a printer 
owned by someone who doesn't have Family Tree Maker.    When you print, you will need 
to provide a name for the output file. 

Note:    If you intend to print the file on a printer other than your own, make sure the 
settings in the Print Setup dialog box match the printer you will be using.    

4. Click OK when you've made your selections.
Family Tree Maker prints your report.



Scrapbooks
Printed Scrapbook pages are great documents to add to family books or other collections of
printed family information.    You can print Scrapbook pages with as many or as few 
Pictures/Objects per page as you like.    To personalize them, you can add a title and 
decorative borders, too.
Selecting items to include in Scrapbooks
Formatting text in Scrapbooks
Adding a title and page numbers to a Scrapbook
Selecting styles for boxes, borders, and lines in Scrapbooks
Selecting the Scrapbook page layout
Selecting which Pictures/Objects to print
Sorting Scrapbooks
Printing Scrapbooks



Displaying Scrapbooks for printing
If all of the Pictures/Objects that you want to print are not in the Scrapbook yet, open it 
using the instructions in the topic "Opening Scrapbooks."    If you do not need to place new 
Pictures/Objects into the Scrapbook before you print, use the instructions below to open the
Scrapbook.
To display an individual's or a marriage's Scrapbook for printing:
1. Go to the Family Page containing the individual or the marriage whose Scrapbook you 

want to print.
Use the Index of Individuals or Find Individual to find an individual's Family Page.    

2. On the Family Page, place the cursor either on the name of the individual or on the 
marriage whose Scrapbook you want to print.

3. From the View menu, select Scrapbook (ALT, V, S).
Family Tree Maker displays the individual's or marriage's Scrapbook.    

4. From the File menu, select Print Preview (ALT, F, V).
Family Tree Maker changes to Scrapbook Print Preview.    You must be in Scrapbook Print 
Preview to use most of the Scrapbook formatting commands on the Contents and 
Format menus.    However, you will not be able to insert new items into the Scrapbook.    
To insert new items, you must be in the Scrapbook view, not in Scrapbook Print Preview.
You can move around in your Scrapbook with the scroll bars and arrow keys.    You can 
also use the Zoom command to enlarge it on the screen.    From the Edit menu, select 
Zoom (ALT, E, Z) and then choose a size from the dialog box.    The larger the percentage, 
the bigger your Scrapbook will be on screen.    You can also use the Zoom In and Zoom 
Out buttons on the Toolbar to view your Scrapbook at different sizes.
Note:    The Zoom command does not control how large your Scrapbook will be when you
print.
To control whether or not dotted lines representing page margins appear on the screen, 
from the View menu, select Show Page Lines (ALT, V, S).    If there is a check mark, the 
lines will appear on the screen, otherwise, they won't.    The lines will not appear on your 
printed documents.

5. You can either print your Scrapbook right away or customize it and then print.
To change the print setup, click Print Setup.    To print the Scrapbook, click Print.    If you
want to leave Scrapbook Print Preview, click Scrapbook.    Family Tree Maker will return 
you to the Scrapbook view.

See Also
Opening Scrapbooks



Selecting items to include in Scrapbooks
The items you can include on a printed Scrapbook include the caption, the description, the 
date, and more.    However, the more information you include, the smaller the 
Pictures/Objects will be.    In addition, if you choose to include more items than can fit on 
each Scrapbook page, Family Tree Maker simply will not print those items that do not fit, 
starting with the last item you choose.    If you need other information about printing 
Scrapbooks, see the topic Scrapbooks.
The items that you choose to include will be printed in "blocks."    For example, if you chose 
to include "Picture/Object" and "Picture/Object Caption," each Picture/Object would print 
with its caption directly beneath it.
From the Contents menu, select Items to Include (ALT, C, I).    (You must first be in 
Scrapbook Print Preview.)    Family Tree Maker displays the Items to Include dialog box.    It 
contains two lists.    The list on the right shows which items will be included in your printed 
Scrapbook.    The scrolling list on the left shows which items you can add to the printed 
Scrapbook.    There is a default group of items that are already included.    However, you can
add and delete items to and from the list on the right as often as you like.    When you're 
done selecting information, click OK.    Family Tree Maker will return you to Scrapbook Print 
Preview.
To add items to or remove items from a printed Scrapbook: 
1. Click the name of the item in the list on the left if you want to add the item.    Click the 

name of the item in the list on the right if you want to remove the item.
2. Click either the Include button (the arrow pointing to the right) or the Remove button 

(the arrow pointing to the left). 
 

If you chose to add the item, it is added to the list on the right.    If you chose to remove the 
item, it is removed from the list on the right.
Instead of selecting an item and then clicking "Include" or "Remove," you can just double-
click the item's name.    Double-clicking items in the list on the left automatically adds them. 
Double-clicking items in the list on the right automatically removes them.    In addition, if you
want to delete all items from the list on the right, just click the Remove all button (the 
double arrow pointing to the left). 
You can also format the text that appears in your report.    See the topic "Formatting text in 
Scrapbooks."
See Also
Formatting text in Scrapbooks



Formatting text in Scrapbooks
You can format the text in your Scrapbook report.    If you need other information about 
printing Scrapbooks, see the topic Scrapbooks.
To format the text and title in a Scrapbook:
1. From the Format menu, select Text Font, Style, & Size (ALT, T, F).    (You must first be 

in Scrapbook Print Preview.)
Family Tree Maker displays the Text Font, Style, & Size dialog box.

2. In the Items to format list, click an item that you want to format, such as Title.
Each of the formatting options is described below.    The "Sample" field shows what your 
choices will look like.
Font    Use this field to select a font for that item.    
Size    Use this field to select a point size for that item.    
Style    Use this field to select a text style, such as bold or italics, for that item.        
Alignment    Click the arrow next to this field to display a list of text alignments, such as 
"Centered."    When the list of possible alignments appears, click the alignment that you 
want for that item. 
Color    Use this field to select a color for that item.

3. Click OK when you've made your selections.    
Family Tree Maker returns you to Scrapbook Print Preview.



Selecting styles for boxes, borders, and lines in Scrapbooks
With Scrapbooks, you can select a border style, a box style, and a line style.    The border is 
drawn around the outside edge of each page and the boxes are drawn around each 
Picture/Object.    The border color that you select will be the color with which the border is 
drawn and the background color will cover the entire background of each Scrapbook page.   
The line color that you select will be the color with which the boxes are drawn around each 
Picture/Object, and the fill color will be inside each box.    If you need other information 
about printing Scrapbooks, see the topic Scrapbooks.
To select these formatting options:
1. From the Format menu, select Box, Line, & Border Styles (ALT, T, B).    (You must first 

be in Scrapbook Print Preview.)
Family Tree Maker displays the Box, Line, & Border Styles dialog box. 

2. Make your selections by clicking the buttons with the styles that you like.    
You may only choose one style for each element.    For example you can only choose one 
border style per document.

3. You can also select colors for various parts of your Scrapbook.    Click the arrow next to 
the color field for the element you wish to change and then select a color from the list 
that is displayed.    The colors will only print if you have a color printer, otherwise they 
will print in grayscale.

4. Click OK when you've made your selections.    
Family Tree Maker returns you to Scrapbook Print Preview.



Adding a title and page numbers to a Scrapbook
With Scrapbooks you can add a title and page numbers.    If you need other information 
about printing Scrapbooks, see the topic Scrapbooks.
To add a title or page numbers:
1. From the Contents menu, select Title & Footnote (ALT, C, T).    (You must first be in 

Print Preview.)
Family Tree Maker displays the Title & Footnote dialog box.    
Title    Select the Automatic title option button if you want Family Tree Maker to create 
a title for you.    If you want to create your own title, select the Custom title option 
button and type your title in the field provided.    If you would like the title to print on 
every page, select the Print title on every page check box.
Page number    Select the Include page number check box to include page numbers 
on your Scrapbook pages.    To set the starting page number, type the number for the 
first page in the Starting number field.

2. Click OK when you're done creating your title and footnote. 
Family Tree Maker returns you to Scrapbook Print Preview.



Selecting the Scrapbook page layout
The "layout" refers to the placement of each Picture/Object on a Scrapbook page.    If you 
need other information about printing Scrapbooks, see the topic Scrapbooks.
To choose the Scrapbook page layout:
1. From the Format menu, select Scrapbook Format (ALT, T, F).    (You must first be in 

Scrapbook Print Preview.)
Family Tree Maker displays the Format for Printed Scrapbook dialog box.    

2 Click the button that shows the layout of Pictures/Objects that you want on your 
Scrapbook pages.    
If you want to create your own special Scrapbook page layout, click Edit.    In the Custom
Layout dialog box that Family Tree Maker displays, enter the number of Pictures/Objects 
you want across and down each page.    You can choose from 1 to 50.    Remember, 
however, the more Pictures/Objects on each page, the smaller they will be.    Click OK to 
return to the Format for Printed Scrapbook dialog box.

3 Click OK when you've made your selection.    
Family Tree Maker returns you to the Scrapbook Print Preview.



Selecting which Pictures/Objects to print
Scrapbooks have other important printing options.    To display the dialog box where you 
choose special printing options, from the Contents menu, select Options (ALT, P, O).    (You 
must first be in Print Preview.)    These options are described below.    If you need other 
information about printing Scrapbooks, see the topic Scrapbooks.
When you print Scrapbook pages, Family Tree Maker does not print every single item in an 
individual's or marriage's Scrapbook.    Instead, only the Pictures/Objects that are marked to
include in printed Scrapbooks will print.    However, the default is to include all 
Pictures/Objects.    If there are some Pictures/Objects that you wish to exclude from the 
printed Scrapbook pages, such as sound clips, you can indicate this in the More about 
Picture/Object dialog boxes for those Pictures/Objects.    In the Options for Printed 
Scrapbook dialog box, you can further control which Pictures/Objects print on the 
Scrapbook pages.    
If you wish to print all Pictures/Objects that are marked for printing, select the All option 
button.    Alternatively, you can choose to include Pictures/Objects of a particular category 
and type.    Categories are classifications that you create.    For example, you could create a
"Birthday" category in which to place birthday pictures.    Or, you could create a "Child 
Portrait" category in which to place portraits that were taken when the individuals were 
young.    
Types are chosen from a drop-down list in the More About Picture/Object dialog box.    They 
describe what Pictures/Objects are, such as "Pictures" or "Sound Clips."    Categories and 
types are assigned to each Picture/Object in the More About Picture/Object dialog box.    
The By Category and and Type fields work together to find the Pictures/Objects that you 
want to place in your Scrapbook.    For example, if you choose the category "Birthdays" and 
the type "Picture," Family Tree Maker searches for Pictures/Objects that fulfill both 
requirements.    However, both of the fields have an "Any" option, which, in effect, allows 
you to search only one of the two fields.    If the category that you assigned to a 
Picture/Object does not appear in the "By Category" drop-down list, just type it into the 
field.    



Sorting Scrapbooks
You can select the order in which Pictures/Objects are arranged in Scrapbooks.    Please 
note, however, that when you choose a sorting order in Scrapbooks, it only affects the 
Scrapbook that is currently open.    If you need other information about printing Scrapbooks,
see the topic Scrapbooks.
To select a sorting order:
1. From the Format menu, select Sort (ALT, T, S).

Family Tree Maker displays the Sort dialog box.
2. Click the option button for the type of sorting you prefer.
3. Click OK when you've made your selection.

Family Tree Maker returns you to the Scrapbook view.



Printing Scrapbooks
When you have finished creating your Scrapbook, you're ready to print.    If you need other 
information about printing Scrapbooks, see the topic Scrapbooks.
To print your Scrapbook:
1. Make sure you're in the Scrapbook view or in Scrapbook Print Preview.
2. Turn your printer on.
3. From the File menu, select Print (ALT, F, P).

Family Tree Maker displays the Print dialog box where you can select printing options.    
Print range    To print all of the pages, select the All option button.    To print a range of 
pages, type the number of the first page in the From field and the number of the last 
page in the To field.    To print only one page, type the number in both the From and To 
fields.
Print quality    The higher the print quality you choose, the darker and sharper your 
printed materials will be.    If your printer does not support different print qualities, this 
option will not be available to you.
Print color    If you have a color printer, select this check box to print text in color.    If 
you don't have a color printer, select this check box to print in grayscale.
Copies    In this field, type the number of copies that you want to print.
Collate copies    Select this check box if you are printing multiple copies of a Scrapbook 
and want to print complete sets.    De-select this check box if you want multiple copies of 
the first page, multiple copies of the second page, and so on.
Print to file    If you want to print your report to a file and send it to your printer at a 
later time, select this check box.    This option is useful if you want to print on a printer 
owned by someone who doesn't have Family Tree Maker.    When you print, you will need 
to provide a name for the output file. 

Note:    If you intend to print the file on a printer other than your own, make sure the 
settings in the Print Setup dialog box match the printer you will be using.    

4. Click OK when you've made your selections.    
Family Tree Maker prints your Scrapbook.



Printing information contained in the More About dialog boxes

To print the information contained in your More About dialog boxes:
1. From the Family Page of the individual whose More About information you want to print,

click More About.
Family Tree Maker displays one of the More About dialog boxes.
If you are on an individual's Notes dialog box, you can only print that individual's Notes.    
If you go to any of the other More About dialog boxes, you can print the information 
contained in all of the dialog boxes except Notes.

2. Turn your printer on.
3. From the File menu, select Print (ALT, F, P). 

Family Tree Maker displays the Print dialog box where you can select printing options.    
Print range    To print all of the pages, select the All option button.    To print a range of 
pages, type the number of the first page in the From field and the number of the last 
page in the To field.    To print only one page, type the number in both the From and To 
fields.
Print quality    The higher the print quality you choose, the darker and sharper your 
printed materials will be.    If your printer does not support different print qualities, this 
option will not be available to you.
Copies In this field, type the number of copies that you want to print.
Collate copies    Select this check box if you are printing multiple copies of the More 
About dialog boxes and want to print complete sets.    De-select this check box if you 
want multiple copies of the first page, multiple copies of the second page, and so on.

4. Click OK when you've made your selections.    
Family Tree Maker prints your More About information.



Batch printing
When you want to print a lot of information, Family Tree Maker gives you a convenient way 
to produce and organize it.    The Batch Print command lets you specify what document you 
want to print and also provides page numbering functions to help you keep track of the 
information that you print.    Batch printing is available for Family Group Sheets, Notes 
dialog boxes, and Scrapbooks.
Here are the basic steps to start a batch print:
1. Choose what type of document you want to print.
2. Choose the individuals you want to print the documents for.
3. Specify the print settings.
4. Tell Family Tree Maker to print the documents.
To find out the details about each of these steps, read the topics below in the order in which
they are listed.
See Also
Selecting and setting up the document type
Selecting individuals to print
Selecting print settings
Special uses for Batch printing



Selecting and setting up the document type
With batch printing, you first need to decide what document you want to print.
To select and set up a document for batch printing:
1. Go to the document that you want to print.

To print Family Group Sheets, from the View menu, select Family Group Sheet (ALT, V, 
G). 
To print Notes for individuals or for marriages, place the cursor on either the individual or
the marriage on a Family Page.    Then from the View menu, select More About (ALT, V, 
M).    From the submenu, select Notes (N).
To print Scrapbooks for individuals or for marriages, place the cursor on either the 
individual or the marriage.    Then from the View menu, select Scrapbook (ALT, V, S).    

2. Use the commands on the Contents and Format menus to set up the document for 
printing.    
For example, use the Items to Include command to choose which items you want to 
include in all of the documents.    You also might want to format the text in the 
documents using the Text Font, Style, & Size command.    

3. At this time, you may also want to check your print setup, which controls items such as
paper orientation, paper size, and margins.    If you want to change any of these items, 
see the topic "Print Setup."

See Also
Print Setup



Selecting individuals to print
After you've chosen the type of document you want to print, you're ready to select a 
printing order and choose individuals to print.    If you need other information about Batch 
printing, see the topic Batch printing.
From the File menu, select Batch Print (ALT, F, A).    Family Tree Maker displays the 
Individuals to Include dialog box.    In this dialog box you can create a group of individuals to
include in the batch print.    However, you first need to select a printing order. 
To select a printing order:
1. Click Sort order.

Family Tree Maker displays the Sort Batch Print dialog box.
2. Click the option button for the type of sorting you prefer.

If you want individuals to print in the order in which you will choose them in the 
Individuals to Include dialog box, select Don't sort individuals in this dialog box.

3. Click OK when you've made your selection.
Family Tree Maker returns you to the Individuals to Include dialog box.    Now you can 
choose the individuals to print.

The Individuals to Include dialog box contains two lists.    The list on the right shows the 
group of individuals for whom your documents will be printed.    The scrolling list on the left 
shows which individuals you can add to the group.    
The individuals in the list on the left are in alphabetical order by last name.    Nicknames 
(aka's) are not included on the same line as given names.    To quickly locate an individual 
in the list on the left, click in the Name field and type their name in the following format:    
Last name, First name Middle name.    With each character you type, you will get closer to 
the name you are looking for.
You create a group of individuals to print by selecting individuals and adding them to or 
removing them from the list on the right.    You can add and remove individuals in three 
ways:    using the "Include" and "Remove" buttons, using the "Include All" and "Remove All" 
buttons, and using the "Find and Include" and "Find and Remove" buttons.    The table 
below summarizes how each of these buttons work.    Each of these methods is described in
more detail below the table.

Use this button... To do this...
"Include" or "Remove" Include or remove individuals one-

by-one.
"Include All" or "Remove All" Include all of the individuals 

currently in your Family File or 
remove all of the individuals 
currently in the group.

"Find and Include" or "Find and 
Remove" 

Choose categories of individuals 
to include or remove all at once.

You can use any combination of these methods to create your group.    When you're done 
creating the group, click OK.    Family Tree Maker will return you to the document view.
Note: There is one Individuals to Include dialog box for all views in Family Tree 
Maker.    The group of individuals that you create in one view, such as Labels/Cards, is 
available to you in the other views that allow you to choose groups:    Reports and Batch 



Print.    Even if you quit Family Tree Maker, the group that you create in the Individuals to 
Include dialog box will remain the same until you change it again.    Of course, if you make
changes to the group in one view, such as the Report view, the group will change in all 
other views as well.

Using the "Include" and "Remove" buttons
With the "Include" and "Remove" buttons you can add and remove individuals to and from 
the group one at a time.    
To create a group using the "Include" and "Remove" buttons:
1. If you want to add an individual to the group, click his or her name in the list on the 

left.    If you want to remove an individual from the group, click his or her name in the 
list on the right.

2. Click either the Include button (the arrow pointing to the right) or the Remove button 
(the arrow pointing to the left). 

 
If you chose to add the individual, his or her name is added to the list on the right and the 
"Number included" increases by one.    If you chose to remove the individual, his or her name
is removed from the list on the right, and the "Number included" decreases by one.

Instead of selecting an individual and then clicking "Include" or "Remove," you can just 
double-click the individual's name.    Double-clicking names in the list on the left 
automatically adds them to the group.    Double-clicking names in the list on the right 
automatically removes them from the group.

Using the "Include All" and "Remove All" Buttons
With the "Include All" button, one click adds all of the individuals currently in your Family 
File to the group.    With the "Remove All" button, one click removes all of the individuals 
from the group.    
The best time to use the "Include All" button is when you want to create a group that 
includes almost all of the individuals that are currently in your Family File.    For example, if 
there are only a few people that you don't want to include in the group, click the Include 
All button (the double arrows pointing to the right) to move all of the individuals to the list 
on the right.    Then use the Remove button (the arrow pointing to the left) to remove the 
few individuals that you don't want in the group.    This is much faster than including all of 
the individuals one by one.    
If you want to include all of the individuals in your Family File, don't use the "Include All" 
button.    Instead, from the Contents menu, select Individuals to Include.    Then, in the 
Include dialog box, select All Individuals.    This way, individuals that you add to your 
Family File later will be included automatically.    If you use the "Include All" button to 
include everyone, individuals that are added to your Family File later will not be added to 
the group automatically.
The best time to use the "Remove All" button is when you already have several individuals 
in the group and you want to start over.    Click the Remove All button (the double arrows 
pointing to the left) to remove all of the individuals from the group.    Then use the Include 
button (the arrow pointing to the right) to begin adding individuals to the group again.    

Using the "Find and Include" and "Find and Remove" Buttons
With the "Find and Include" and "Find and Remove" buttons, Family Tree Maker will search 
your Family File for individuals, such as those who were born before a certain date or those 
who are ancestors of a particular individual, and add them to the group or remove them 
from the group.
To create a group using the "Find and Include" and "Find and Remove" buttons:



1. Decide which individuals you want to add to or remove from the group.    For example, 
do you want to add all of your ancestors?    Do you want to add all of the individuals 
who were born in a particular town?    Do you want to remove all of the individuals who 
were born before a particular date?    
If you want to add or remove a group of individuals that are ancestors or descendants of 
a particular individual, make sure to highlight the name of that individual in the list on 
the left before moving on to step 2.    For example, if you wanted to add all of your 
ancestors, you would highlight your name.    

2. Click either the Find and Include ("Find" with the arrow pointing to the right) or Find 
and Remove button ("Find" with the arrow pointing to the left).
Family Tree Maker displays either the Add Individuals or Remove Individuals dialog box.    
In this dialog box you specify which individuals you want Family Tree Maker to find and 
add to the group or remove from the group.

3. Click in the Search field.    
If you want to find individuals who are all ancestors or descendants of a particular 
individual, choose either "Ancestors," or "Descendants," from the drop-down list.    (You 
may have to scroll upwards in the drop-down list.)    Family Tree Maker automatically fills 
the "of" field with the name of the individual that was highlighted in step 1.    Skip to step
5.    
If you want to find individuals who have information in common, such as a birth location, 
use the drop-down list to choose the name of the field that contains that information.    
For example, if you want to find all individuals who were born in a particular place, you 
would select "Birth location."    When you've selected a field, go to step 4.

4. In the for field, type the information that you want to search for.    If the field that you 
are searching only has certain legal values (such as "male," "female," and "unknown"), 
then a drop-down list may be displayed in the "for" field.    Just choose the item you 
want to search for.
For example, if you chose "Birth location" in step 3, and you wanted Family Tree Maker to
find everyone that was born in Cleveland, Ohio, then you would type    Cleveland, Ohio  
in the "for" field. 

5. Click OK.    
Family Tree Maker searches through your Family File for individuals who match your 
request.    If no matches are found, Family Tree Maker tells you so.    If you chose to add 
the individuals, their names are added to the list on the right and the "Number included" 
increases.    If you chose to remove the individuals, their names are removed from the list
on the right, and the "Number included" decreases.



Selecting print settings
After you click OK in the Individuals to Include dialog box, Family Tree Maker displays the 
Batch Print dialog box.    This is where you can select options for page numbering and print 
quality.    If you need other information about Batch printing, see the topic Batch printing.
1. Select your options in the Batch Print dialog box.    Each option is described below.

Print quality    Use this option to select the quality of your printed materials.    The 
higher the print quality you choose, the darker and sharper your printed materials will 
be.    However, items printed in high print quality also take longer to print.    If your printer
does not support different print qualities, this option will not be available to you.
Page numbering    Select the option button for the page numbering scheme that you 
want for your batch print.    If you choose to have page numbers, enter a starting number
in the Starting number field.    Please note that when you print Notes, the Don't 
number pages option button is not available.    In addition, when you print Notes, you 
cannot select a starting number; all Notes start on page 1.    
Print color    Select this check box to print text in color.    De-select it if you just want to 
print in black and white.    If you have a black and white printer, select this check box to 
print in black, white, and gray.    De-select it if you just want to print in black and white.

2. Click OK when you've made your selections.
Family Tree Maker begins printing.



Special uses for Batch printing
Batch printing comes in handy when you are doing family research.    For example, you can 
batch print a set of Family Group Sheets to send to relatives so that they can verify the 
information.    After printing the Family Group Sheets, you can easily switch to the 
Labels/Cards view and print mailing labels for the same group of people!    This is because 
Family Tree Maker saves the group that you select in the Individuals to Include dialog box 
until you change it again.
Batch printing is also especially useful when you want to make family books.    You can 
choose who to print the documents for and how to number the pages.    You can also select 
the order in which the documents print -- alphabetically, chronologically, or virtually any 
order you want!    Many people like to print their documents in Ancestor or Descendant 
order, so we're including general instructions here:
To batch print in Ancestor or Descendant order:
1. When you first open the Individuals to Include dialog box, click the Remove all button 

(double arrows pointing to the left.)
2. Click Sort order.

Family Tree Maker displays the Sort Batch Print dialog box.
3. Select the Don't sort individuals option button and then click OK.

Family Tree Maker returns you to the Individuals to Include dialog box.
4. Select the individual whose ancestors or descendants you want to add, and click Find 

and Include.
Family Tree Maker displays the Add Individuals dialog box.

5. In the Search field, select either Ancestors or Descendants.
6. Click OK.

Family Tree Maker returns you to the Individuals to Include dialog box
7. Click OK.

Family Tree Maker displays the Batch Print dialog box.
8. Make your selections in the Batch Print dialog box.
9. Click OK.

Family Tree Maker begins printing.



Creating family books
Like most programs designed for Microsoft Windows, Family Tree Maker allows items to be 
copied to the Clipboard and then pasted into other Windows applications.    This opens up 
many creative possibilities.    For example, a family tree from Family Tree Maker could be 
pasted right into a book of family stories being written in a Windows word processor.    
You can place a copy of most Family Tree Maker items, such as trees, Family Group Sheets, 
Kinship reports, and calendars, into other Windows applications.    When you copy one of 
these items, a metafile image is placed on the Clipboard.    A metafile is a graphics file 
format that many Windows word processors and graphics programs can read.    Check the 
manual of your other software programs to see if they can read metafiles.    
To copy and paste an item from Family Tree Maker into another Windows 
application:
1. Display the image that you want to copy.
2. From the Edit menu, select Copy (ALT, E, C).

Family Tree Maker places a metafile image of what you had displayed on the Clipboard. 
3. Go to your other program that can read metafiles, and make any preparations that it 

requires.    
4. From the Edit menu of that program, select Paste (ALT, E, P).

The image will appear in that program.



Print setup
When you change your print setup, you are changing it for a specific view, not for all views. 
For example, if you change the print setup while you're in the Ancestor Tree view, every 
Ancestor tree that you print afterwards will have the same setup.    However, Descendant 
trees would not have that setup.    
To change your print setup:
1. From the File menu, select Print Setup (ALT, F, R).    Or, if you're in the Print dialog box, 

click Setup.
Family Tree Maker displays the Print Setup dialog box.
Default/Specific Printer    The default printer is the printer that is normally used by 
your Windows programs.    Select the Default printer option button to use the default 
printer.    Select the Specific printer option button if you want to select a printer other 
than the default printer.
Note:    If the printer you wish to use is not shown, then you will need to install that 
printer's driver.    Consult your Microsoft Windows User's Guide for more information.
Portrait/Landscape    If you want your document to print with the short edge of the 
paper at the bottom (as a letter normally prints) click the Portrait option button.    If you 
want your document to print with the long edge of the paper at the bottom (sideways), 
click the Landscape option button.    Ancestor trees usually take fewer pages in portrait 
orientation, and Descendant trees usually take fewer pages in landscape orientation.    
This option is not available to printers using 14" x 11" paper.
Size/Source    Click the arrow next to the Size field to choose a paper size and Source 
to choose your paper source.
Margins    Use the Top, Bottom, Left, and Right fields to change the margins on your 
pages.
Print continuous forms    If your printer uses continuous forms, you can select this 
check box to tell Family Tree Maker to print across the perforations in your paper.    This 
does not apply to laser printers that automatically feed in single sheets of paper.
Overlap pages    If you want information on the edge of one page to be repeated on the 
edge of the next page so that it's easier to tape pages together, select this check box.
Options  Click this to go to the Options dialog box.    The options available to you depend
on your printer.    Make your selections from this dialog box, and then click OK to return 
to the Print Setup dialog box.

2. Click OK when you've made your selections.    
Family Tree Maker returns you to the current view.



The FamilyFinder Index:    what it is & how to use it
Please note that the FamilyFinder Index is only available on the CD-ROM version of Family 
Tree Maker.

The Basics
Many of the records that you use for genealogical research, such as census records and 
marriage records, have been indexed.    These indexes can help you save time by telling 
you exactly where to go to get the record that you are searching for.    The CD-ROM version 
of Family Tree Maker for Windows comes equipped with the best index of them all -- the 
FamilyFinder Index.    This index is special because it works like a "Super Index" to existing 
archives.    The FamilyFinder Index contains approximately 100 million names of individuals 
whose names appear in U.S. census records, selected state marriage records, selected 
state land records, all publicly available social security death benefits records, and many 
other archives.    The FamilyFinder Index is an index of actual names.    It can tell you within 
seconds exactly where to go to obtain more detailed information about each listed person.

Using the FamilyFinder Index
One of the best parts about the FamilyFinder Index is that you can use it without even 
leaving your computer.    To use the FamilyFinder Index, follow these simple steps.    From 
the FamFinder menu in Family Tree Maker, select FamilyFinder Index (ALT, A, F).    Family 
Tree Maker displays the FamilyFinder Index dialog box.    The entries in the FamilyFinder 
Index are listed alphabetically by last name.    Next to each entry is a description of the 
Archive disc which contains information about that name.    
Archive discs are CD-ROMs that you can use in selected libraries or purchase from Banner 
Blue Software.    The Archive disc contains the actual index or archive (marriage index, 
census index, land record archive, etc.) that the name in the FamilyFinder Index was taken 
from, and gives you more information about the record that the Index refers to.    Often, you
won't need to go to the actual record itself, because the Archive disc will give you all of the 
information that you need.    However, if you do want to see the actual record, the Archive 
disc gives you information about how to find it.    For example, if you are looking for a 
census record, the Archive disc will tell you on which microfilm roll the record is located.    
You then just need to go to a National Archives branch or a library that has the census on 
microfilm.    
To find a name in the FamilyFinder Index, all you need to do is type it in at the top of the 
screen.    (There are several ways to search for names in the FamilyFinder Index.    Complete
instructions for using the FamilyFinder Index are in the topics listed at the bottom of this 
screen.)    If this name is included in the FamilyFinder Index, Family Tree Maker will find it for
you, and then you know for certain that a particular record containing that name exists.    
The FamilyFinder Index tells you on which Archive disc you can find the name.    You can 
then go to that Archive disc to get more information about the individual with that name.    
You will also find out where the actual record is located.    The process is actually quite easy,
click here to see an example.
There are a number of options after you find your ancestor's name in the FamilyFinder 
Index.
 You can contact Banner Blue and actually purchase the Archive disc containing the index 

on which the name is listed.    These Archive discs are specially discounted for Family Tree 
Maker customers.    And, even better, they can be accessed right from your own computer!    
You won't have to go to a library and search for the correct index.    In addition to directing 
you to the actual record, these Archive discs contain a wealth of genealogical information -- 
so much that you may not even need the actual record.    (More about accessing these 
Archive dics is in the topic "All About Archive CD-ROM Discs.")



 You can visit a good public or genealogy library or a National Archives branch in your area. 
These institutions may have the indexes that you need in bound, microfilm, or CD-ROM form.

 You may be able to go straight to the actual record after using the FamilyFinder Index.    It 
all depends on the type of record that you are searching for.

It is possible that you will not find your ancestor's name in the FamilyFinder Index.    See the
topic What if I can't find my ancestor's name for more information.

Where do the Archive discs come from?
The Archive discs were created by Automated Archives, a research company in Utah.    
Banner Blue Software has a special agreement with Automated Archives to sell Archive 
discs to Family Tree Maker customers.    For more information about Archive discs, call 
Banner Blue Software at 800-387-2158 or 716-871-7637.    The fax number is 716-873-
0906.    Lines are open 24 hours a day, 7 days a week.    You can also write to (please 
include your address and phone number so that we can contact you):
Banner Blue Software
PO Box 119
Buffalo, NY 14207-9965

Select one of the topics below to get instructions for using the FamilyFinder Index.    For a 
more complete description of the Archive discs and where you can access them, see the 
topic "Accessing Archive CD-ROM discs."
You should also know about research issues regarding the FamilyFinder Index, Archive CD-
ROM discs, and genealogical records in general.    These issues are described in the 
Genealogy "How-To" Guide.    To read about these issues, from the FamFinder menu, select
Genealogy "How-To" Guide (ALT, A, F).    On the first screen of the Genealogy "How-To" 
Guide, select FamilyFinder Index.    At the bottom of that topic, select the jump to "Issues
with using the FamilyFinder Index (and Archive CD's)."
See Also
Setting search options
Doing a FamilyFinder Quick Search
Using FamilyFinder Find Name
Printing the results of your FamilyFinder Index search
Getting more information about a record
Accessing Archive CD-ROM discs



What if I can't find my ancestor's name?
It's possible that the name you are looking for will not be found in the FamilyFinder Index.    
If this occurs, don't despair!    There are two things you should realize before giving up:
First, it is possible that the name really is in the FamilyFinder Index but has been disguised 
by errors or name changes.    As you look through the FamilyFinder Index, don't rule out 
entries that are similar, but not exact matches of the names that you are looking for.    
Because the FamilyFinder Index is composed from many different sources, including hand-
written census records more than a century old, there are spelling errors, 
misinterpretations of names, transpositions of first and last names, first initials being used 
instead of first names, abbreviations being used instead of full or middle names (like Edw. 
Wm. instead of Edward William), and other errors.    Even name changes may play a part in 
"hiding" a name you are looking for.    For example, if you are looking for the name of a 
female in the Social Security Death Benefits Index, most likely you should be looking under 
her married name rather than her maiden name.    For advice and more examples of exactly
what types of errors you should be aware of, see the important topic "Issues with using the 
FamilyFinder Index (and Archive discs)." 
Second, even if you can't locate your ancestor's name in the FamilyFinder Index, it is still 
possible that a record with your ancestor's name exists.    It just happens that the record 
was not not in an index that is available electronically, and therefore couldn't be included in
the FamilyFinder Index.
There are other important research issues regarding the FamilyFinder Index, Archive discs, 
and genealogical records in general.    It is important to know about these issues before you
begin your genealogical research.    To read about them, from the Help menu, select 
Genealogy "How-To" Guide (ALT, H, G).    On the first screen of the Genealogy "How-To" 
Guide, click FamilyFinder Index.    At the bottom of that topic, select the topic "Issues 
with using the FamilyFinder Index (and Archive discs)."

If you want to return to the topic that you were reading previously, click the Back button at 
the top of this screen.



A sample search
Joseph Bradley is searching for information about his great-grandfather, Thomas Franklin 
Bradley, who was from Missouri.    Before he begins to look through microfilm indexes and 
records at his local genealogy library, he uses the FamilyFinder Index that's on the CD-ROM 
version of Family Tree Maker for Windows.    Joseph gives the name of his great-grandfather 
to the FamilyFinder Index, and it goes to work.    
After quickly searching through 100 million names, the FamilyFinder Index highlights the 
name "Thomas Franklin Bradley."    Next to it reads "Census:    Iowa, Illinois, Missouri, 
Michigan, Minnesota, Wisconsin (1850)."    Since Joseph's grandfather was from Missouri 
and the time frame seems plausible, this looks like a possible match.    From the 
FamilyFinder Index, Joseph can see that this particular census index is contained on Archive
disc number 47.    This may be an Archive disc that he wants to look at.
First, Joseph decides to find out a little more about the contents of Archive disc number 47.  
He'd like to know as much as he can about the index that may contain information about 
his great-grandfather.    He clicks More About and this is what he finds out:    Archive CD 47
contains about 900,000 total entries.    It is an almost complete index of all of the counties 
that existed in those states in 1850.    He also finds out that he can get the following 
information from the Archive disc:    the township where this individual named Thomas 
Franklin Bradley lived at the time of the census, the microfilm page number where the 
census record exists, the Soundex code for Thomas Franklin Bradley's name, and notes 
indicating the number and age of males, females, and slaves in the household at the time 
of the census enumeration.    It's incredible how much information Joseph can get just from 
the Archive disc that contains the census index itself!    Joseph decides to order Archive disc
number 47 from Banner Blue so that he can access the information listed above.    All of this
information will help him determine if this Thomas Franklin Bradley is actually his great-
grandfather.    
Once he gets the Archive disc, he can look at all of the information that is in this census 
index.    If he likes, he can also go further and actually acquire a copy of the census record.   
Now getting a copy of the census record will be easy because the Archive disc tells him the 
exact microfilm page number where the census record exists.    He only needs to go to a 
branch of the National Archives or a library that has the 1850 census on microfilm.

If you want to return to the topic that you were reading previously, click the Back button at 
the top of this screen.



Setting search options
Please note that the FamilyFinder Index is only available on the CD-ROM version of Family 
Tree Maker.
The FamilyFinder Index contains over 150 million entries.    That's a lot of names to search 
through, so it can take some time.    In many cases, however, you will be able to limit your 
search to include fewer entries by selecting which Archive discs to include in the search.    
When you limit your search to a certain group of Archive discs, you can narrow in on 
specific types of records, such as census records or land records.    If you need other 
information about the FamilyFinder Index, see the topic The Family Finder Index:    what 
it is & how to use it
To limit the number of Archive discs in a particular FamilyFinder Index search:
1. Make sure you are in the FamilyFinder Index dialog box.    If you are not, from the 

FamilyFinder menu, select FamilyFinder Index (ALT, A, F).
2. Click Archives.    This button is located at the bottom of the FamilyFinder Index dialog 

box.
Family Tree Maker displays the Archives dialog box.    It lists seven different categories of 
Archive discs.    When the check box next to a category is selected, the Archive discs in 
that category will be included in the next search.    

3. Read through the list of categories.    When you come to a category that you want to 
include in your next search, make sure that the check box next to that category is 
selected.    If you want to include all categories in your next search, you can click 
Select all.    When you come to a category that you don't want to include in your next 
search, make sure that the check box next to that category is not selected.    For the 
FamilyFinder Index to perform a search, at least one category must be selected. 

4. Click OK when you've made your selections.    
Family Tree Maker returns you to the FamilyFinder Index dialog box.    Now you can 
perform a search using the set of Archive discs you just selected.

Family Tree Maker remembers which categories of Archive discs are selected during your 
Family Tree Maker session until you change them again.    You do not need to re-select the 
categories each time you perform a search.
See Also
Doing a FamilyFinder Quick Search
Using FamilyFinder Find Name



Doing a FamilyFinder Quick Search
Please note that the FamilyFinder Index is only available on the CD-ROM version of Family 
Tree Maker.
With this feature you can find an individual in the FamilyFinder Index just by typing their 
name.    If you need other information about the FamilyFinder Index, see the topic The 
Family Finder Index:    what it is & how to use it
To use the quick search feature of the FamilyFinder Index:
1. Click in the Name field at the top of the FamilyFinder Index dialog box.
2. Start typing the last name of the individual that you want to find.

With each character you type, you will get closer to the name you are looking for.    You 
can type part or all of the name, as long as it is in the following format:    Last name, First 
name Middle name.    As you move through the index, you may notice some unusual 
characters in some names, such as * or $.    These are simply typos -- with tens of 
millions of names, it's hard to be perfect!
The following characters may be included in your search:    A-Z, a-z, and accented 
characters.    However, be careful with accented characters.    All accents were 
purposefully removed from the names in the FamilyFinder Index.    If your family name 
has an accent in it, search for the name without the accent.    You may still see a few 
accents in the Index, but they are accidental.    
Some other characters, such as apostrophes, dashes, commas, periods, and the 
underscore character are regarded as spaces by Find Name.    This means that if you type
a name such as Jean-Luc Marchand, the FamilyFinder Index will interpret the name as 
three words, and ask you to reduce your search to two words.    In addition, you cannot 
include the following characters:    !, *, ?, [, ], \, |, (, ), and &.    
If you are unable to locate your ancestor's name under the spelling that you know, try a 
few different spellings.    Because the FamilyFinder Index is composed from many 
different sources, including hand-written census records over a century old, there are 
bound to be spelling errors, misinterpretations of names, missing middle names, 
transpositions of first and last names, first initials being used instead of first names, 
abbreviations being used instead of full or middle names (like Edw. Wm. instead of 
Edward William), and other errors.    Even name changes may play a part in "hiding" a 
name you are looking for.
When you come to an index entry of interest to you, double-click that entry or click 
Name while the entry is highlighted.    This places a check mark to the left of the entry.    
To remove a check mark, just double-click the entry again or click Name again.    If you 
want to remove all check marks from the FamilyFinder Index, select Clear all.    When 
you are done with your search, you can print a list of the entries that you have marked to
print and use the list as a guide for further research on those names, such as a list of 
names to look up on an Archive disc or in bound indexes that you might find in your local
genealogy library.    Please note that if you click Cancel to leave the dialog box, all of 
your check marks will be lost.    If you need to leave the FamilyFinder Index dialog box 
and want to save your check marks, make sure to click OK. 
At any time while you are searching you can find out what type of information a 
particular Archive disc contains.    Simply highlight the entry and click More About.    

3. When you reach the end of your search, select Print if you want to print all of the 
entries that you have marked for printing.    For a description of the Print dialog box, 
see the topic "Printing the results of your FamilyFinder Index search."

4. Click OK to leave the FamilyFinder Index dialog box.



See Also
Setting search options
Using FamilyFinder Find Name
Printing the results of your FamilyFinder Index search
Getting more information about a record
Accessing Archive CD-ROM discs



Using FamilyFinder Find Name
Please note that the FamilyFinder Index is only available on the CD-ROM version of Family 
Tree Maker.
Using Find Name is a quick way to locate a specific name in the FamilyFinder Index.    It's 
especially useful if you only know an individual's first name, because you don't need to 
search in the "Last name, First name Middle name" format.    In fact, you can search on as 
little as the first four letters of either the first, middle, or last name.    If you need other 
information about the FamilyFinder Index, see the topic The Family Finder Index:    what 
it is & how to use it
To use the Find Name command in the FamilyFinder Index:
1. Click Find.  It's located at the bottom of the FamilyFinder Index dialog box.    

Family Tree Maker displays the Find Name dialog box.    
2. Decide which type of search you want to do, either a partial word or whole word 

search.    
With whole word searches, the FamilyFinder Index will only find whole words that match 
the letters you type in the Name field.    For example, if you type Smith in the Name 
field, the FamilyFinder Index will find all entries where the individual's first, middle, or last
name was "Smith."    FamilyFinder would not find names such as "Smithson," "Smithy," or
"Nesmith."    To do a whole word search, make sure that the Search for whole words 
check box is selected.
With partial word searches, the FamilyFinder Index will find any index entry that has a 
first, middle, or last name whose beginning letters are the same as the letters that you 
typed into the Name field.    For example, if you type blan, the FamilyFinder Index will 
find "Ken Blannard," "Blanche Smith," "George Blane Smith, III," and so on.    It will not 
find names such as "Robert Kirbland" or "Seablane Williams" because the "blan" is not at 
the beginning of one of the names.    To do partial word search, make sure that the 
Search for whole words check box is not selected.
If you don't find your ancestor's name by using an whole word search, you may want to 
try searching on a portion of the name using a partial word search.    It may be the case 
you don't have the correct spelling of your ancestor's name, or that the individual who 
created the records made a spelling error.    In addition, try a few different spellings.    
Because the FamilyFinder Index is composed from many different sources, including 
hand-written census records over a century old, there are bound to be spelling errors, 
misinterpretations of names, missing middle names, transpositions of first and last 
names, first initials being used instead of first names, abbreviations being used instead 
of full or middle names (like Edw. Wm. instead of Edward William), and other errors.    
Even name changes may play a part in "hiding" a name you are looking for.

3. Type an individual's name in the Name field.
With whole word searches, you may type no more than two words in the Name field, and
neither word may be more than 15 characters long.    The FamilyFinder Index will find any
index entry containing the words that you type in the Name field.    For example, if you 
type Robert Wilson, the FamilyFinder Index will find "Robert John Wilson," "Wilson 
Robert Smith," and "Robert A. Wilson."    
With partial word searches, each word that you type must be from 4 to 15 characters 
long, and you may type no more than two words.
The following characters may be included in your search:    A-Z, a-z.    Searches in the Find
Name dialog box cannot include accented characters.    Some other characters, such as 
apostrophes, dashes, commas, periods, and the underscore character are regarded as 



spaces by Find Name.    This means that if you type a name such as Jean-Luc Marchand, 
the FamilyFinder Index will interpret the name as three words, and ask you to reduce 
your search to two words.    In addition, you cannot include the following characters:    !, 
*, ?, [, ], \, |, (, ), and &.    

4. Click OK to begin searching.
Family Tree Maker returns to the FamilyFinder Index dialog box and highlights the first 
index entry that meets your request.    If there are no matches, Family Tree Maker 
displays a message telling you this.    As you move through the index, you may notice 
some unusual characters in some names, such as * or $.    These are simply typos -- with 
tens of millions of names, it's hard to be perfect!
When you come to an index entry of interest to you, double-click that entry or click 
Name while the entry is highlighted.    This places a check mark to the left of the entry.    
To remove a check mark, just double-click the entry again or click Name again.    If you 
want to remove all check marks from the FamilyFinder Index, select Clear all.    When 
you are done with your search, you can print a list of the entries that you have marked to
print and use the list as a guide for further research on those names.    Please note that if 
you click Cancel to leave the dialog box, all of your check marks will be lost.    If you 
need to leave the FamilyFinder Index dialog box and want to save your check marks, 
make sure to click OK. 
At any time while you are searching you can find out what type of information a 
particular Archive disc contains.    Simply highlight the entry and click More About.    

5. To continue searching through the list of index entries, either click Next or Previous.    
The FamilyFinder Index does not begin each new search from the beginning of the index. 
Instead, it starts each new search from the last index entry that was highlighted.    This 
means that the first match that the FamilyFinder Index shows you may be in the middle 
of the FamilyFinder Index, not at the beginning.    For this reason, even when you're on 
the very first match that the FamilyFinder Index shows you, you can still click Previous 
and move backwards through the index.    
Please note that once you reach the end of the FamilyFinder Index, it will tell you that 
there are no more matches.    However, if you started your search in the middle of the 
index, there still may be some matches in the first half of the index that you have not 
already seen.    You must click Previous to go backwards, or you can simply move to the
top of the index by dragging the scroll box to the top of the scroll bar.    Then you can 
search through the remaining matches in the first half of the index.    You cannot move 
from the very end of the index (the Z's) to the very beginning of the index (the A's) by 
clicking Next.

6. When you reach the end of your search, select Print if you want to print all of the 
entries with check marks next to them.    For a description of the Print dialog box, see 
the topic "Printing the results of your FamilyFinder Index search."

7. Click OK to leave the FamilyFinder Index dialog box.
See Also
Doing a FamilyFinder Quick Search
Setting search options
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Printing the results of your FamilyFinder Index search
Please note that the FamilyFinder Index is only available on the CD-ROM version of Family 
Tree Maker.
As you are looking through the FamilyFinder Index, you may see several index entries that 
you want to look up on the Archive discs.    Instead of writing down each index entry, you 
can print a list of them when you've finished your search.    For each index entry that you 
marked while searching, Family Tree Maker will print the individual's name, the Archive disc 
date range, the Archive disc title, and the Archive disc number.    If you need other 
information about the FamilyFinder Index, see the topic The Family Finder Index:    what 
it is & how to use it
To print the results of your FamilyFinder Index search:
1. You should have already performed a search in the FamilyFinder Index and marked at 

least one index entry for printing.    If not, see either "Using Find Name," or "Doing a 
Quick Search."

2. Turn your printer on.
3. Select Print.    This button is located at the bottom of the FamilyFinder Index dialog 

box.
Family Tree Maker first reminds you how to change the text formatting, click OK to clear 
the message.    Family Tree Maker then displays the Print Selected FamilyFinder Index 
Entries dialog box where you can select printing options.    
Print range    If you want to print all of the pages, select the All option button.    If you 
want to print a range of pages, type the page number of the first page in the From field 
and the page number of the last page in the To field.    If you want to print only one page,
type the number in both the From and To fields.
Print quality    The higher the print quality you choose, the darker and sharper your 
printed materials will be.    If your printer does not support different print qualities, this 
option will not be available to you.
Copies In this field, type the number of copies that you want to print.
Collate copies    Select this check box if you are printing multiple copies of a report and 
want to print complete sets.    De-select this check box if you want multiple copies of the 
first page, multiple copies of the second page, and so on.
Print to file    If you want to print your report to a file and send it to your printer at a 
later time, select this check box.    This option is useful if you want to print on a printer 
owned by someone who doesn't have Family Tree Maker.    When you print, you will need 
to provide a name for the output file. 

Note:    If you intend to print the file on a printer other than your own, make sure the 
settings in the Print Setup dialog box match the printer you will be using.    

Print color    Select this check box to print in color, or in black, white, and gray if you 
don't have a color printer.    

4. When you're done making your selections, click OK.    
Family Tree Maker prints the results of your FamilyFinder Index search.    Use the list as a 
guide when you are looking at an Archive disc.

See Also
Formatting text in FamilyFinder Index print-outs
Doing a FamilyFinder Quick Search
Using FamilyFinder Find Name



Accessing Archive CD-ROM discs



Formatting text in FamilyFinder Index print-outs
Please note that the FamilyFinder Index is only available on the CD-ROM version of Family 
Tree Maker.
You can use the text format settings in the Report view to change the text formatting in 
FamilyFinder Index print-outs.    If you need other information about the FamilyFinder Index, 
see the topic The Family Finder Index:    what it is & how to use it
To format the text and title in a FamilyFinder Index print-out:
1. If you are in the FamilyFinder dialog box, click OK to save your check marks.    Then go 

to the Report view by clicking Report on the button bar at the top of the Family Tree 
Maker screen.    Please note that if you click Cancel to leave the FamilyFinder dialog 
box, all of your check marks will be lost.      

2. From the Format menu, select Text Font, Style, & Size (ALT, T, F).
Family Tree Maker displays the Text Font, Style, & Size dialog box.

3. In the Items to format list, click an item that you want to format, such as Title.
Each of the formatting options is described below.    The "Sample" field shows what your 
choices will look like.
Font    Use this field to select a font for that item.    
Size    Use this field to select a point size for that item.    
Style    Use this field to select a text style, such as bold or italics, for that item.        
Color    Use this field to select a color for that item.

4. Click OK when you're done making changes.    
Family Tree Maker returns you to the Report view.

5. You can now return to the FamilyFinder Index and print the results of your FamilyFinder 
Index search.    To return to the FamilyFinder Index, from the FamilyFinder menu, 
select FamilyFinder Index (ALT, A, F).



Getting more information about a record
Please note that the FamilyFinder Index is only available on the CD-ROM version of Family 
Tree Maker.
As you move through the list of index entries in the FamilyFinder Index, you can find out 
what type of information a particular Archive disc contains.    Simply highlight the name of 
the Archive disc and select More About.    Family Tree Maker displays a Help window with a
description of the Archive disc.    If you need other information about the FamilyFinder 
Index, see the topic The Family Finder Index:    what it is & how to use it
Remember, the Archive discs are available to you in two ways:    you can find them at 
selected libraries throughout the country, or you can purchase them from Banner Blue 
Software.    Then, once you have access to the Archive disc that you need, you can locate 
your ancestor's name on that disc.    From that Archive disc, you will find out exactly where 
your ancestor's record is.    For example, if FamilyFinder indicated that your great-
grandmother's name was in a census Archive disc, that Archive disc would tell you a 
microfilm roll number, page number, or other information that would lead you directly to 
the actual census record.
When you are finished reading the description of the record, you can close the Help 
window:    from the File menu in the Help window, select Exit (ALT, F, X).



Accessing Archive CD-ROM discs
Please note that the FamilyFinder Index is only available on the CD-ROM version of Family 
Tree Maker.
The Archive discs were created by Automated Archives, a research company in Utah.    
Banner Blue Software has a special agreement with Automated Archives to sell Archive 
discs to Family Tree Maker customers.    For more information about Archive discs, call 
Banner Blue Software at 800-387-2158 or 716-871-7637.    The fax number is 716-873-
0906.    Lines are open 24 hours a day, 7 days a week.    You can also write to (please 
include your address and phone number so that we can contact you):
Banner Blue Software
PO Box 119
Buffalo, NY 14207-0119
Purchasing the CD's for use in your home will allow you to locate ancestors without even 
leaving your computer.    In addition, you avoid the time limits that libraries often must 
impose on computer use.    Contact Banner Blue Software for more purchasing information 
today!    
You can also find the discs created by Automated Archives at selected libraries around the 
country.    Check with your local libraries for more information about their CD-ROM index 
collection.
Using the FamilyFinder Index and the Archive discs are really a convenient way to find your 
ancestors, because these resources give you access to millions of names from several 
different types of records all in one place.    Without the FamilyFinder Index and Archive 
discs, you would need to spend hours finding out what types of indexes existed, and 
searching through all of the indexes by hand.    In addition, it's possible that your local 
libraries wouldn't even have the indexes that you need.



The Toolbar and menu commands
Toolbar

Select this topic to get help about the row of buttons underneath the main menu in 
Family Tree Maker.

File menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
File menu.

Edit menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
Edit menu.

View menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
View menu.

People menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
People menu.

Picture/Object menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
Picture/Object menu.

Contents menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
Contents menu.

Format menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
Format menu.

Preferences menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
Preferences menu.

FamFinder menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
FamFinder menu.    (This menu is only available if you have a CD-ROM version of Family 
Tree Maker.)

Help menu
Select this topic to get help about each of the commands listed on Family Tree Maker's 
Help menu.



Toolbar
The Toolbar contains buttons that you can click to move to different views in Family Tree 
Maker.    To change views, just click the button corresponding to the view that you want to 
see.    For example, if you want to see the Index of Individuals, click the button on the left 
that is labeled "Index."
From left to right, the tool bar buttons will take you to the following views:    Index of 
Individuals, Family Page, Ancestor Tree, Descendant Tree, Outline Descendant Tree, Kinship,
Calendar, Family Group Sheet, Report, and Labels/Cards.    These views are also accessible 
from the View menu.    
In addition, depending on which view you are in, there may be Zoom In and Zoom Out 
buttons on the Toolbar.    You can use these to view your document at larger and smaller 
sizes.    The Zoom buttons do not affect the size that your documents will be when you 
print them.
See Also
View menu



File menu
New Family File    Allows you to create and name a new Family File (ALT, F, N).
Open Family File    Opens an existing Family File, Family Tree Maker for DOS file, or 

Backup file.    You can also use this dialog box to append files (ALT, F, O).
Import Text File    Allows you to import a text file from another program into the Notes 

dialog box.    This command is only available while you are in Notes.    (ALT, F, I)
Backup Family File    Makes a backup copy of an existing Family File.    It will have the 

same name as the original file, with the extension .FBK (ALT, F, B).
Export Notes    Allows you to export your Notes from the Notes dialog box into a 

program that reads ASCII files.    This command is only available while you are in 
Notes.    (ALT, F, E)

Copy/Export Family File    Lets you make a copy of an existing Family File.    You can 
copy it to any drive or directory and give it a new name (ALT, F, C).

Print Preview    Changes from the Scrapbook view to Scrapbook Print Preview.    You 
must be in Scrapbook Print Preview to make formatting changes to Scrapbook pages 
that you want to print.    This command is only available while you are in the 
Scrapbook view.    (ALT, F, V)

Print    Prints the current document (ALT, F, P).
Batch Print    Allows you to print Family Group Sheets, Scrapbooks, and Notes dialog 

boxes for multiple people all at once (ALT, F, A)
Print Setup    Allows you to change the paper orientation, margins, etc. for your printed 

documents (ALT, F, R).
Exit    Closes the program and ends your Family Tree Maker session (ALT, F, X).
Note: Family Tree Maker does not have a Save command.    For more information, 
please see the topic "Saving Family Files."
See Also
Saving Family Files



Edit menu
Undo    Reverses the last editing command.    Words are added to "Undo"    to describe 

what will be undone.    For example, "Undo Cut" tells you that the item you cut will be 
replaced (ALT, E, U).

Cut    Deletes the highlighted item and places it on the Clipboard (ALT, E, T).
Copy    Makes a copy of the highlighted item and places it on the Clipboard (ALT, E, C).
Paste    Takes whatever is on the Clipboard and places a copy of it where the cursor or is 

located (ALT, E, P).
Find    Displays a dialog box where you can type information.    Family Tree Maker will 

locate the individual(s) that the information is associated with (ALT, E, F).
Picture/Object    Displays a list from which you can select editing commands to use with 

Pictures/Objects.    The commands will vary depending on the type of Picture/Object 
that is selected when you choose this command (ALT, E, O).



View menu
Index of Individuals    Lists the names, birth dates, and death dates of each individual 

contained in your Family File (ALT, V, I).
Family Page    Displays the Family Page:    the "page" for entering names, birth dates, 

and death dates for each member of a nuclear family (ALT, V, F).
More About    Displays a cascading menu from which you can select once of the More 

About dialog boxes (Facts, Notes, Address, Lineage, and Medical) to go to.    You will 
go to a More About dialog box for the primary individual (ALT, V, M).

Source    This command is only available for selected fields.    It displays a dialog box in 
which you can enter the name of the source where you found the information that 
you entered into the currently selected field (ALT, V, U).

Scrapbook    Displays the Scrapbook for the currently selected individual.    If the cursor 
is on a marriage field, it will display the Scrapbook for the marriage (ALT, V, S).

Ancestor Tree    Displays an Ancestor tree with the current individual as the primary 
individual (ALT, V, A).

Descendant Tree    Displays a Descendant tree with the current individual as the 
primary individual (ALT, V, D).

Outline Descendant Tree    Displays an Outline Descendant tree with the current 
individual as the primary individual (ALT, V, O).

Kinship    Creates a list of all of the individuals related to the current individual, and 
describes their relationship.

Calendar    Creates a calendar containing the anniversaries and birthdays of every 
individual in the Family File (ALT, V, C).

Family Group Sheet    Creates a document summarizing all of the information about a 
nuclear family, including each member's name, birth date, death date, and 
spouse(s).    Can also include the information contained from the More About dialog 
boxes (ALT, V, G).

Report    Creates a list of the names, birth dates, and death dates of every individual 
contained in your family file (ALT, V, R).    

Labels/Cards    Displays a set of labels or cards that contain information about a selected
set of individuals (ALT, V, L).

Zoom    Allows you to change the size in which a document is displayed on screen (ALT, V, 
Z).

Show Page Lines    Turns on and off the dotted lines on screen that indicate where a 
page's margins are (ALT, V, S).



People menu
Add Unrelated Individual    Displays an empty Family Page where you can enter 

information about an individual who you know is related to you, but you're unsure 
how (ALT, P, U).    

Fix Relationship Mistakes    Shows a cascading menu containing Attach Spouse, 
Detach Spouse, Attach Child, and Detach Child:    commands that allow you to modify 
the structure of your Family File (ALT, P, F).

Insert Child    Creates a blank row between two children in the "Children" list on the 
Family Page so you can add another child (ALT, P, I).

Move Child    Allows you to change a child's placement in the "Children" list on a Family 
Page (ALT, P, M).

Delete Individual    Allows you to remove an individual, and all of the information 
associated with that individual, from your Family File (ALT, P, D). 

Sort Children    Sorts by birth order the children listed on a single Family Page (ALT, P, S).



Picture/Object menu
Note: The commands on this menu are only available when you are in the 
Scrapbook view.    In addition, some of the commands may not be available, depending on
the type of Picture/Object that is currently selected in the Scrapbook.
Insert Photo CD Picture    Displays the Insert from Photo CD dialog box where you can 

select pictures to insert into the current Scrapbook (ALT, O, C).
Insert Picture from File    Displays the Insert from File dialog box where you can select 

pictures to insert into the current Scrapbook (ALT, O, F).
Insert Object    Displays the Insert Object dialog box where you can select items to 

insert into the current Scrapbook (ALT, O, O).
More About    Displays the More About Picture/Object dialog box where you can enter 

information, such as a caption and description, about the currently selected 
Picture/Object.    In addition, this is where you indicate to Family Tree Maker in which 
documents you may want to include the currently selected Picture/Object (ALT, O, A).

Brightness    Displays the Brightness dialog box where you can adjust the coloring for all 
of the Pictures/Objects in the currently selected Scrapbook (ALT, O, B).

Contrast    Displays the Contrast dialog box where you can adjust the coloring for the 
currently selected Picture/Object (ALT, O, N).

Edit    Allows you to open the currently selected Picture/Object for editing (ALT, O, E).    
Compression/Resolution    Allows you to open the currently selected Picture/Object and

select a new compression or resolution for it (ALT, O, R).
View    Allows you to view the currently selected Picture/Object at full size (ALT, O, V).    
Play Scrapbook    Displays each of the Pictures/Objects in the current Scrapbook in 

sequence.    You can select the amount of time that each Picture/Object is displayed 
(ALT, O, P).    



Contents menu
Items to Include    Allows you to select and de-select information to include in your 

trees, calendars, and other documents.    You can also choose the format in which 
information prints, as well as select the text style in which it prints (ALT, C, I).

Individuals to Include    Allows you to chose which individuals are included in your 
document.    This command is only available in the Labels/Cards view, the Report 
view, and for labels and cards (ALT, C, N).    

Title & Footnote    Displays a dialog box where you can create a title and footnote to 
add to trees, calendars, and other documents (ALT, C, T).

# of Generations to Show    Lets you select the number of generations for your trees 
(ALT, C, G).

Options    Displays a dialog box where you can select various printing options for trees, 
depending on the tree type (ALT, C, O).



Format menu
Tree Format    Displays a dialog box where you can select the layout and box 

connections for your trees.    With Ancestor trees you also can choose between Fit to 
Page and Custom Ancestor tree (ALT, T, F).

Scrapbook Format    Displays a dialog box where you can select the number of 
Pictures/Objects that will appear on printed Scrapbook pages (ALT, T, F).    

Maximum Width for Each Box    Allows you to limit the size of the boxes in your trees 
(ALT, T, W).

Sort    For Scrapbooks, Sort allows you to select the order in which the Pictures/Objects 
appear in the current Scrapbook.    For Custom reports, labels and cards, and Batch 
printing, Sort allows you to choose the order in which individuals print (ALT, T, S).    

Box, Line, & Border Styles    Lets you select the styles and colors for the boxes, lines, 
and borders in your documents (ALT, T, B).

Text Font, Style, & Size    Displays a dialog box where you can select the formatting for 
the text in your documents, including point size, color, font, style, and alignment.    
Not all options are available for all documents (ALT, T, T).



Prefs menu
Startup    Allows you to choose between Insert and Overwrite typing modes, as well as 

set the size of the cache available to Family Tree Maker (ALT, R, U).
Labels    Displays a dialog box where you can globally change many field labels in Family 

Tree Maker (ALT, R, L).
Dates    Lets you select the standard date format that Family Tree Maker displays in date 

fields (ALT, R, D).
Titles    Displays a dialog box where you can select default titles, such as "Mr." and "Mrs."

to use with all of the individuals in your Family File (ALT, R, T).
Fastfields    Displays a dialog box where you can choose which fields in Family Tree 

Maker act as Fastfields (ALT, R, F).
Pictures/Objects    Displays a dialog box where you can select default compression and 

resolution levels for any pictures that you import into Scrapbooks in the future (ALT, R, 
P).



FamFinder menu
Please note that this menu is only available if you have a CD-ROM version of Family Tree 

Maker.
FamilyFinder Index    Displays the FamilyFinder Index dialog box in which you can 

search an index of 150 million names for your ancestors' records (ALT, A, F).
Genealogy "How-To" Guide    Opens the Family Tree Maker Genealogy "How-To" Guide, a

Help system that guides you through the genealogy research process.    It includes a 
step-by-step guide for finding information such as birth dates, maiden names, family 
addresses, and much more.    The Genealogy "How-To" Guide also gives research tips, 
such as what to watch for in older records, how to keep a correspondence log, and 
how to use Soundex.    You'll find hundreds of addresses for libraries, genealogy 
societies, archives, and vital records offices, as well as abstracts to print for census 
records and other printable forms (ALT, A, G).



Help menu
Contents    Displays the Contents screen of the Family Tree Maker on-screen Help system

(ALT, H, C).
Search for Help on    Lets you search for a specific topic in the Family Tree Maker on-

screen Help system (ALT, H, S).
How to Use Help    Gives basic information about using an on-screen Help system (ALT, H,

H).
Family File Status    Shows you the name and size of the Family File you're working on, 

where it's located, as well as the number of individuals it contains.    You can also see 
information about your system memory, temp directory, and video driver (ALT, H, S).

About Family Tree Maker    Displays the version number and date of your Family Tree 
Maker program diskettes (ALT, H, A).



Using the mouse and keyboard
Using the mouse

Select this topic to get help about using your mouse to navigate and enter information in
Family Tree Maker.

Using the keyboard
Select this topic to get help about using shortcut keys to navigate through Family Tree 
Maker and editing keys to edit the information that you enter into Family Tree Maker.



Using the mouse
Using a mouse is one of the easiest ways to move around in Family Tree Maker.    Just click 
on a field where you want to enter or edit information.    The cursor will move to that field 
and you can start typing.    You can also use the mouse to select items from the Menu Bar 
and drop-down menus.    Just click one of the words on the Menu Bar at the top of the 
screen and then click one of the items that appears on the drop-down menu.
Another thing that you can do with your mouse is navigate through your Family File using 
trees, Kinship reports, Custom reports, and labels and cards.    In trees that have boxes, 
simply click the text in an individual's box choose another view using the pull-down menus 
or the Toolbar.    Family Tree Maker will take you to that view.    The individual whose box you
selected will now be the primary individual.    If you double-click the text in an individual's 
box, Family Tree Maker will take you to that individual's Family Page.    If you double-click a 
Picture/Object in an individual's box, Family Tree Maker will either play the object or display 
it at full size, depending on the type of Picture/Object.
You can do the same with Outline Descendant Trees, Kinship reports, Custom reports, and 
labels and cards.    Simply select an individual's name and then choose another view using 
the pull-down menus or the Toolbar.    Family Tree Maker will take you to that view.    The 
individual whose name you selected will now be the primary individual.    If you double-click 
an individual's name, Family Tree Maker will take you to that individual's Family Page.
You'll also find many different ways to use the mouse in dialog boxes.    Experiment!    Just 
try clicking an item that you want to use.



Using the keyboard
Function keys

Select this topic to get help about using the keyboard to navigate through Family Tree 
Maker.

Editing keys
Select this topic to get help about using the keyboard to edit the information you enter 
into Family Tree Maker.



Function keys

Press this To do this
Ctrl + S Display the Sources dialog box
F1 Display the Contents screen of the

Family Tree Maker on-screen Help 
system

Shift + F1 Display the on-screen Help topic 
most relevant to your current 
activity

F2 Display the Index of Individuals, a 
list of all individuals in your Family
File

F3 From the Family Page, display the 
Other Spouses dialog box for the 
current individual

F4 From the Family Page, display the 
Family Page for the parents of the 
wife

Alt + F4 Exit Family Tree Maker
F5 From the Family Page, display the 

Family Page for the parents of the 
husband

F6 From the Family Page, display the 
Family Page of either the first child
in the list, or of the child that the 
cursor is on

F8 From the Family Page, display the 
Family Page of the next sibling of 
the current individual.    The "next"
sibling is the child listed below the
current individual on the Family 
Page where the current individual 
appears as a child

Alt + F8 From the Family Page, display the 
Family Page of the previous sibling
of the current individual.    The 
"previous" sibling is the child 
listed above the current individual
on the Family Page where the 
current individual appears as a 
child

Editing keys



Press this 
key

To do this

Backspace Erase the character to 
the left of the cursor

Insert Switch back and forth 
between insert and 
overwrite modes

Delete Delete characters to the
right, one by one

Ctrl +X Cut highlighted text and
place on the Clipboard

Ctrl +C Copy highlighted text 
and place on the 
Clipboard

Ctrl +V Paste text from the 
Clipboard to where the 
cursor is located



Customizing Family Tree Maker
Startup preferences

Select this topic to get help about changing how Family Tree Maker saves your Family 
File.

Date format preferences
Select this topic to get help about selecting a default date format for the dates that you 
enter into Family Tree Maker.    You will also find information about using Double Dates.

Title preferences
Select this topic to get help about selecting a default title, such as "Mr." or "Mrs.," to use 
with the majority of the individuals in your Family File. 

Field label preferences
Select this topic to get help about changing the names of any field labels that you don't 
like, or about using LDS format field labels.

Fastfield preferences
Select this topic to get help about choosing which fields in Family Tree Maker help you 
save time by automatically filling in information for you.

Picture/Object preferences
Select this topic to get help about selecting at which resolution and compression Family 
Tree Maker will store any pictures that you bring into Family Tree Maker in the future.



Startup preferences

To set your Startup preferences:
1. From the Preferences menu, select Startup (ALT, R, U).
2. Make your selection between the Overwrite and Insert typing mode option buttons. 

Insert mode places new text in front of the old text.    Overwrite mode lets you type over 
the existing text.

3. By default, Family Tree Maker is set to protect your files from loss:    "Automatically 
backup Family File" is selected and "Allow replacing existing files" is not selected.    
There may be times, however, when you want to change these options.    Please do so 
only if you are sure you need to.    Each of the options is described below.
Automatically backup Family Files  Normally, Family Tree Maker saves an exact copy 
of your Family File when you exit the program.    The backup file has the same name as 
the original file, but with the extension *.FBK.    You can use this backup file if your 
original file is ever lost or damaged.    However, since the backup file takes up space in 
your computer's memory, you may want to de-select this option if your computer's free 
memory space is limited.    
Allow replacing existing files    Normally, Family Tree Maker does not allow you to 
replace an old file with a new file of the same name.    If you select this option, Family 
Tree Maker will only give you a warning message before it writes over an existing file.    
Any files that you elect to overwrite will be permanently lost.
To protect your Family Files as much as possible, make sure that Automatically backup
Family Files is selected and Allow replacing existing files is not selected.

3. Change the size of your cache if you would like.    
The cache is the memory where Family Tree Maker stores recently used information.    
The program will run more efficiently if you make the optimum amount of cache 
available to Family Tree Maker.    If you have large Family Files, you should have a larger 
cache, but if you have small Family Files, you should have a smaller cache.    With larger 
Family Files, a good rule of thumb for the cache size is about one-fourth of your 
computer's available memory.    The maximum cache size is four megabytes.

4. Click OK.
Startup preferences do not take effect until you exit Family Tree Maker and then restart 
the program.



Title preferences
With Family Tree Maker, you can use the Labels/Cards view to print address labels, name 
tags, rolling index cards, post cards, address book pages, and much more.    When you print
these types of items, you may often want to use titles in front of people's names, such as 
"Mr." and "Mrs."    The Title dialog box, where you can select the titles that are used with 
people's names, is described below. However, if anyone in your Family File uses a title that 
is different from everyone else's, you can enter that title in that individual's Lineage dialog 
box.    The Lineage dialog box is described in the topic "The Lineage dialog box."    For more 
general information about entering people's names into Family Tree Maker, see the topic 
Entering names.
To change title preferences:
1. From the Prefs menu, select Titles (ALT, R, T).

Family Tree Maker displays the Titles dialog box. 
2. Make your changes in the Titles dialog box.    Your options are described below.

Married Males/Married Females    The title that you type here will appear on labels 
and cards for all men and women who are currently married or have ever been married.   
The defaults are "Mr." and "Mrs." 
Not married Males/Not married Females    The title that you type here will appear on
labels and cards for all men and women who have never been married.    The defaults are
"Mr." and "Ms."
Children Males/Children Females    The title that you type here will appear on labels 
and cards for all children.    The defaults are to have no title.
Children are individuals younger than X years old    All individuals under the age 
that you type in this field will appear on labels and cards with the "Children" title.    All 
individuals this age and over will appear on labels and cards with either the "Married" or 
the "Not married" title.
Use defaults    Use this button to reset the title and the cutoff age to their default 
values.

3. Click OK when you've made your selections.
See Also
The Lineage dialog box



Date format preferences
In the Dates dialog box you can change the standard date format that appears in all of your
date fields.    The possible date formats are listed below.    You can also change the double 
date cutoff year.    If you don't want double dates to print, set the double date cutoff year to
zero.    For more general information about entering dates in Family Tree Maker, see the 
topic Entering dates.
To change date preferences:
1. From the Prefs menu, select Dates (ALT, R, D).
2. Make your changes in the Date dialog box.    
3. Click OK when you've made your selections.

Date format 
choices

July 4, 1776
Jul 4, 1776
4 July 1776
4 Jul 1776
07.04.1776
04.07.1776
07-4-1776
07/04/1776

Field label preferences
You can change field labels so that your Family Tree Maker records match other 
genealogical records that you have.    For example, you could change "Fact 1" to 
"Graduation."    There is also an option to choose field labels that conform to LDS standards.
Note:    When you're changing field labels, remember that you're changing the label for 
every individual in your Family File.    You cannot change a field label for only one 
individual.
To change field labels:
1. From the Prefs menu, select Labels (ALT, R, L).
2. Type over the old labels with your new, preferred labels.
3. To make field labels conform to LDS standards, select the LDS format option.    

Selecting this option will affect the way Family Group Sheets are printed as well. 
4. Click OK when you've made your changes.
To restore field labels to their initial values, select Reset labels to defaults.



Fastfield preferences 
In the Fastfields dialog box, Family Tree Maker allows you to choose which fields work as 
Fastfields.    This way, if you are not comfortable using Fastfields, you can turn them off.    
To change Fastfields preferences:
1. From the Prefs menu, select Fastfields (ALT, R, F).

Family Tree Maker displays the Fastfields dialog box.
2. Select the check boxes for the fields that you want to act as Fastfields, or deselect the 

fields that you don't want to act as Fastfields.    Click All to select all of the check boxes.
Click None to deselect all of the check boxes.

3. Click OK when you've made your selections.



Picture/Objects preferences
In the Preferences for Scrapbook dialog box, you can set a default degree of compression 
and resolution for any pictures that you bring into Scrapbooks.    After you set a default, you
can still change the settings for individual pictures at any time.    In addition, you can 
change the default settings at any time.    For more general information about Scrapbooks, 
see the topic Entering information in Scrapbooks.
To set default compressions and resolutions for pictures:
1. From the Prefs menu, select Pictures/Objects (ALT, R, P).

Family Tree Maker displays the Change Compression/Resolution dialog box.
2. You can now select the default compression and/or resolution.    Each of your options is 

described below.
Degree of Compression    Select the option button corresponding to the degree of 
compression that you want for your picture.    Higher ratios give you a greater loss in 
picture quality, but the pictures will take up less space on your hard disk.    (Family Tree 
Maker uses the industry standard JPEG compression method.)    Lower ratios give you 
pictures with less loss in quality, but will take up the most disk space.    The "1:1" setting 
will not reduce the quality of your picture at all, but will take up the most space on your 
hard disk.    In general, the "Recommended" setting is a good balance between quality 
loss and disk space.    
Photo CD    This option is only available for Kodak Photo CD Pictures.    Select the option 
button corresponding to the resolution that you want for your picture.    "Resolution" 
refers to the size of your picture.    A higher resolution will create a larger picture, and a 
larger picture will be sharper and have more detail.    If the default resolution that you 
choose here is not available for one of the images that you import, Family Tree Maker will
import it at the next available lower resolution.    
Choosing resolutions higher (larger) than the recommended "256 x 384" will use up large
amounts of your hard disk space.    In addition, you may not be able to load a picture at a
very high resolution if your computer does not have a sufficient amount of RAM 
(memory).    See the topic "Picture Size and Your Computer," for more information.

3. Click OK when you've made your selections.
Family Tree Maker remembers your selections until you change them again.    

See Also
Picture size and your computer



Other information
Technical support

Select this topic to get help about contacting Banner Blue Software's technical support 
lines.

Family File Status
Select this topic to get help about the size of your Family File.

System information
Select this topic to get help about your computer's setup and available resources.

The README file
Select this topic to get information reading the README file, which contains last-minute 
information that didn't make it into the program manual.

The Data Exchange Utility (DEU)
Select this topic to get help about using the Data Exchange Utility with Family Tree Maker
for Windows.

Genealogy research sources
Select this topic to get help about researching your family.

Preserving photos
Select this topic to get help about safeguarding your precious family photographs.

Picture size and your computer
Select this topic to get help about the resources that are required to import pictures into 
Scrapbooks



Technical support
If you have problems using Family Tree Maker, take these steps in the order listed:
1. Check the Index of your manual for the subject you need help with, and then read the 

appropriate pages.    You can also check the Contents of the Family Tree Maker on-
screen Help system.

2. Consult Appendix E, "Troubleshooting," in your manual.    This section describes how to 
solve common problems.

3. Call Banner Blue Technical Support.
Call while you're at your computer.    It's also useful to have information about your 
printer and monitor handy, as well as the release date of your software.    To find the 
release date, from the Help menu, select About. 
The Banner Blue Technical Support lines are open Monday through Friday, 8:00 AM to 
5:00 PM, Pacific time.    Call 510-794-6850 and ask for Technical Support.    

The Technical Support phone number is for questions dealing specifically with using Family 
Tree Maker.    The person you speak to will not have information on Microsoft Windows or 
conducting genealogical research.    For help with Windows, consult your Windows manual.   
For help with genealogical research, consult Appendix A of your manual or your local 
library, historical society, or genealogical society. 



Family File Status
The Family File Status dialog box contains information about the number of individuals in 
your Family File.    If you call our technical support lines, this is information that technical 
support may ask for.    
To display the Family File Status dialog box:
 From the Help menu, select Family File Status (ALT, H, F).

Family Tree Maker displays the Family File Status dialog box.

When you're finished looking at the information, click OK.



System information
System Information is a dialog box that gives you information about the environment that 
you're working in, such as the amount of memory available to your computer and the 
display type.    It also tells you the size and location of your Family File.    If you call our 
technical support lines, this is information that technical support may ask for.    
To display the System Information dialog box:
 From the Help menu, select System Information (ALT, H, I).

Family Tree Maker displays the System Information dialog box.
The Run option on this dialog box also allows you to access standard Windows system 
editors.

When you're finished using this dialog box, click OK.



Genealogy research sources
Note:     These addresses and phone numbers were verified at the time of this 
manual's printing.    It is possible that they have since changed.    If you have trouble 
reaching any of these places,    dial 1+ (area code) + 555-1212 for information.

National Sources
African-American Genealogy Group, P.O. Box 1798, Philadelphia, PA, 19105, (215) 572-
6063
Afro-American Historical and Genealogical Society, Inc., P.O. Box 73086, Washington, DC 
20056
Local History and Genealogy Reading Room, Library of Congress Annex, 1st St. & 
Independence Ave. SE, Washington, DC 20540-5554, (202) 707-5537
National Archives and Records, Records Administration, 7th and Pennsylvania Ave., 
Washington, DC 20408, (202) 501-5402
National Genealogical Society, 4527 Seventeenth Street North, Arlington, VA 22207-
2399, (703) 525-0050
National Society of Daughters of the American Revolution, 1776 D Street, NW, 
Washington, DC 20006-5392, (202) 628-1776 

State Sources 
Alabama

Alabama Archives and History Dept., 624 Washington Ave., Montgomery, AL 36130, (205)
242-4152

Alaska
Alaska Historical Collections, P.O. Box 110571, Juneau, AK 99811-0571, (907) 465-2925
Kenai Community Library, 163 Main St. Loop, Kenai, AK 99611, (907) 283-4378

Arizona
Arizona Dept. of Library Archives & Public Records, 1700 W. Washington St., Phoenix, AZ 
85007, (602) 542-3942
Arizona State Genealogical Society, 500 S. Langley, Tucson, AZ 85710, (602) 298-0905

Arkansas
Arkansas History Commission, One Capital Mall, Little Rock, AR 72201, (501) 682-6900

California
California Genealogical Society, P.O. Box 77105, San Francisco, CA 94107-0105, (415) 
777-9936
California Historical Society, 2909 Pacific Ave., San Francisco, CA 94109, (415) 567-1848
California State Archives, 201 N. Sunrise Ave., Roseville, CA 95661, (916) 773-3000
California State Library, 914 Capitol Mall, Sacramento, CA 95814, (916) 654-0261
Los Angeles Westside Genealogical Society, P.O. Box 10447, Marina del Rey, CA 90295
Napa Valley Genealogical & Biographical Society, P.O. Box 385, Napa, CA 94559, (707) 
252-2252
Orange County Genealogical Society, 7111 Talbert Ave., Huntington Beach, CA 92648
San Diego Genealogical Society, 2925 Kalmia St., San Diego, CA 92104, (619) 284-7017



San Luis Obispo Genealogical Society, Inc., P.O. Box 4, Atascadero, CA 93423-0004
Southern California Genealogical Society, P.O. Box 4377, Burbank, CA 91503, (818) 843-
7247
Sutro Library, 480 Winston Drive, San Francisco, CA 94132, (415) 731-4477

Colorado
Colorado Genealogical Society, P.O. Box 9218, Denver, CO 80209, (303) 571-1535
Colorado State Archives and Public Records, 1313 Sherman St., Rm. 1B-20, Denver, CO 
80203, (303) 866-2390

Connecticut
Connecticut State Library, 231 Capitol Ave., Hartford, CT 06106, (203) 566-3692
The Stamford Historical Society, 1508 High Ridge Rd., Stamford, CT 06903, (203) 329-
1183

Delaware
Delaware Genealogical Society, 505 Market Street Mall, Wilmington, DE 19801, (302) 
995-2783
Historical Society of Delaware, 505 Market Street Mall, Wilmington, DE 19801, (302) 655-
7161

Florida
Miami-Dade Public Library, Genealogy Dept., 101 West Flagler St., Miami, FL 33130, 
(305) 375-5580
State of Florida, Bureau of Archives, Tallahassee, FL 32399-0250, (904) 487-2073
Tampa Public Library Special Collections, 900 North Ashley Dr., Tampa, FL 33602, (813) 
273-3628

Georgia
Atlanta History Center, 3101 Andrews Dr. NW, Atlanta, GA 30305, (404) 814-4000
Georgia Department of Archives and History, 330 Capitol Ave., Atlanta, GA 30334, (404) 
656-2350

Hawaii
Hawaii State Library, 478 S. King St., Honolulu, HI 96813, (808) 586-3500
Hawaiian Historical Society, 560 Kawaiahao St., Honolulu, HI 96813, (808) 537-6271

Idaho
Idaho Genealogical Society, 325 W. State St., Boise, ID 83705-2867, (208) 384-0542
Idaho State Historical Society Genealogical Library, 450 North 4th St., Boise, ID 83702-
6027, (208) 334-2305

Illinois
Chicago Genealogical Society, P.O. Box 1160, Chicago, IL 60690, (312) 725-1306
Illinois State Archives, Archives Bldg., Springfield, IL 62756, (217) 782-4682
Illinois State Genealogical Society, P.O. Box 10195, Springfield, IL 62791, (217) 789-1968 
Illinois State Historical Library, Old State Capitol, Springfield, IL 62701, (217) 524-7216

Indiana
Allen County Public Library, 900 Webster St., Ft. Wayne, IN 46801, (219) 424-7241
Indiana Historical Society, 315 West Ohio Street, Indianapolis, IN 46202, (317) 232-1882



Indiana State Library, 140 North Senate Ave., Indianapolis, IN 46204, (317) 232-3675
Iowa

State Historical Society of Iowa, 600 East Locust St., Des Moines, IA 50319, (515) 281-
6200

Kansas
Kansas State Historical Society, 120 West 10th, Topeka, KS 66612, (913) 296-4774
Kansas State Historical Society Library, 120 West 10th, Topeka, KS 66612, (913) 296-
4775
Midwest Historical & Genealogical Library, 1203 N. Main St., Wichita, KS 67212, (316) 
264-3611 (open Tuesday & Saturday)

Kentucky
Kentucky Historical Society, P.O. Box H, Frankfort, KY 40602, (502) 564-3016
Kentucky State Library and Archives, 300 Coffee Tree Rd., P.O. Box 537, Frankfort, KY 
40602-0537, (502) 875-7000

Louisiana
Louisiana Genealogical and Historical Society, P.O. Box 3454, Baton Rouge, LA 70821
Louisiana State Library,    760 N. 3rd St., Baton Rouge, LA 70802, or P.O. Box 131, Baton 
Rouge, LA 70821-0131, (504) 342-4914

Maine
Maine Historical Society, 485 Congress Street, Portland, ME 04101, (207) 774-1822
Maine State Library, Cultural Building, State House Station 64, Augusta, ME 04333, (207) 
287-5600

Maryland
Maryland Genealogical Society, 201 West Monument St., Baltimore, MD 21201, (410) 
685-3750
Maryland Historical Society, 201 West Monument St., Baltimore, MD 21201, (410) 685-
3750

Massachusetts
Massachusetts Historical Society, 1154 Boylston St., Boston, MA 02215, (617) 536-1608
Massachusetts State Library, State House, Rm. 341, Boston, MA 02133, (617) 727-2590
New England Historic Genealogical Society, 101 Newbury Street, Boston, MA 02116, 
(617) 536-5740

Michigan
Archives and Regional History Collections, Western Michigan University, Kalamazoo, MI 
49008-5081, (616) 387-8490
Detroit Public Library, Burton Historical Collections, 5201 Woodward Ave., Detroit, MI 
48202, (313) 833-1480
Michigan State Library, 717 W. Allegan St., P.O. Box 30007, Lansing, MI 48909, (517) 373-
5400

Minnesota
Minnesota Genealogical Society, P.O. Box 16069, St. Paul, MN 55116, (612) 645-3671
The Prairieland Genealogical Society, Southwest State University, Marshall, MN 56258

Mississippi



Mississippi Dept. of Archives and History, P.O. Box 571, Jackson, MS 39205, (601) 359-
6876
Mississippi Genealogical Society, P.O. Box 5301, Jackson, MS 39236-5301

Missouri
Heart of America Genealogical Society, c/o Public Library, 311 East 12th St., Kansas City, 
MO 64106, (816) 221-2685
Missouri State Genealogical Association, 4302 Barth Drive, St. Louis, MO 63125

Montana
Montana Historical Society Foundation, P.O. Box 863, Helena, MT 59624, (406) 449-3770
Yellowstone Genealogy Forum, c/o Parmly Billings Library, 510 North Broadway, Billings, 
MT 59101, (406) 657-8257

Nebraska
Eastern Nebraska Genealogical Society, c/o Clare Mares, 1722 E. 19th St., Fremont, NE 
68025, (402) 721-9553
Nebraska State Historical Society Library, P.O. Box 82554, Lincoln, NE 68501, (402) 471-
4751

Nevada
Nevada Historical Society, 1650 N. Virginia, Reno, NV 89503, (702) 688-1190
Northeastern Nevada Genealogical Society, P.O. Box 1903, Elko, NV 89801

New Hampshire
New Hampshire Historical Society Library, 30 Park Street, Concord, NH 03301, (603) 225-
3381
New Hampshire State Library, 20 Park Street, Concord, NH 03301, (603) 271-2144

New Jersey
New Jersey State Archives, 185 West State Street, CN 307, Trenton, NJ 08625, (609) 292-
6260
New Jersey State Library, 185 West State Street, CN 520, Trenton, NJ 08625, (609) 292-
6220

New Mexico
Albuquerque Public Library, Special Collections Branch, 423 Central Ave. NE, 
Albuquerque, NM 87102, (505) 848-1376.
New Mexico Genealogical Society, P.O. Box 8283, Albuquerque, NM 87198
New Mexico State Library, 325 Don Gasper, Santa Fe, NM 87503, (505) 827-3800

New York
The Brooklyn Historical Society, 128 Pierrepont St., Brooklyn, NY 11201, (718) 624-0890
Buffalo and Erie County Public Library, Laffayette Square, Buffalo, NY 14203, (716) 858-
7103
Central New York Genealogical Society, P.O. Box 104, Covin Sta., Syracuse, NY 13205
New York Genealogical and Biographical Society, 122 East 58th Street, New York, NY 
10022-1939, (212) 755-8532
New York State Historical Association, P.O. Box 800, Cooperstown, NY 13326, (607) 547-
2509
New York State Library & Cultural Education Center, Empire State Plaza, Seventh Floor, 



Albany, NY 12230, (518) 474-5355
North Carolina

The North Carolina Genealogical Society, P.O. Box 1492, Raleigh, NC 27602
North Carolina State Library, 109 East Jones Street, Raleigh, NC 27601-2807, (919) 733-
7222

North Dakota
State Historical Society of North Dakota, 612 East Blvd., Bismarck, ND 58505-0830, (701)
224-2666

Ohio
Ohio Genealogical Society, 34 Sturges Ave., P.O. Box 2625, Mansfield, OH 44906, (419) 
522-9077
Ohio Historical Society Library, 1982 Velma Avenue, Columbus, OH 43211, (614) 297-
2510
Ohio State Library, c/o Genealogy Section, Rm. 308, 65 South Front Street, Columbus, OH
43266-0334, (614) 644-6966
Warren-Trumbull County Public Library, History & Genealogy Room, 444 Mahoning Ave. 
NW, Warren, OH 44483, (216) 399-8807

Oklahoma
Oklahoma Historical Society, 2100 N. Lincoln Blvd., Oklahoma City, OK 73105-4997, 
(405) 521-2491

Oregon
Multnomah County Library, 801 SW 10th Ave., Portland, OR 97205, (503) 248-5234
Oregon Genealogical Society, 223 North A St., Suite F, Springfield, OR 97477, (503) 746-
7924 (answering machine, Monday & Friday, 10 - 2)
Oregon State Library, State Library Building, Salem, OR 97310, (503) 378-4277

Pennsylvania
Carnegie Library, Pennsylvania Dept., 4400 Forbes Ave., Pittsburgh, PA 15213, (412) 622-
3154
Pennsylvania Genealogical Society, 1300 Locust Street, Philadelphia, PA 19107, (215) 
545-0391
Pennsylvania State Archives, P.O. Box 1026, Harrisburg, PA 17108-1026, (717) 783-3281
State Library of Pennsylvania, P.O. Box 1601, Harrisburg, PA 17105, (717) 783-5991 
(answering machine only)

Rhode Island
Rhode Island State Archives, 337 Westminster St., Providence, RI 02905, (401) 277-2353
Rhode Island State Historical Society Library, 121 Hope St., Providence, RI 02906, (401) 
331-8575

South Carolina
South Carolina Historical Society, 100 Meeting Street, Charleston, SC 29401, (803) 723-
3225
South Carolina State Archives, 1430 Senate St., P.O. Box 11669, Columbia, SC 29211, 
(803) 734-8596
South Carolina State Library, 1500 Senate Street, P.O. Box 11469, Columbia, SC 29211, 
(803) 734-8666



South Dakota
State Historical Society, 900 Governors Dr., Pierre, SD 57501-2217, (605) 773-3458
Tri-State Genealogical Society, 905 Fifth Avenue, Bell Fourche, SD 57717

Tennessee
Tennessee Genealogical Society, P.O. Box 111249, Memphis, TN 38111-1249, (901) 327-
3273
Tennessee State Library and Archives, 403 7th Avenue North, Nashville, TN 37243, (615) 
741-2764

Texas
Texas State Library, Box 12927, Austin, TX 78711, (512) 463-5455

Utah
Family History Library, 35 North West Temple Street, Salt Lake City, UT 84150, (801) 240-
2364
Utah Genealogical Association, P.O. Box 1144, Salt Lake City, UT 84110, (801) 241-4196

Vermont
Genealogical Library, Bennington Museum, West Main St., Bennington, VT 05201, (802) 
447-1571
Vermont Historical Society, Pavilion Office Bldg., 109 State Street, Montpelier, VT 05609-
0901, (802) 828-2291

Virginia
Central Rappahannock Regional Library, 1201 Caroline St., Fredericksburg, VA 22401-
3798
College of William and Mary, Earl Gregg Swem Library, Williamsburg, VA 22903-2498
George M. Jones Library Association, Jones Memorial Library, 2311 Memorial Ave., 
Lynchburg, VA 24501
Handley Library P.O. Box 58 100 West Picadilly St., Winchester, VA 22604
Jefferson-Madison Regional Library, 201 East Market St., Charlottesville, VA 22902-5287
Lloyd House, 220 N. Washington St., Alexandria, VA 22314
Norfolk Public Library, Kirn Memorial Library, 301 East City Hall Avenue, Norfolk, VA 
23510-1775
Thomas Balch Library, 208 West Market Street, Leesburg, VA 22075
University of Virginia, Alderman Library, Charlottesville, VA 22903-2498
Virginia Historical Society, P.O. Box 7311, Richmond, VA 23221-0311, (804) 358-4901
Virginia Room, Fairfax City Regional Library, 2915 Chain Bridge Road, Fairfax, VA 22030
Virginia State Library, 11th St. at Capitol Square, Richmond, VA 23219, (804) 786-2306

Washington
Seattle Genealogical Society, 1405 5th Avenue, Ste. 210, P.O. Box 1708, Seattle, WA 
98111, (206) 682-1410
Washington State Library, P.O. Box 42475, Olympia, WA 98504-2475, (206) 753-4024

West Virginia
West Virginia Historical Society, Cultural Center, 1900 Kanewha Blvd E., Charleston, WV 
25305-0300, (304) 558-0220



Wisconsin
Milwaukee Public Library, 814 West Wisconsin Ave., Milwaukee, WI 53233-2385, (414) 
278-3000
Wisconsin Genealogical Society, c/o Mrs. John Irvin, 2109 20th Ave., Monroe, WI 53566, 
(608) 325-2609
Wisconsin Jewish Genealogical Society, 9280 N. Fairway Dr., Milwaukee, WI 53217
Wisconsin State Historical Society Library, 816 State St., Madison, WI 53706, (608) 264-
6534

Wyoming
Department of Commerce, Historical Research Unit, Barrett Bldg., 2301 Central Avenue, 
Cheyenne, WY 82002, (307) 777-7018

Canadian Sources
Archives Nationales du Québec, Service Au Public, P.O. Box 10450, 1210 Avenue du 
Seminaire, Saint-Foy, Qué., G1V4N1, (418) 643-1322
Archives of Ontario, 77 Grenville St., Queen's Park, Toronto, Ont., M7A 2R9, (416) 327-
1600
National Archives of Canada, 395 Wellington St., Ottowa, Ont., K1A 0N3, (613) 995-5138
Northwest Territories Archives, Department of Educational, Cultural, & Employment 
Programs, Government of the Northwest Territories, Yellowknife, N.W.T., X1A 2L9, (403) 
873-7698
Provincial Archives of Alberta, 12845    102 Ave., Edmonton, Alba., T5N 0M6, (403) 427-
1750
Provincial Archives of British Columbia, 655 Belleville St., Victoria, B.C., V8V 1X4, (604) 
387-5885
Provincial Archives of Manitoba, 200 Vaughan St., Winnipeg, Man., R3C 1T5, (204) 945-
3971
Provincial Archives of New Brunswick, P.O. Box 6000, Fredericton, N.B., E3B 5H1, (506) 
453-2122
Provincial Archives of Newfoundland and Labrador, Colonial Building, Military Road, St. 
John's Nfld., A1C 2C9, (709) 729-3065
Public Archives, 6016 University Ave., Halifax, N.S., B3H 1W4, (902) 424-6060
Public Archives of Prince Edward Island, P.O. Box 1000, Charlottetown, P.E.I., C1A 7M4, 
(902) 368-4290
Saskatchewan Archives Board, Regina Office, University of Regina, Regina, Sask., S4S 
0A2, (306) 787-4068
Saskatchewan Archives Board, Saskatoon Office, University of Saskatchewan, Saskatoon,
Sask., S7N 0W0, (306) 933-5832
Yukon Archives, P.O. Box 2703, Whitehorse, Y.T., Y1A 2C6, (403) 667-5321



Preserving photos
For more than a century, people have enjoyed the ability to capture a special moment in 
time with a photograph.    People enjoy seeing pictures of their parents and grandparents 
when they were young.    Many take it for granted that their children and grandchildren will 
someday enjoy the pictures they take today.    
However, you probably have experienced yellowing, cracking, and fading of some of your 
photographs.    Still others are destroyed or simply lost.    Although some photographs last 
for generations, none of them are immune to the effects of time.    This appendix provides 
tips that can help you preserve your photographic treasures.

What A Photograph Is Made Of
Photographs are made up of several layers of materials.    The top layer contains the image 
suspended in gelatin (purified animal protein).    It is called the emulsion layer.    This layer is
coated on to a base layer of photographic paper or film.    A middle layer of adhesive is 
used to make the emulsion stick to the base.    
The materials used to form the image depend on the type of photograph.    The image for 
black and white photographs is made up of light-sensitive silver salts (silver halides).
Color photographs and slides are made up of dyes instead of silver deposits.    Like all dyes, 
those used in photography fade and/or change color over time.    Since most of the 
photographs taken today are made in color, researchers continue to work on dye stability.    
With proper care you can expect your color prints to last for decades, but in general, they 
do not preserve as well as black and white images.

Causes Of Deterioration
Many factors can contribute to the deterioration of photographs.    Since photos are made 
up of layers of material, damage to any one layer can ruin the image.    Often, it is a 
combination of factors causing the damage.    The following are some of the most 
destructive influences.
High temperature and relative humidity
These factors by themselves are damaging and together they are the most destructive 
factors that affect photographs.    Temperatures above 70F and relative humidity above 
60% for long periods should be avoided.    Daily, drastic temperature changes (such as 
occur in an attic) and continuously damp areas (such as basements) should also be 
avoided.    At the other extreme, very low humidity, under 25%, is also damaging.    It 
causes the emulsion layer to crack and the base material to curl.    
Because the emulsion layer is composed of organic materials (the gelatin), heat and high 
humidity promote the growth of mold and fungi on it.    The gelatin also softens and 
becomes sticky as it begins to retain moisture.    Heat and humidity also make base 
materials deteriorate quickly.    Cold temperatures (refrigeration) are preferable, especially 
for color photos, but only if humidity can also be controlled.    Standard refrigerators have a 
high relative humidity and are NOT a good place to store photographs.    Air-conditioning 
used with a dehumidifier helps control the effects of temperature and humidity when 
refrigeration is not an option.
Residual processing chemicals
Damaging chemicals can be left on photographs if they are not processed correctly.    In 
black and white photographs, these chemicals are made up of sulfur and silver compounds 
which react with the silver of the image to turn it a yellowish brown color.    Over time, the 
silver compounds can become silver sulfide which will not only discolor the photograph, but
also fade the image.    Residual chemicals also increase the effect of external influences 
such as heat and humidity.    For these reasons it is important that you have your film 



developed by reputable professionals or, if you develop your own, that you follow 
processing procedures precisely as the manufacturer suggests.
Air pollutants
All kinds of airborne substances can be damaging to photographs.    Those people living in 
cities with high pollution levels will find this especially true.    Oxidizing gases containing 
sulfur compounds, paint and varnish fumes, cleaning agents (chlorine and ammonia), 
tobacco smoke, auto exhaust, salty sea air, and dust are some of the most troublesome 
pollutants.    Photos should not be stored in areas where these pollutants are present.    For 
example, avoid closets that also contain cleaning products and remove photos from rooms 
freshly painted with an oil based paint for at least a month (latex paint is safe).
Nitrate based film
This type of film base was common in the early 1900s.    It is relatively unstable and 
decomposes rapidly.    It is also flammable and in large quantities is considered a fire 
hazard.    During decomposition it produces oxidizing gases such as nitric oxide and 
nitrogen dioxide.    These by-products of decomposition also speed up the decomposition 
process and are damaging to other negatives and photographs that may be stored near 
them.    If possible, have pictures on nitrate based film converted to newer, safer film.    At 
the very least, store nitrate based film away from your other photographs.
Ultraviolet light
Direct sunlight and fluorescent light can be very damaging to the image on a photograph.    
This is particularly true of the dyes in color photos which will fade rapidly when exposed to 
light.    For all types of photographs, it is best to avoid prolonged exposure to direct sunlight
and to use ultraviolet filters on fluorescent lights.    Tungsten lights are much safer than 
fluorescent lights.
Mishandling
Much of the damage to photos comes from the way we handle them.    Always try to avoid 
touching the emulsion surface.    Some other obvious things to avoid are bending, cutting, 
or scratching photographs.    Less obvious dangers are such common household items as 
ink, staples, paper clips, glue, and tape.    These products all contain substances harmful to 
photographs.    The next section (Proper Storage Methods and Materials) will list products 
safe to use with photographs.
Natural Disasters
There are a few things you can do to protect your photographs from flood, fire, and other 
natural disasters.    Storing them up off the floor is relatively simple and can help 
tremendously in case of minor flooding.    Storage in an enameled steel file cabinet can 
prevent photographs from being crushed and offers some safety from water and fire 
damage.    You may want to consider a safe deposit box for extremely valuable 
photographs.    It is also wise to give copies of special photographs to relatives to avoid 
having them all in one place in case of a disaster.

Proper Storage Methods and materials
In addition to avoiding the conditions mentioned in the previous section, using specialized 
storage methods and materials helps prolong the life of photographs.    The storage 
environment is very important.    Heat, relative humidity, light, and air pollutants should be 
maintained as close to acceptable levels as possible.    The two places photographs are 
most often stored, attics and basements, do not provide the best conditions.
When storing prints and negatives, a general rule is never store them in contact with one 
another.    Prints and negatives can stick to each other.    Also, any print with residual 
processing chemicals could affect the prints around it as it begins to decay.    Each should 
be stored in a separate paper or plastic enclosure.    If you have mounted prints, be sure to 
place a sheet of paper or plastic (interleaving sheets) between them during storage.    The 
prints and negatives within their enclosures can be stored in acid-free storage boxes on a 



shelf or in enameled steel file cabinets.    
If you prefer the convenience of a photograph album, take great care in choosing it.    
Ironically, many mass produced photograph albums are made from photo-damaging 
materials.    Albums can be safe if made of proper materials.    
On the next page is a list of dos and don'ts when choosing storage materials and locations. 
Also, the next section lists the names of two catalogs where you can order the proper 
materials.    You should also be able to find these materials in photographic supply stores.

Sources Of Safe Storage And Display Materials
Light Impressions, P.O. Box 940, Rochester, NY 14603-0940,    (800) 828-6216
Archival Quality Materials, University Products Inc., P.O. Box 101, 517 Main Street, Holyoke, 
MA 01041, (800) 628-1912

Additional Preservation Techniques
Another method for preserving your photographs is to have copies made of them while 
they are still in good condition.    It is also wise to display these copies instead of the 
originals.
For black and white photographs, toned prints tend to be more stable.    The toning process 
changes the metallic silver of the image to a form that is more resistant to oxidizing gases.  
The toning is performed during the developing process and results in the photograph 
having a brownish or purplish tone to it.    This process is not recommended for old prints.
For color prints, consider having black and white negatives and prints made since these 
tend to last longer.    There is a method which produces black and white separation masters.
These separate the different layers of color into a black and white format which can be 
recombined and colored at a later time if desired.    However, this procedure is costly and 
difficult.
As you can see, there are several relatively simple things you can do to help your 
photographs last longer.    By carefully choosing the mounting materials, storage materials, 
and storage location for your photographs, you can preserve memories for generations to 
enjoy.
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The README file
The README file contains last minute information that couldn't be included in the manual.   
The README file is in the form of a Help system, just like the file that you're reading right 
now.    It was installed in the same directory as Family Tree Maker, and is called 
README.HLP.    To see the README file, return to the program manager and double-click the
FTW Read Me icon.



The Data Exchange Utility (DEU)
The Data Exchange Utility is no longer needed to export information to GEDCOM and to 
import information from GEDCOM.    Family Tree Maker for Windows can do this 
automatically.    "GEDCOM Import and Export" gives instructions on transferring data 
between Family Tree Maker and GEDCOM.
See Also
GEDCOM Import and Export



Picture size and your computer
Family Tree Maker cannot import a Kodak Photo CD picture file that is larger than the 
amount of physical RAM available on your machine.    Physical RAM refers to the size of the
memory chips that are in your computer.    Keep in mind that once Windows is running, 
some of your computers physical RAM is already in use and is not available for importing 
pictures.
The higher the resolution of a particular picture, the larger the picture file will be.    If your 
machine is unable to handle a picture at a higher resolution, try importing it at a lower 
resolution.    Please note that the compression that you choose for a picture does not affect 
whether or not Family Tree Maker can import it.    This is because compression takes place 
after a picture has been imported.    
The table on the next page should give you an idea of approximate picture sizes before 
compression.    For example, if you wanted to import a picture at the 1024 x 1536 
resolution, you would need 4.7 MB of physical RAM available, no matter what compression 
you chose for the picture.    Please keep this limitation of your computer hardware in mind 
when you work with Kodak Photo CD pictures.    

Photo CD Picture 
Resolution

Approximate 
Required Physical 
RAM

64 x 96 (thumbnail) 36K
128 x 192 73K
256 x 384 
(recommended)

295K

512 x 768 1.2 MB
1024 x 1536 4.7 MB
2048 x 3072 18.9 MB

The Merge Fields dialog box
When you have entered the same person twice, Family Tree Maker attempts to merge that 
person's information together.    In this process, occasionally Family Tree Maker will have to 
ask you which of two sets of information is correct.    In this case, Family Tree Maker will 
display the Merge Fields dialog box.    When it appears, select the information that you want
to keep in your Family File.    Family Tree Maker will discard the incorrect information.



When your report is too big
Your report may become too big for different reasons.    For example, you may have 
included too much information in the report.    If Family Tree Maker displays this error 
message, try the following:
 Use the Items to Include in Reports dialog box to reduce the number of items that you 

have selected to include in the report.
 Reduce the size of the font that you have selected for your report.





Backup file
A backup is an exact copy of your Family File, but with a slightly different name.    The 
backup is stored separately from the Family File that you regularly work with, either on your
computer's hard disk or on a floppy disk.    Making regular backup copies of your Family File 
can help ensure that you won't loose all of your genealogical information if something ever 
happens to the Family File that you work with regularly.    It's a good idea to save as 
frequently as once every half hour, you never know when you will have a power failure!



Family File
A Family File is where Family Tree Maker stores all of the information that you enter about 
your family.    Each Family File will contain multiple Family Pages with information about 
multiple nuclear families.    



Family Page
The Family Page is where you enter basic information, such as a name and birth date, 
about each individual in your family.    Each nuclear family (two parents and their children) 
in your Family File has a Family Page.    In addition, each person in your Family File appears 
on two Family Pages:    each individual is shown as a child on his or her parents' Family Page
and also as an adult on his or her own Family Page.



Nuclear family
A nuclear family is simply two parents and their children.    Your entire family is made up of 
several nuclear families, and each nuclear family has its own Family Page.



Fields
Fields are the places in Family Tree Maker where you enter information. For example, the 
Family Page consists of several fields where you enter the names of a husband, a wife, and 
their children, as well as all of their birth dates.    You type information into the fields and 
then move from field to field using Tab, Enter, the cursor keys, or by clicking on the field 
with your mouse pointer.    Some fields only allow you to enter certain kinds of information.   
For example, date fields only allow you to enter a date, the word "unknown,'' or a question 
mark.    



Sibling
A sibling is an individual's brother or sister.    Siblings should be listed in the same 
"Children" list if they were born to the same parents.



ASCII
ASCII files are generic text files that many programs can read and create.    DOS programs 
create PC-8 files, while Windows programs create ANSI files.    Check the manual of your 
other program to see if and how you can export your information to an ASCII file.    Look 
under "ASCII," "PC-8," "ANSI," or "Export" in the index of the other manual.



Clipboard
The clipboard is a temporary storage space in Windows.    When you use an editing 
command like Copy, Windows stores the copied    information on the Clipboard.    You can 
then paste the information from the Clipboard to another location.    A piece of information 
stays on the Clipboard until you cut or copy new information to it.



Primary individual
In a family tree, the primary individual is the main individual in the tree.    For example, in a 
Descendant tree, the primary individual is the individual at the top of the tree from whom 
everyone else in the tree descends.      



Ancestor tree
Ancestor trees (sometimes called "pedigree" trees) show the family roots for any individual.
For example, if you created your own Ancestor tree, it would show your two parents, four 
grandparents, eight great-grandparents, and so forth.    In Family Tree Maker, you can 
choose to create a Fit to Page Ancestor tree to get a one page tree, or instead, choose a 
Custom Ancestor tree to get a multiple page tree.



Descendant tree
Descendant trees show where everyone fits in the family.    Starting with a relative in the 
distant past, a Descendant tree moves to the present, showing the primary individual's 
children, grandchildren, great-grandchildren and so on, generation by generation.    



Outline Descendant tree
Outline Descendant trees, like Descendant trees, show where everyone fits in the family.    
Starting with a relative in the distant past, an Outline Descendant tree moves to the 
present, showing the primary individual's children, grandchildren, great-grandchildren and 
so on, generation by generation.    
The difference between an Descendant tree and an Outline Descendant tree is that Outline 
Descendant trees don't use boxes to display each individual's information.    Instead, the 
information is displayed in outline format, with each individual on a separate line, and each 
generation indented slightly more than the one before it.



Standard (Ahnentafel) numbers
Ahnentafel numbers are a numbering scheme used to identify each individual in a family 
tree.    The formula states that an individual's father is twice that individual's number, and 
an individual's mother is twice that individual's number plus 1.    If your Ahnentafel number 
is 1, your father's number is 2, and your mother's is 3.



Civil and Canon relationships
When you're in a Kinship report, you can see two columns labeled "Civil" and "Canon."    
These words, "Civil" and "Canon" refer to the degree of a relationship.    The degree of a 
relationship is a legal term.    It refers to the number of "steps" between two people who are
related by blood.    
Canon law is used in most of the United States.    It measures the maximum number of 
steps from the nearest common ancestor.    For example, you would be 2 direct steps 
away from your fist cousin because your nearest common ancestor is one of your 
grandparents.    So in this case, the degree is 2.
The degree in civil law represents the total number of steps through the blood line that 
separate two individuals.    For example, there are 2 steps from you to your grandparent,
and then 2 more steps back down to your first cousin, so the degree is 4.



Double dates
The practice of double dating resulted from the switch from the Julian to the Gregorian 
calendar.    The Julian calendar declared March 25 as the first of the year, and a solar year 
to be 365 days and 6 hours long.    In 1582, Pope Gregory XIII determined that the Julian 
calendar was off by 11 minutes and 14 seconds.    The new Gregorian calendar resolved the
discrepancy and declared January 1 as the first of the year.    
Not all countries accepted this calendar at the same time.    In fact, England and the 
American colonies didn't accept it until 1752.    Before that date, the government observed 
March 25 as the first of the year, but most of the population observed January 1 as the first 
of the year.    So, many people included both years when writing dates falling between 
January 1 and March 25, as in the following examples.

Julian or Old 
Style

Gregorian or New 
Style

Double Date

December 25, 
1718

December 25, 1718 December 25, 
1718

January 1, 1718 January 1, 1719 January 1, 
1718/19

February 2, 1718 February 2, 1719 February 2, 
1718/19

March 25, 1719 March 25, 1719 March 25, 1719

Layout and connection
The tree layout is the placement of the boxes on a page.    For example, in Family Tree 
Maker you can choose between three different types of layouts:    Perfect, Squished, and 
Collapsed.    Selecting Perfect gives you a tree with the most space between the boxes.    
Squished, on the other hand, creates the smallest tree by pushing the boxes closer 
together.    
Box connections are the way that the boxes on the lowest level of your tree are 
connected to the tree.    For example, Detached attaches the boxes by placing lines 
between them.    Fishtail, on the other hand, places the boxes against the right edge of the 
box on the left.    



Object Linking and Embedding (OLE)
Object Linking and Embedding (OLE) is a technology that lets you create items in one 
software program and place them in another software program.    For example, you can use 
video capture software to transfer clips of your home videos onto your computer.    Then, 
with the help of Object Linking and Embedding you can transfer video clips from your video
capture software into Family Tree Maker Scrapbooks.    



Archive
A group of records, such as a land record archive or death record archive.    



Record
A set of information, usually pertaining to one individual.    For example, death records, birth
records, or marriage records.



Index 
A guide to a set of records.    An index can help you locate the information that you need, 
without having to look through all of the individual records.






